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About This Guide

Introduction

The SPT 1700 product family is the next generation of pen-based, one- and two-
dimensional bar code scanning, pocket-sized terminals which also offer a new ruggedized 
design, rechargeable lithium-ion battery, and optional wireless local area networking 
capability. The complete line of SPT 1700 products are based on the popular Palm 
ComputingTM platform architecture, offering users a fast, friendly, and flexible interface for 
data acquisition and management. 
xiii
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The SPT 1700 consists of the following models.

The SPT 1700 Series Product Reference Guide provides information about all the SPT 
1700 Series terminals and its accessories. 

SPT 1700 Performs 1- and 2-dimensional scanning and batch 
communication. Three memory configurations are 
available: 

• 2MB ROM/2MB RAM

• 2MB ROM/8MB RAM 

• 4MB ROM/8MB RAM.

SPT 1733 Performs 1- and 2-dimensional scanning and uses the 
CDPD radio to perform wide area wireless communication. 
This model has the same available memory configurations 
as the SPT 1700.

SPT 1734 Performs 1- and 2-dimensional scanning and uses the 
Global Systems for Mobile Communications (GSM) radio to 
perform wide area wireless communication. This model has 
the same available memory configurations as the SPT 
1700.

SPT 1740 Performs 1- and 2-dimensional scanning and uses the 
Symbol Spectrum24®radio to perform 1 MB and 2 MB local 
area wireless communication. This model has the same 
available memory configurations as the SPT 1700.

SPT 1742 Performs 1- and 2-dimensional scanning and uses the 
Symbol Spectrum24 radio to perform 2 MB local area 
wireless communication. This model has the same 
available memory configurations as the SPT 1700.

SPT 1746 Performs 1- and 2-dimensional scanning and uses the 
Symbol Spectrum24 radio to perform 11 MB local area 
wireless communication. This model has the same 
available memory configurations as the SPT 1700.
xiv
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About This Guide
Chapter Descriptions

Topics covered in this guide are as follows:

• Chapter 1, Getting Started with the SPT 1700, explains the physical buttons and 
controls on your SPT 1700 terminal, how to install and charge the battery, start your 
SPT 1700 terminal for the first time, and set up your Symbol Palm Terminal (SPT) 
Desktop software.

• Chapter 2, Network Setup, explains how to set up your SPT 174x terminals for use 
on Spectrum24; SPT 1733 terminals for use on CDPD; and SPT 1734 terminals for 
use on GSM wireless networks, respectively.

• Chapter 3, Working with Your SPT 1700 Terminal, explains how to open 
applications, use the on-screen keyboard, write with the stylus and use common 
features on your SPT 1700 terminal.

• Chapter 4, Finding Information With Your SPT 1700 Terminal, explains how to 
locate information on your SPT 1700 terminal with the Find command and the 
Phone Lookup command.

• Chapter 5, Applications: Address Book, explains the Address Book application, 
which enables you to keep names, addresses, phone numbers and other 
information about your personal or business contacts.

• Chapter 6, Applications: Calculator, explains the Calculator application, which 
allows you to perform simple calculations on your SPT 1700.

• Chapter 7, Applications: Date Book, covers the Date Book application, which 
enables you to quickly and easily schedule appointments or any kind of activity 
associated with a time and date.

• Chapter 8, Applications: Expense, explains the Expense application, which 
enables you to keep track of your expenses and then transfer the information to a 
spreadsheet on your computer.

• Chapter 9, Applications: HotSync®, describes the HotSync utility, which allows you 
to synchronize data between the SPT 1700 and your computer.

• Chapter 10, Applications: ScoutSync Client, describes the ScoutSyncTM 
application, which enables you to connect your SPT 1700 terminal to a Scout 
Server and transfer data between the ScoutSync Client and your company’s back-
end applications and databases.

• Chapter 11, Applications: AvantGo Client and Mobile Link, provides information 
about using the SPT 173x terminal with the AvantGoTM and Mobile Link 
applications to access the Internet.
xv
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• Chapter 12, Applications: Mail, describes the Mail application which enables you to 
manage your e-mail while away from your desk. 

• Chapter 13, Applications: Memo Pad, explains the Memo Pad application, which 
provides a place to take notes not associated with Date Book, Address Book or To 
Do items.

• Chapter 14, Applications: Preferences, describes the Preferences screens, which 
enable you to customize the configuration options on your SPT 1700 terminal. 
Included in this chapter are instructions on configuring your SPT 1700 terminal for 
use in the Spectrum24, CDPD, and GSM environments.

• Chapter 15, Applications: Security, covers the security options available for 
protecting your SPT 1700 from unauthorized users.

• Chapter 16, Applications: To Do List, describes the To Do List application, which is 
a convenient place to create reminders and prioritize the things that you have to do.

• Chapter 17, Applications: Laser Scanner, covers laser scanner applications and 
the proper methods for scanning 1- and 2-dimensional bar codes.

• Chapter 18, Applications: GsmDemo, allows you to explore what features GSM 
and the SPT 1734 terminal offer you, including sending and receiving SMS 
messages.

• Chapter 19, Installing and Removing Applications, explains how to install and 
remove applications on your SPT 1700 terminal and how to remove the Symbol 
Palm Terminal (SPT) Desktop software from your computer.

• Chapter 20, Getting Help With Your SPT 1700 Terminal, describes methods for 
troubleshooting problems with the SPT 1700, and contact phone numbers for 
technical support.

• Chapter 21, Maintaining Your SPT 1700 Terminal, provides information to help you 
take proper care of your SPT 1700 terminal and prolong battery life. This chapter 
also discusses how to reset your SPT 1700 terminal.

• Appendix A, Using Expense Templates and Custom Expense Reports, provides 
illustrations of the four expense templates that come with the Symbol Palm 
Terminal (SPT) Desktop software. It also explains how to modify existing Expense 
application templates, and how to create your own custom expense report 
templates for use with the Expense application.

• Appendix B, Non-ASCII Characters for Login Scripts, provides information to 
enable you to create custom login scripts that require non-ASCII characters. This 
information is for advanced users only.
xvi
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Notational Conventions

This document uses these conventions:

• “Terminal” refers to any model of SPT 1700. 

• “User” refers to anyone using an application on the SPT 1700.

• “You” refers to the End User, System Administrator or Technical Support person 
using this manual as a reference to install, configure, operate, maintain and 
troubleshoot the SPT 1700.

• Italics are used to highlight specific items in the general text, and to identify 
chapters and sections in this and related documents.

• Bullets indicate:

• lists of alternatives or action items.

• lists of required steps that are not necessarily sequential.

• Numbered lists indicate a set of sequential steps, i.e., those that describe step-by-
step procedures.

• “Tap” refers to selecting an option on the display using the stylus.

Related Documents

• SPT 1700 Series Quick Reference Guide, p/n 70-37543-xx

• SPT 1700/2700 Modem Module Quick Reference Guide, p/n 72-42908-xx

• SPT 1700 Series Site Survey Tool User Guide, p/n 72E-39283-xx

• SPT 1700 Series Site Admin Tool User Guide, p/n 72E-39284-xx

• SPT 1500/1700 Scanner System Software Manual, p/n 72E-35914-xx

• CRD1700-4000S Cradle Quick Reference Guide, p/n 60308-001

• CRD 1700-1000S Cradle Quick Reference Guide, p/n 70-37840-xx

• CRD 1700-1000M Modem Cradle Quick Reference Guide, p/n 70-40933-xx

• CRD 1700-4000E Ethernet Cradle Quick Reference Guide, p/n 72-39472-xx

• VCD 1700 Series Vehicle Cradle Quick Reference Guide, p/n 72-42033-xx

• VCD 1700 Installation Instructions (Vehicle Cradle), p/n 72-43825-xx

• MSR 3000 Magnetic Stripe Reader Quick Reference Guide, p/n 72-38392-xx

• MSR 3000 Magnetic Stripe Reader System Software Manual, p/n 72-38411-xx

• SPT 1733/2733 CDPD Developer’s Guide, p/n 72E-42911-xx
xvii
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• SPT 1734/PPT 2734 Developer’s Guide for GSM Wireless Wide Area Network 
(WWAN), p/n 72-44271-xx

• SPT 1740 Web Client User’s Guide, p/n 72-42792-xx

• Spectrum24 Access Point AP-3020 Product Reference Guide, p/n 70-20504-xx

• SPT 1740 Spectrum24 Driver Extensions Library Developer’s Guide, 
p/n 70-38524-xx

Service Information

If you have a problem with the SPT 1700 equipment, contact the Symbol Support Center. 
If your problem cannot be resolved over the phone, you may need to return your equipment 
for servicing. If that is necessary, you will be given special directions.

Note: Symbol Technologies is not responsible for any damages incurred 
during shipment if the approved shipping container is not used. 
Shipping the units improperly can possibly void the warranty. If the 
original shipping container has not been kept, contact Symbol to 
have another sent to you.
xviii
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Symbol Support Centers
For service information, warranty information or technical assistance contact or call the 
Symbol Support Center in:

United States
Symbol Technologies, Inc.
One Symbol Plaza
Holtsville, New York 11742-1300

1-800-659-2240

Canada
Symbol Technologies Canada, Inc.
2540 Matheson Boulevard East
Mississauga, Ontario, Canada L4W 4Z2

905-629-7226

United Kingdom
Symbol Technologies
Symbol Place
Winnersh Triangle, Berkshire RG41 5TP

United Kingdom
0800 328 2424 (Inside UK)
+44 208 945 7529 (Outside UK)

Asia/Pacific
Symbol Technologies Asia, Inc.
230 Victoria Street #04-05
Bugis Junction Office Tower

Singapore 188024
337-6588 (Inside Singapore)
+65-337-6588 (Outside Singapore)

Australia
Symbol Technologies Pty. Ltd.

432 St. Kilda Road
Melbourne, Victoria 3004
1-800-672-906 (Inside Australia)

+61-3-9866-6044 (Outside Australia)

Austria
Symbol Technologies Austria GmbH 

Prinz-Eugen Strasse 70
Suite 3
2.Haus, 5.Stock

1040 Vienna, Austria
1-505-5794 (Inside Austria)
+43-1-505-5794 (Outside Austria)

Denmark
Symbol Technologies AS

Gydevang 2,
DK-3450 Allerod, Denmark
7020-1718 (Inside Denmark)

+45-7020-1718 (Outside Denmark)

Europe/Mid-East Distributor Operations
Contact your local distributor or call

+44 208 945 7360
xix
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Finland
Oy Symbol Technologies
Kaupintie 8 A 6
FIN-00440 Helsinki, Finland

9 5407 580 (Inside Finland)
+358 9 5407 580 (Outside Finland)

France
Symbol Technologies France
Centre d'Affaire d'Antony
3 Rue de la Renaissance

92184 Antony Cedex, France
01-40-96-52-21 (Inside France)
+33-1-40-96-52-50 (Outside France)

Germany
Symbol Technologies GmbH

Waldstrasse 68
D-63128 Dietzenbach, Germany
6074-49020 (Inside Germany)

+49-6074-49020 (Outside Germany)

Italy
Symbol Technologies Italia S.R.L.

Via Cristoforo Columbo, 49
20090 Trezzano S/N Navigilo
Milano, Italy

2-484441 (Inside Italy)
+39-02-484441 (Outside Italy)

Latin America Sales Support
7900 Glades Road
Suite 340

Boca Raton, Florida 33434 USA
1-800-347-0178 (Inside United States)
+1-561-483-1275 (Outside United States)

Mexico
Symbol Technologies Mexico Ltd.
Torre Picasso

Boulevard Manuel Avila Camacho No 88
Lomas de Chapultepec CP 11000
Mexico City, DF, Mexico

5-520-1835 (Inside Mexico)
+52-5-520-1835 (Outside Mexico)

Netherlands
Symbol Technologies
Kerkplein 2, 7051 CX

Postbus 24 7050 AA
Varsseveld, Netherlands
315-271700 (Inside Netherlands)

+31-315-271700 (Outside Netherlands)

Norway
Symbol Technologies
Trollasveien 36

Postboks 72
1414 Trollasen, Norway
66810600 (Inside Norway)

+47-66810600 (Outside Norway)
xx
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If you purchased your Symbol product from a Symbol Business Partner, contact that 
Business Partner for service.

Warranty

Symbol Technologies, Inc. (“Symbol”) manufactures its hardware products in accordance with 
industry-standard practices. Symbol warrants that for a period of twelve (12) months from date of 
shipment, products will be free from defects in materials and workmanship. 

This warranty is provided to the original owner only and is not transferable to any third party. It shall 
not apply to any product (i) which has been repaired or altered unless done or approved by Symbol, 
(ii) which has not been maintained in accordance with any operating or handling instructions supplied 
by Symbol, (iii) which has been subjected to unusual physical or electrical stress, misuse, abuse, 
power shortage, negligence or accident or (iv) which has been used other than in accordance with 
the product operating and handling instructions. Preventive maintenance is the responsibility of 
customer and is not covered under this warranty. 
Wear items and accessories having a Symbol serial number, will carry a 90-day limited warranty. Non-
serialized items will carry a 30-day limited warranty.

South Africa
Symbol Technologies Africa Inc.
Block B2
Rutherford Estate

1 Scott Street
Waverly 2090 Johannesburg
Republic of South Africa

11-4405668 (Inside South Africa)
+27-11-4405668 (Outside South Africa)

Spain
Symbol Technologies S.A.
Edificioi la Piovera Azul
C. Peonias, No. 2 - Sexta Planta

28042 Madrid, Spain
9-1-320-39-09 (Inside Spain)
+34-9-1-320-39-09 (Outside Spain)

Sweden
Symbol Technologies AB
Albygatan 109D

Solna
Sweden
84452900 (Inside Sweden)

+46 84452900 (Outside Sweden)
xxi
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Warranty Coverage and Procedure
During the warranty period, Symbol will repair or replace defective products returned to Symbol’s 
manufacturing plant in the US. For warranty service in North America, call the Symbol Support Center 
at 1-800-659-2240. International customers should contact the local Symbol office or support center. 
If warranty service is required, Symbol will issue a Return Material Authorization Number. Products 
must be shipped in the original or comparable packaging, shipping and insurance charges prepaid. 
Symbol will ship the repaired or replacement product freight and insurance prepaid in North America. 
Shipments from the US or other locations will be made F.O.B. Symbol’s manufacturing plant. 
Symbol will use new or refurbished parts at its discretion and will own all parts removed from repaired 
products. Customer will pay for the replacement product in case it does not return the replaced 
product to Symbol within 3 days of receipt of the replacement product. The process for return and 
customer’s charges will be in accordance with Symbol’s Exchange Policy in effect at the time of the 
exchange. 
Customer accepts full responsibility for its software and data including the appropriate backup 
thereof. 
Repair or replacement of a product during warranty will not extend the original warranty term. 
Symbol’s Customer Service organization offers an array of service plans, such as on-site, depot, or 
phone support, that can be implemented to meet customer’s special operational requirements and 
are available at a substantial discount during warranty period. 

General
Except for the warranties stated above, Symbol disclaims all warranties, express or implied, on 
products furnished hereunder, including without limitation implied warranties of merchantability and 
fitness for a particular purpose. The stated express warranties are in lieu of all obligations or liabilities 
on part of Symbol for damages, including without limitation, special, indirect, or consequential 
damages arising out of or in connection with the use or performance of the product. 
Seller’s liability for damages to buyer or others resulting from the use of any product, shall in no way 
exceed the purchase price of said product, except in instances of injury to persons or property. 
Some states (or jurisdictions) do not allow the exclusion or limitation of incidental or consequential 
damages, so the proceeding exclusion or limitation may not apply to you. 
xxii
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Getting Started with the SPT 1700
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Introduction

This chapter explains the physical buttons and controls on your SPT 1700 terminal, how to 
install and charge the battery, start your SPT 1700 Series terminal for the first time, set up 
your cradle and install your Symbol Palm Terminal Desktop software.

Unpacking the Terminal

Carefully remove all protective material from around the terminal and save the shipping 
container for later storage and shipping.

Verify that you received all equipment listed on the packing slip and inspect the equipment 
for damage. If any equipment is missing or damaged, contact the Symbol Technologies 
Support Center immediately. Refer to page xviii for contact information.
1-3
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Parts of the SPT 1700

Scroll Button 
(Up and Down)

Laser Decode LED

Center Scan Button

Scroll Button
(Up and Down)

Right Scan Trigger

LCD (Screen)

Calculator Icon

Find Icon

Applications Icon

Menu Icon

Contrast ButtonPower Button

 Application Buttons

Left Scan
Trigger

Front View

Left View

Graffiti Input Area

WAN Antenna
(SPT 1733/34 only)
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Infrared Port

Handstrap Connector

Lithium-Ion Battery

Battery Latch

Handstrap Connector

Stylus

Stylus Silo

Battery Latch

Battery
Compartment

Battery Cover

Serial PortScanner Exit Window

Speaker

Bottom ViewTop View

Back View

Reset Button
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Getting Started with the SPT 1700

Before you can use your SPT 1700, perform the basic set up procedures covered on the 
following pages. Specifically:

• Set up the cradle (optional)

• Install and charge the battery

• Start the SPT 1700 

• Initiate a Spectrum24 network (SPT 174x only) or wide area network (WAN) 
connection (SPT 173X only).

Setting Up the Cradle
There are optional cable and cradle solutions that enable you to charge the terminal’s 
battery and synchronize information on your SPT 1700 terminal with host system 
applications. 

There are several cable and cradle options available for the SPT 1700:

• Synchronization/Charging Cable 

• CRD1700-1000S Single-slot Serial Cradle

• CRD1700-4000S Four-slot Serial Cradle

• CRD1700-1000M Single-slot Modem Cradle

• CRD1700-4000E Four-slot Ethernet Cradle.

This section describes the procedures for connecting each of these cradles to the host PC.

Using the Synchronization/Charging Cable
To charge the terminal’s battery using the Synchronization/Charging Cable:

1. Make sure the battery is installed in the terminal. Refer to Installing the Battery on 
page 1-13 for instructions.
1-6
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2. Insert the cable into the bottom of the terminal, as shown. 

3. Plug the power cable into a wall outlet and plug the other end into the battery 
charging receptacle on the side of the Synchronization/Charging Cable.

The battery is fully charged after approximately two hours. 

To perform serial host communication using the cable, plug the other end of the cable into 
an available communication port on the back of the host computer. 

Synchronization/
Charging Cable

Battery Charging 
Receptacle

Serial Cable

Power Supply
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CRD1700-1000S Single-slot Serial Cradle
To connect the cradle:

1. Turn off your computer. 

2. Plug one end of the serial cable into the host connector on the back of the cradle.

3. Plug the other end of the serial cable into the serial communication port on your 
computer.

Note: You may require a 9-pin to 25-pin adapter, p/n 160-0072 to connect 
the cable to the serial port on the back of your computer.

Note: Your SPT 1700 terminal requires a dedicated port. It cannot share a 
port with an internal modem or other device. If you are unsure about 
the location of the serial port on your computer, refer to the user’s 
manual supplied with the computer.

4. Connect the power jack to the power receptacle on the back of the cradle.

5. Plug the power cable into the wall.

CRD1700-4000S Four-slot Serial Cradle
To connect the cradle:

1. Turn off your computer. 

2. Plug one end of the serial cable into the host connector on the back of the cradle.

3. Plug the other end of the serial cable into the serial communication port on your 
computer.
1-8
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Note: You may require a 9-pin to 25-pin adapter, p/n 160-0072 to connect 
the cable to the serial port on the back of your computer.

Note: Your SPT 1700 terminal requires a dedicated port. It cannot share a 
port with an internal modem or other device. If you are unsure about 
the location of the serial port on your computer, refer to the user’s 
manual supplied with the computer.

4. Connect the power jack into the power receptacle on the back of the cradle.

5. Plug the power cable into the wall.

CRD1700-1000M Modem Cradle
To connect the cradle:

1. Turn off your computer.

2. Plug the RJ-41 connector of the communication cable into the Line Out port on the 
back of the cradle. 

3. Plug the other end of the cable into the serial port on the back of your computer. 

4. Plug one end of the phone cord into the Line In port on the cradle, and the other 
end into a wall phone jack.

5. Connect one end of the power cable into the power port on the back of the cradle, 
and plug the other end into a wall outlet.
1-9

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
Note: Your SPT 1700 terminal requires a dedicated port. It cannot share a 
port with an internal modem or other device. If you are unsure about 
the location of the serial port on your computer, refer to the user’s 
manual supplied with the computer.

Refer to Chapter 9, Applications: HotSync® for instructions on configuring the cradle and 
terminal for modem synchronization.

CRD1700-4000E Ethernet Cradle
Before setting up the cradle, make sure that Symbol Palm Terminal Desktop Software (p/n 
SW-35138-xx) is installed and running on the host computer, as well as properly configured 
Network HotSync software on the SPT 1700 terminal. Refer to the section Symbol Palm 
Terminal Desktop Software on page 1-23 for instructions on installing this software. Specific 
software setup necessary to use the CRD1700-4000E is discussed in Chapter 9, 
Applications: HotSync®.

A DHCP server must be configured and operational on the subnet to which the cradle will 
be attached.

To connect the cradle:

1. Connect the power supply cable round plug to the power connector on the back of 
the cradle.

2. Connect the power supply AC plug to a standard electrical outlet.

Note: International customers must use a separate AC power cable 
appropriate for their respective country. 

The cradle’s LEDs blink, then remain off until a terminal is inserted into one or more of the 
slots. 

DC Power 
Connector
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To set up for network communications: 

1. Ensure there is a DHCP server accessible to the CRD1700-4000E on the subnet 
to which it will be attached.

2. Connect one end of a standard 10 Base-T network cable to the middle connector 
on the back of the CRD1700-4000E. Connect the other end of the cable to a hub 
which is connected to your subnet.

3. Power-up the unit; the CRD1700-4000E performs its power-up sequence, then 
attempts to collect all network parameters from the local DHCP server. 

If configuration of the unit from the local DHCP server fails, all LEDs flash red. The unit 
becomes unresponsive until power is removed, the unit is connected to a network with a 
DHCP server, and power is restored.

Note: Before communication between the SPT 1700 terminal and the host 
computer can take place, the Symbol Palm Terminal Desktop 
Software must be installed and running on the host computer. 

VCD 1700 Series Vehicle Cradle
The SPT 1700 provides a serial port at the bottom of the terminal. When you insert a 
terminal into a VCD 1700 cradle, it connects to the cradle’s serial port. The terminal can 
then use the cradle’s serial port to communicate with an external device. 

To connect the cradle:

1. Plug a 9-pin serial cable into the serial port located next to the power port at the 
bottom of the cradle. Note that some devices may require the serial cable to be a 
null modem cable.
1-11
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Note: The external device must use an RS-232 serial connection limited to 
TXD, RXD, RTS and CTS data lines. It must also have its own power 
supply, as the cradle’s serial port does not provide power. 

2. Connect the other end of the cable to the serial port of the external device (e.g., a 
host computer, printer, or modem). 

To begin communication:

1. Insert the terminal into the cradle.

2. Connect the Power Input cable to your vehicle power source. Then plug the cable 
into the Power Port on the terminal. 

3. To initiate communication, make appropriate selections on the terminal, as 
determined by the application you are using.

Note: Removing a terminal during data communication will disrupt 
communication between the terminal and the attached device. 

To Vehicle

To External Device

Power Source
Serial Cable

Power Input Cable
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Installing the Battery
To install the battery in your SPT 1700:

1. Open the latches on the battery cover and lift it away from the SPT 1700.

2. Insert the lithium-ion battery in the battery compartment, making sure it snaps into 
place.

3. Replace the battery cover and re-secure the latches.

Note: Be careful to position the battery latches completely open while 
securing the battery cover on the terminal.

Latch

Latch
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Charging the Battery
Before using your SPT 1700 for the first time, charge the lithium-ion battery. The terminal’s 
battery can be charged using the Cradle, the Synchronization/Charging Cable, or the 
Universal Battery Charger (UBC). For instructions on using the UBC to charge your 
batteries, refer to the Quick Reference Guide which came with your UBC. Follow these 
same procedures to recharge the battery when the terminal’s battery level is low.

Using the Cradle to Charge the Battery
To charge the terminal’s battery using the CRD 1700 cradle:

1. Make sure the battery is installed in the terminal. Refer to Installing the Battery on 
page 1-13 for instructions.

2. Make sure the cradle is plugged into a wall outlet. 

3. Insert the SPT 1700 terminal in the cradle as shown:

On the CRD1700-1000S, the battery charging LED turns red to indicate that the battery is 
charging, then turns green after approximately two hours to indicate that the terminal’s 
battery is fully charged. 

Spare Battery Charging 
The CRD1700-1000S single-slot cradle has a spare battery charging slot which charges 
the terminal’s spare battery. Insert the battery in the spare battery charging slot in the back 
of the cradle. The spare battery charging LED turns red to indicate the spare battery is 

Battery 
Charging 
LED
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charging, then turns green after approximately two hours to indicate the battery is fully 
charged.

Attaching the Handstrap
The SPT 1700 has an optional handstrap which increases comfort when holding the 
terminal for extended periods of time. To attach the handstrap to the back of the terminal:

1. Thread the metal piece through the metal handstrap connection on the back of the 
terminal.

Spare Battery 
Charging LED
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2. Slide the flat metal piece into the handstrap connection on the bottom of the 
terminal. 

3. Adjust the velcro® strap to fit your hand.

Starting the SPT 1700 
After charging and installing the battery, start the terminal by pressing the red power button 
on the front of the unit. If the terminal does not power on, perform a hard reset. 

Note: When starting the terminal for the first time, or whenever the battery 
is completely drained, a hard reset is required.

To hard-reset the terminal:

1. Remove the battery cover from the back of the terminal. 

2. Hold down the power button on the front of the SPT 1700 terminal.

3. While holding down the power button, use the tip of the stylus to gently press the 
reset button on the back of the terminal.

4. Release the reset button.

5. Release the power button.

Thread metal piece 
through this connector

Slide flat metal piece 
up and into this 
connector
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6. When a message displays on the screen warning that you are about to erase all 
the data stored on your SPT 1700 terminal, do one of the following:

a. Press the upper half of either of the scroll buttons on the front panel of the SPT 
1700 terminal to complete the hard reset and display the Digitizer screen.

b. Press any other button to perform a soft reset.

Note: With a hard reset, the current date and time are retained. Formats 
Preferences and other settings are restored to their factory default 
settings.

After initial start up, always start the terminal by pressing the red power button.

Calibrating the Screen
The first time you start your SPT 1700 (or after a hard reset), the calibration screen 
displays. Follow the steps in this section to align the internal circuitry of your SPT 1700 with 
its touch-sensitive screen.

Note: If your SPT 1700 unit came pre-loaded with a custom software 
application, you may not need to calibrate your screen, in which 
case you will not see the calibration screen.

To calibrate your SPT 1700 for first time use:

1. Press the power button on the front panel of your SPT 1700 to display the 
calibration screen. (This screen also displays following a hard reset).

2. Remove the stylus from its storage silo on the back of the SPT 1700.

Power 
Button
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3. Tap the exact center of each target that displays on the screen with the tip of the 
stylus.

If you need to recalibrate the screen at any time, open the Prefs application, tap on the pull-
down menu at the top right corner of the screen, and select the digitizer option.

Setting the Time
The General Preferences screen is the first screen to display after you align the digitizer on 
your SPT 1700 terminal.

Note: If the General Preferences screen is not on your SPT 1700 terminal 
screen, you may have pressed one of the application buttons on the 
front panel. Refer to General Preferences on page 14-10 for 
information on displaying the General Preferences screen.
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To set the current time:

1. Tap the Set Time box in the General Preferences screen to open the Set Time 
screen.

2. Tap the up or down arrows to change the hour.

3. Tap the minutes box, and then tap the arrows to adjust the settings for the current 
time.

4. Tap the AM or PM box to select the time of day.

Note: Your SPT 1700 terminal can also display time based on a 24-hour 
clock. Refer to Formats Preferences on page 14-9.

5. Tap the OK button to close the Set Time screen and return to the General 
Preferences screen.

Setting the Current Date
The Set Date box in the General Preferences screen is used to set the current date for your 
SPT 1700 terminal.

To set the current date:

1. Tap the Set Date box to open the Set Date screen.

2. Tap the arrows at the top to select the current year. 

Tap here
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3. Tap a month box to select the current month.

4. Tap the current date to close the Set Date screen and return to the General 
Preferences screen. 

Note: You do not need to adjust the other General Preference settings at 
this time. Refer to General Preferences on page 14-10 for 
information about the remaining options.

Configuring the Spectrum24 Network (SPT 174x only)
Before the SPT 174x can be used on the Spectrum24 wireless LAN, your facility must be 
set up with the equipment required to run the wireless LAN and your terminal must be 
properly configured. Refer to Chapter 2, Network Setup for instructions on configuring your 
terminal for use with Spectrum24.

Configuring the Wide Area Network (SPT 173x only)
Before the SPT 173X can be used on a WAN (CDPD or GSM), your terminal must be 
properly configured. Refer to Chapter 2, Network Setup for instructions on configuring your 
terminal for use with a WAN.

Tap arrows to select year

Tap to select month

Tap to select date
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Using the SPT 1700

This section describes the procedures for the basic use of the SPT 1700 series terminal. 
Topics covered include powering on the terminal, using the backlight, adjusting the screen 
contrast, writing with the stylus, and using the onscreen keyboard.

Using the Power Button/Backlight Control
The power button turns the SPT 1700 on and off. This button also serves as your backlight 
control for low-light conditions. With the unit on, press and hold the power button for 
approximately 2 seconds to turn the backlight on and off. 

Note: When the backlight is on, the screen text displays in reverse video. 

Using the Contrast Control
The contrast control button is located on the lower right-hand side of the terminal.

To adjust the contrast:

1. Press the contrast control button, which displays the contrast adjusting bar on the 
terminal’s screen. 

2. Using your stylus, adjust the contrast by scrolling the contrast bar until the contrast 
is set to the desired level, or use either of the scroll buttons on the top of the 
terminal to adjust the contrast level.

3. Press the contrast control button or tap Done on the terminal screen to turn off the 
contrast control. 

Contrast 
Control
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Writing with the Stylus
Your SPT 1700 includes Graffiti® handwriting software as the primary system for entering 
text and numbers. Graffiti is a system where simple strokes you write with the stylus are 
instantly recognized as letters or numbers. Refer to Writing Graffiti with the Stylus on page 
3-6 for more information.

Using the Onscreen Keyboard
You can activate the on-screen keyboard any time you need to enter text or numbers on 
your SPT 1700. Note that you cannot enter Graffiti characters while using the on-screen 
keyboard. 

To use the on-screen keyboard:

1. Open any SPT 1700 application. 

2. Tap any record name, or tap the New button with the tip of the stylus.

3. Tap the left target to open the Alpha keyboard, or tap the right target to open the 
Numeric keyboard.

Refer to Using the On-Screen Keyboard on page 3-17 for additional information.

Tap here for letters 
keyboard

Tap here for numbers 
keyboard
1-22

Download from Www.Somanuals.com. All Manuals Search And Download.



Getting Started with the SPT 1700
Icon Descriptions

Symbol Palm Terminal Desktop Software

Symbol Palm Terminal Desktop software extends many of the functions of your SPT 1700 
Series terminal to your computer. Although using Symbol Palm Terminal Desktop software 
is optional, when you use it with your SPT 1700 Series terminal and the built-in HotSync 
technology, you can fully synchronize the information on your SPT 1700 Series terminal 
with the information on your computer. Changes you make on your SPT 1700 Series 
terminal or Symbol Palm Terminal Desktop display in both places after you synchronize.

With Symbol Palm Terminal Desktop software you can:

• Work with your SPT 1700 terminal applications on your computer. The Symbol 
Palm Terminal Desktop software duplicates the Date Book, Address Book, To Do 
List and Memo Pad applications on your SPT 1700 terminal, so you can view, enter 
and modify any data stored on your SPT 1700 terminal.

• Back up the data stored on your SPT 1700 terminal with HotSync technology and 
synchronize the data with the Symbol Palm Terminal Desktop software. 
Synchronization is a one-step procedure that ensures your data is always safe and 
up-to-date. Refer to Chapter 9, Applications: HotSync® for information about using 
this feature. 

• Import and export data, so you can easily transfer data from other Windows 
applications into Address Book or Memo Pad.

• Print your Date Book, Address Book, To Do List and Memo Pad information on any 
Windows-compatible printer.

Applications Icon Tap to exit the current application and to display a list of available 
applications for selection.

Calculator Icon Tap to display the calculator application.

Menu Icon Tap from within an application to display the menu of options for the 
selected application.

Find Icon Tap from within an application to enter search criteria to find an entry.
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System Requirements
To install and operate the Symbol Palm Terminal Desktop software, your computer system 
must meet the following requirements:

• Windows 95 or Windows NT 4.0

• IBM-compatible 486 computer or higher 

• 8 MB RAM (memory) minimum, 16 MB recommended

• 12 MB available hard disk space

• VGA monitor or better 

• CD-ROM drive 

• Mouse

• One available serial port.

Optional Equipment
• Modem 

• Windows-compatible printer.

Symbol Palm Terminal Desktop Software Installation
The following instructions guide you through installing the Symbol Palm Terminal Desktop 
software. After you install the software, refer to the Help menu for complete information 
about how to use the Symbol Palm Terminal Desktop software.

To ensure a safe and uninterrupted installation of the Symbol Palm Terminal Desktop 
software, do the following before installing:

• Connect the cradle to your computer.

• If you have placed your SPT 1700 terminal in the cradle, remove it during software 
installation.

• Exit all programs, including those that run automatically at startup, such as fax 
software, virus protection software, screen-saver software, and application 
toolbars such as Microsoft® Office. 

• Do not simply copy the Symbol Palm Terminal Desktop files to your hard drive. You 
must use the installer to place the files in their proper locations and then 
decompress them. 
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To install the Symbol Palm Terminal Desktop software:

1. Insert the Symbol Palm Terminal Desktop Software CD into the CD-ROM drive on 
the PC.

2. If your CD-ROM supports the auto-run feature, an installation menu automatically 
displays on your desktop. If not, navigate to your CD-ROM drive and double-click 
on setup.exe. The Welcome Screen displays. 

3. Follow the directions as the installation program guides you through the install 
process.
1-25

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
1-26

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 2  
Network Setup
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Introduction

Wireless networks allow SPT 1700 series terminals to communicate wirelessly, and to send 
captured data “real time” to a host device. Terminals and their supported network types are:

Before a terminal can be used on a Spectrum24 LAN, your facility must be set up with the 
equipment required to run the network and the terminal must be properly configured. Before 
a terminal can be used on a CDPD/GSM WAN, you must activiate your device on the 
network. Refer to the following sections for specific configuration information for each 
terminal type: Configuring a Spectrum24 Connection (SPT 174x Only), Configuring a 
CDPD WAN Connection (SPT 1733 Only), and Configuring a GSM WAN Connection (SPT 
1734 Only).

Configuring a Spectrum24 Connection 
(SPT 174x Only)

To configure your SPT 174x terminal for use on a Spectrum24 network: 

1. On the Main Application screen, tap the  icon. 

2. Tap the preference options pick list and select Network. The Network Preference 
screen displays:

Terminal Network Technology

SPT 174x Spectrum24 (LAN)

SPT 1733 CDPD (WAN)

SPT 1734 GSM (WAN)
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Note: Refer to Network Preferences Menu Commands on page 14-27 for 
details about using the Network Preferences menu options.

3. Tap the Service pick list and select Spectrum24, then tap Details. The Spectrum24 
Preferences screen displays:

Enter the following information:

4. Extended Service Set ID (ESS ID).

The ESS ID identifies the radio network and differentiates between different radio 
networks. All terminals on the same network, as well as the access points in your 
facility, must have the same ESS ID. Ask your System Administrator for the correct 
ESS ID number of your network. 

5. Internet Protocol address (IP).

Each SPT 174x terminal requires a unique internet address (IP address). This 
address can be administered and entered manually through the terminal, or 
administered and allocated by a server on the network, using DHCP. 

Note: The default value for this field is Use DHCP. Use this option if you 
want the IP address to be dynamically selected by the DHCP server.
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a. To manually enter the IP address information for this terminal, deselect Use 
DHCP and tap Settings. The IP Settings screen displays:

b. Enter the IP address, Subnet mask, and Gateway address for this terminal. 

Tap each field to display a keypad for selection of the address information. Each 
part of the four-part address must be in the range of 0-255; numbers are the only 
allowable characters in these fields. Ask your Internet Service Provider or your 
System Administrator for the correct IP, Subnet and Gateway information. 

c. Tap Done to exit the Keypad.

d. Tap OK to save the information and return to the Spectrum24 Preferences 
screen. 

6. To enable DNS, tap the Enable DNS box. A Details button is added to the screen.

Note: Many systems do not require a DNS. If you are not sure, leave the 
DNS fields blank.

a. Tap Details to display the Details screen.

Enter the Host and Domain Names. If you need more space to enter name 
information, tap the arrow to the right of these fields to display a blank screen. 
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Tap the Primary and Secondary DNS fields to display a keypad to enter the 
address information for these fields. Each part of the four-part address must be in 
the range of 0-255; numbers are the only allowable characters in these fields. Ask 
your Internet Service Provider or System Administrator for the correct Primary or 
Secondary DNS numbers.

b. Tap OK to save the information and return to the Spectrum24 Preferences 
Screen, or Cancel to return to this screen without saving the DNS information.

7. Tap the Radio Config button to set the radio configuration parameters.

Note: This button is available for the SPT 1746 only.

a. The following parameters display:

PwrMode The power-saving level of the terminal. 
“5” uses the least power and is the 
recommended configuration.

Diversity Determines whether the radio firmware 
attempts to use one or two antenna 
ports for communications. It is 
important to match this setting with the 
actual number of antennas in use.
If set to “Both”, the radio firmware 
attempts to use both antenna ports for 
communications. 
Both is the default and provides the 
best chance of a clear signal.
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Note: Symbol Technologies recommends using the default settings, as 
they have been set to maximize the performance of the SPT 1746.

8. Tap Done when configuration is complete, then tap OK to return to the Spectrum24 
Preferences screen.

9. Tap Connect to connect to the network.

Channel The specific Direct-Sequence Channel 
used for communications between the 
AP (Access Point) and the MU (Mobile 
Unit). Channels are unique per country.

Preamble Approximately 8 bytes of the packet 
header generated by the AP and is 
attached to the packet prior to 
transmission. Preamble length is 
transmission data rate dependent. The 
short preamble is 50% shorter than 
long preamble.
Both the MU and AP need to be set to 
the same preamble to associate.

Encryption Tap to enable encryption, an efficient 
method of preventing data theft and 
improving data security.

Key Index The specific algorithm used for each 
encryption key.

Encrypt Len Encryption length. 
Choose either 40 bit or 128 bit. 
40-bit encryption: Requires a 10 Hex 
digit Encryption key. 
128-bit encryption: Requires an access 
code. Contact the Symbol 
Technologies Support Center 
(1-800-653-5350) for details.

Keys 1 - 4 Specific key codes required for 
encryption.
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Configuring a CDPD WAN Connection (SPT 1733 
Only)

Before the SPT 1733 terminal can be used, you need to be activated on a CDPD network.

All CDPD identification and address information is entered through the Preferences 
application on the SPT 1733 terminal.

To configure your SPT 1733 terminal for use on a CDPD network, tap the  icon from the 
Applications Launcher. The main Merlin screen displays:

Setup Wizard
The first time that the MerlinTM Modem Manager software is started the Setup Wizard will 
display and prompt you through the steps to configure and set up the terminal for operation.
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Note: If this is not the first time you are accessing the Merlin Modem 
Manager, Tap the  icon and select Setup Wizard from the Merlin 
menu.

At any time, you can choose to cancel the Setup Wizard and exit back to the Application 
Launcher by tapping the Cancel button. If you do choose to cancel, the Setup Wizard will 
be displayed the next time that the Modem Manager is selected. It is recommended that 
once you begin the setup process you continue through to its completion.

1. To begin configuration, tap Next. The Network Provider screen displays:

2. Select a Wireless Provider from the pick list:
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3. Tap Other if you need to enter a Service Provider Interface number representing a 
different carrier. The following screen displays:

4. Enter the SPI number and tap Done.

5. The Network Provider screen reappears. Tap Next to continue.

Note: The Setup Wizard will not proceed until a CDPD carrier selection 
has been made.

6. The Configure Palm Device screen displays: 

7. Tap the Configure Preferences button to configure the terminal with the network 
library settings that Symbol recommends. A “Palm Configuration Complete” 
message will display below the Configure Preferences button when the process is 
finished.

Note: If you are confident that the Network Preferences are correct, you 
may bypass this step. However, it strongly suggested that you verify 
preference configuration.
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8. Tap Next to continue. The Contact A Provider screen displays:

You are informed that you will need an IP address and two DNS addresses from 
your Network Provider before continuing. Tap Next to continue.

9. The Settings screen displays: 

10. Enter the required information and tap Next to continue. You are prompted to 
confirm the settings. Verify the information you entered is accurate and tap Next.
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11. Once the modem has been configured, the Auto Config screen displays:

Tapping either button displays the Check Network screen as the modem attempts 
to register.

12. When the modem connects successfully and the following screen displays:

Tap if you are going to 
wait for your account 
to be registered

iTap to attempt
connection with the

network now
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Maintenance Screens and Menus
The SPT 1733 terminal includes menu commands to make it fast and easy to configure and 
check the status of your modem. This section explains the menu commands specific to the 
Merlin Modem Manager.

Quick Status Screen
The initial Merlin Modem Manager screen displays numerous modem parameters. These 
include the detection of a CDPD channel and whether the modem has successfully 
registered. The modem's status is updated every 3 seconds. 

Setting Description

Cellular Signal 
Present

When checked, it indicates that the modem has identified a 
cellular signal.

CDPD Service 
Detected

When checked, it indicates that the modem has identified and 
is synchronized to a CDPD signal in the area.

Modem Ready 
Registered

When checked, it indicates that the modem has successfully 
registered with a CDPD service provider in the coverage area. 
When the indicator is lit a working data connection exists and 
can be used by other applications to transmit and receive 
data. Until this checkbox is selected, the modem can neither 
transmit nor receive data.

RSSI Measures Received Signal Strength from the wireless base 
station. These values range from one to ten bars. The greater 
the number of bars, the better the performance of the modem.

Error Detect When checked, it indicates that a large number of errors have 
been detected by the modem. Under these circumstances the 
modem may continue to operate but with a severely reduced 
performance, caused by the increased likelihood of 
connection retries and data errors when communicating with 
the wireless base station.

System Busy When checked, it indicates that the currently detected CDPD 
system is busy. The modem may continue to operate but at a 
decreased level of performance.

Wireless Provider Displays the CDPD channel’s System Provider’s Identifier.
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RF Channel Shows the CDPD channel that is currently active. If the unit is 
not registered or is searching for a channel, the value 
displayed will be either "Searching A" or "Searching B”, 
depending on the state of the modem. Once a channel has 
been detected, a numeric value for the channel is displayed.

Registration Error This shows either "None" or a numeric value between 1 and 
7. If "None" is displayed there was a successful registration 
without any errors. If a numeric error code is displayed then an 
error has occurred. Tap to display details about the error.

Shutdown Turns the modem off.

Setting Description
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Merlin Menu Options

Tapping the Menu key provides a series of menus. Merlin Modem Manager software 
supports shortcuts to access any of the menus. The following are the available menu 
options.

Merlin Menu

Disconnect Terminates the active Network session with the modem. If 
disconnected, the Merlin Modem Manager can no longer perform 
3-second updates.

Shutdown Performs the same function as Disconnect. 
Terminates the active Network session with the modem and forces 
the modem to power off. If the modem is shutdown, the Merlin 
Modem Manager can no longer perform 3-second updates. 

Reconnect Reconnects a network session that has previously been 
disconnected. When Reconnect is selected, the 3-second 
updates of the software begin again.

Network 
Prefs

Brings the user directly to the Network Preferences screen. Refer 
to Chapter 14, Applications: Preferences for details.

Setup 
Wizard

Launches the Setup Wizard to configure your modem.
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Advanced Menu

Configuration Screen

Config (Configuration) Displays the network connection configuration screen, 
allowing you to make the desired changes or refinements 
to your network settings. Refer to Configuration Screen 
on page 2-16 for detailed information.

Status Displays the Detailed Status screen, which shows 
various details about how your modem is connecting to a 
Network or the Internet. This screen is used for diagnostic 
purposes and for assisting customer service in 
diagnosing any problems you may encounter with 
Network connections. Refer to Status Screen on page 2-
20 for detailed information.

Terminal Displays the terminal emulator, allowing you to connect to 
and send AT commands to the modem. Refer to Terminal 
Screen on page 2-22 for detailed information.

Ping Displays the Ping screen, allowing to send a packet to a 
particular IP address to determine if it is online. Refer to 
Ping Screen on page 2-23 for detailed information.
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You can select any of the buttons, or triggers, and modify their settings. Note that none of 
your changes will become active until you tap the Save button. When Save is selected, you 
are provided with the Disconnecting and Reconnecting screens, indicating that the settings 
are being saved and the modem is being reset with the new settings. The Save button also 
returns you to the Quick Status screen.

IP Address This is the current IP address of the modem. Tap to enter 
a new IP address.

Primary DNS This is the current Primary DNS address of the modem. 
Tap to enter a new DNS address.

Secondary DNS This is the current Secondary DNS address of the modem. 
Tap to enter a new DNS address.

Sleep Mode Allows or disallows the modem to enter the low-power 
mode. Please note that this feature is only functional when 
used on Wireless IP networks that support it.

Network Provider Configure the side preferences for the modem. All CDPD 
systems are categorized into "A" systems or "B" systems. 
This setting determines which system category 
(categories) how the modem will search for a CDPD 
system among the two system category choices. Refer to 
Network Provider pick list on page 2-18 for detailed 
information.

SPI, SPNI, WASI Configures all identification values for a particular system 
or Wireless IP network. Also called Service ID parameters.

Service ID Pref Configures the preferences for the service ID parameters. 
Refer to Network Provider pick list on page 2-18 for 
detailed information.

Channel Hot List Configures a list of channels upon which the modem will 
attempt to find service. This user-configurable list can 
contain up to 32 channels, listed in the particular order that 
you want the modem to use.

Hot List Operation Configures how the Channel Hot List entered is used.
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Sleep Mode pick list

Network Provider pick list

Enabled The modem will attempt to enter a low-power mode if it is not required to 
carry out any communications with a Network. The modem may respond 
sluggishly to the first communication request when it is required again.

Disabled The modem is not allowed to enter sleep mode.

A only The modem will search for a CDPD system on the "A" side only. For users 
who do not roam, this selection can sometimes speed the registration 
process, as the modem does not have to look on the "B" side as well 
before it can register.

B only Same as "A only" except on the "B" side.

Prefer A The modem will search for a CDPD system on the "A" side first and 
attempt registration on any system it finds. However, if the modem cannot 
register on the "A" side, it will then attempt to find service on the "B" side. 
For users who roam, this setting would be appropriate if the home system 
was on the "A" side.

Prefer B The modem will search for a CDPD system on the "B" side first and 
attempt registration on any system it finds. However, if the modem cannot 
register on the "B" side, it will then attempt to find service on the "A" side. 
For users who roam, this setting would be appropriate if the home system 
was on the "B" side.
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Service ID Pref pick list

Hot List Operation pick list

Only SvcID The modem will attempt to detect only the system in the Service 
ID parameters for registration. This is useful in cases where the 
user wishes to prevent roaming to any other system but his home 
one.

PreferSvcId The modem will first attempt to register on the system described 
by the SPI/WASI/SPNI entries. If no system is found, the modem 
will attempt to register on the remaining available systems in the 
area. This is useful in situations where the user spends most of his 
time in one area and occasionally roams. In this case, the user 
would enter the Network ID parameters that reflect the system he 
most often will register on. Another situation where this may be 
useful is in cases where the user has two systems in his area but 
prefers service on one due to rate advantages, etc.

IgnoreSvcID The modem will attempt to register on any system but that 
reflected in the Network ID entries. This is useful in situations 
where the user wishes to block registration on systems in his area 
that he does not have an agreement with. This may speed up the 
registration process in some areas.

Any SvcID The SPI/WASI/SPNI entries are ignored. This is the default 
configuration and ensures that the modem will attempt to register 
on any valid system that it can find.

Scan All Ignores the list of channels and search all of them.

Use List Attempts to search for system on the channels in the list. If service 
cannot be found on those channels, the user will be unregistered.

Hybrid Attempts to search for systems on the given channels first, and 
then opens the search up to all channels if none can be found. 
Given this selection, the modem will also update the channel list 
automatically with any channel on which it has found service. In 
this way, the channel list is eventually updated with all CDPD 
systems in the area.
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Status Screen
The Status screen shows modem information which is updated every 3 seconds.This 
screen was designed to assist support personnel in diagnosing problems with your modem. 
If a problem develops, the Symbol Support Center (Refer to Symbol Support Centers on 
page -xix for contact information) will find the information displayed here of importance. 

Note: There are no menus on this screen and no place for user entry. 
Tapping Done will return you to the Quick Status screen.

CDPD Entry identifies the current CDPD acquisition state.

SEARCH The modem is searching for service.

ACQ'D The modem has acquired or synchronized to a CDPD system in 
the area.
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RSSI Entry is the signal strength measured on the current channel. During the SEARCH 
phase of operation, this value may vary according to the channel on which an attempt will 
be made. When ACQ'D, the signal strength measurement should remain somewhat 
constant.

IP is the IP address of the unit.

EID is the Equipment ID of the unit.

Color Area color code being transmitted by the CDPD system.

Chan The current channel. During the SEARCH phase, this value may 
change according to the channel that is being attempted. Once a 
channel has been ACQ'D, this should remain relatively constant.

CellID CDPD Base Station identifier number.

BLER A measurement of the error rate on the forward channel detected by 
the modem.

Side Display of the current Side, given the A/B side distribution of the CDPD 
channels.

PL The current Power Level value at which transmission will take place.

SPI The current CDPD Base Station Service Provider Identifier.

WASI The current CDPD Base Station Wide Area Service Identifier.

SPNI The current CDPD Base Station Service Provider Network Identifier.

PwrProd The Power Product value transmitted by the current CDPD system.

RegErr A numeric value representing the last registration error encountered. A 
value of 1-7 indicates an error; a value of 0 indicates no error and a 
value of 255 indicates no registration attempt was made.

Link Identifies the current CDPD communication link state. Can be Locked 
or Searching.
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Terminal Screen
The Terminal provides an internal terminal emulator for communication with the modem, 
allowing users to further customize the operation of their modem based on the AT 
command set.

To begin a terminal session:

1. Tap the Online button. 

Going online terminates any active network session and establishes a serial 
session to the modem. 

The screen shows the data that is being received from the modem. As data is 
received, it is displayed line by line on the screen display. Scroll bars automatically 
display when the amount of displayed data exceeds the physical size of the SPT 
1733 terminal’s total display area. You can scroll back and forth through most of the 
previously displayed data. There is a physical limitation on how much previous data 
can be scrolled and once this limitation is reached, the oldest data will be 
overwritten, so the screen buffer always maintains the last 2000 bytes of data from 
the modem.

2. Tap Offline button to close the serial session.

3. Tap Done to terminate any serial session and re-establish a network session, 
returning you to the Quick Status screen.

4. Tap the Clear button to clear the current screen buffer.

At the bottom of the screen is a field for entry of an AT command. There are a number 
of pre-defined commands that are included in the Cmd pick list. When you selection of 
any of these commands, the modem will automatically send the command, without the 
need to press Send button.
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Ping Screen
From this screen you can send a PING request to another network device whose network 
address you already know. This is useful to verify network connectivity.

As with other PING applications, you must enter the IP address of the other network device 
in the IP field and then select the desired payload size. Pressing the Send button will send 
the PING. A status line will provide information on whether or not the PING was successful 
by displaying a "Success" or "Fail" message. There is a 20 second timeout for a response 
before a "Success" or "Fail" message may display.

Please note that there are some limitations on this PING implementation:

• The size of PING payload is limited to 99 bytes. If a payload of greater than that is 
entered, a data error message will be displayed.

• The delay to wait for response is fixed at 20 seconds.

After you have viewed this information, press the OK button to return to the Quick Status 
screen.
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Help Menu
The Help menu shows basic information about your modem, modem driver, and Merlin 
application.

Modem Info Displays the Quick Status screen. Refer to 2-13 for 
details.

Driver Info Displays the version of the modem driver. 

About Displays version and copyright information for Merlin.
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Configuring a GSM WAN Connection (SPT 1734 
Only)

To set up a new connection configuration:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open the HotSync application.

3. Tap the  icon to display the HotSync Options menu and select Connection 
Setup.The Connection Preferences screen displays:

4. Tap New to create a new configuration. The Edit screen displays:

5. Enter a name for the connection (i.e., GSM modem) and select GSM Driver to 
Modem as the Connection Method.

Refer to Preparing Your SPT 1700 Terminal for a Modem HotSync Operation on 
page 9-15 for additional information about this screen.

6. Tap the OK button, followed by the Done button.
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Working with Your SPT 1700 Terminal
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Introduction

This chapter explains how to open applications, use the on-screen keyboard, write with the 
stylus, perform scanning, and use common features on your SPT 1700 terminal.

Applications

Your SPT 1700 terminal is equipped with a variety of applications which display in the 
Applications Launcher. Use the Applications Launcher to open any application installed on 
your SPT 1700 terminal. You can also open the four main applications — Date Book, 
Address Book, To Do List and Memo Pad — with the buttons on the front panel of your SPT 
1700 terminal. 

Tip: The buttons on the front panel provide instant access to the selected 
application. You don’t need to turn on your SPT 1700 terminal first. 

The Applications Launcher also displays the current time, battery level and application 
category. 

To open applications: 

1. Tap the  icon on the SPT 1700 terminal screen to open the Applications 
Launcher.

2. Tap the icon of the application that you want to open. If you have many applications 
installed on your SPT 1700 terminal, tap the scroll bar to see all of your 
applications. 

Tip: As a shortcut, write the Graffiti® handwriting software character stroke for the 
first letter of the application you want to use. The Applications Launcher scrolls to 
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the first application that begins with that letter. Refer to Writing Capital Letters With 
Graffiti on page 3-12 for additional information.

Changing the Applications Launcher Display Format
By default the Applications Launcher displays each application as an icon. As an 
alternative, you can choose to show a list of applications. 

To change the Applications Launcher display:

1. Tap the  icon on the SPT 1700 terminal screen to open the Applications 
Launcher.

2. Tap the  icon to open the Applications Launcher menus.

3. Tap Preferences from the Options menu to open the Preferences screen.

4. Tap the View By pick list and select the List option.

Note: Tap the Remember Last Category checkbox to display only the last 
category of applications that you have selected.

5. Tap the OK button to close the Preferences screen and display the Applications 
Launcher in list format.

Switching Applications
When working in any application, you can tap the  icon or press the buttons on the front 
panel to switch to any other application. Your SPT 1700 terminal saves your work in the 
current application and displays it when you return to the current screen.
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Setting Preferences for Applications
You can set preferences for individual applications in the Preferences screen. Not all 
applications have preference settings. 

To set preferences for an application: 

1. Open an application. 

2. Tap the Menu icon. 

3. From the Options menu, select Preferences.

4. Enter the desired preference settings; then tap OK.

Displaying Applications by Category
The category feature enables you to limit the number of applications that display on the 
screen. You can assign your applications to categories and then choose to display a single 
category or all your applications. 

To display applications by category:

1. Tap the  icon on the SPT 1700 terminal screen to open the Applications 
Launcher.

2. Tap the  icon to open the Applications Launcher menus.

3. Tap Category from the App menu to open the Category screen.

4. Tap the pick list next to each application to assign it to a category.

Tip: To create a new category, tap Edit Category from the pick list to open the Edit 
Categories screen. Tap the New button, enter the category name, and then tap the 
OK button to add the category. Tap OK to close the Edit Categories screen.
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5. Tap the Done button to close the Category screen and return to the Applications 
Launcher.

6. Tap the pick list in the upper-right corner of the screen and select the application 
category you want to display.

Tip: You can also tap the  icon to scroll through the application categories.

Writing Graffiti with the Stylus

Your SPT 1700 terminal includes Graffiti handwriting software as the primary system for 
entering text and numbers. Graffiti is a system where simple strokes you write with the 
stylus are instantly recognized as letters or numbers.

This section explains the basics of Graffiti, and how to make strokes in the Graffiti writing 
area. Your SPT 1700 terminal also includes Giraffe — a game you can use to practice 
writing Graffiti. Refer to Installing Games on page 19-6 for instructions on how to install 
Giraffe.

Practicing Graffiti with the Memo Pad 
The Memo Pad application is ideal for practicing the Graffiti alphabet. This section explains 
how to open the Memo Pad and use it to practice Graffiti. A complete explanation of the 
Memo Pad application appears in Chapter 13, Applications: Memo Pad.

To open the Memo Pad application:

1. Press the  button on the front of your SPT 1700 terminal to open the Memo Pad 
application.
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2. Tap the New button to open a new Memo Page.

Note: A cursor displays in the upper-left corner of the Memo Page to 
indicate where new text will display.

Writing Letters With Graffiti
Most people find they can enter text quickly and accurately with only minutes of practice. 
Graffiti includes any character you can type on a standard keyboard. The Graffiti strokes 
closely resemble those of the regular alphabet which makes it quick and easy to learn. For 
example, the following Graffiti strokes are portions of the regular alphabet equivalents.

New 
memo 
cursor

Tap 
New 

Write in Graffiti area 

A F K T

4 5
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There are four basic concepts for success with Graffiti:

• Draw the character shape exactly as shown in the tables later in this chapter (like 
the shapes shown in the following diagram).

• The heavy dot on each shape shows where to begin the stroke. Certain characters 
have similar shapes, but different begin and end points. Always begin the stroke at 
the heavy dot. (Do not draw the heavy dot; it is there only as a guideline).

• Most characters require only a single stroke. When you lift the stylus from the 
Graffiti writing area, your SPT 1700 terminal recognizes and displays the text 
character immediately.

• The Graffiti writing area is divided into two parts: one for writing the letters of the 
alphabet and one for writing numbers. The small marks at the top and bottom of 
the Graffiti writing area indicate the two areas.

To write letters of the alphabet with Graffiti:

1. Tap the screen where you want to write your text (an entry in your Data Book, an 
e-mail address, etc.). 

Note: A blinking cursor must display onscreen above the Graffiti writing 
area before you can begin writing text.

2. Use the The Graffiti Alphabet on page 3-11 to find the stroke shape for the letter 
you want to create. For example, the stroke shown below creates the letter “n.”

Write letters here Write numbers here

Division marks
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Note: There are two different stroke shapes available for some letters. For 
these letters, choose the one that’s easiest for you.

As you’ll see later, you use these shapes to create both upper- and lowercase 
letters.

3. Position the stylus in the left-hand side of the Graffiti writing area. 

4. Start your stroke at the heavy dot, and draw the stroke shape as it displays in the 
table.

Note: Don’t try to draw the dot shape itself. The heavy dot is there to show 
the starting point of the stroke.

5. Lift the stylus from the screen at the end of the stroke shape.

That’s all there is to it! When you lift the stylus from the screen, your SPT 1700 terminal 
recognizes your stroke immediately and prints the letter at the insertion point on the screen.

As soon as you lift the stylus from the screen, you can begin the stroke for the next 
character you want to write.

Caution

You must make the character strokes in the Graffiti writing area or your 
SPT 1700 terminal does not recognize them as text characters.

Start stroke at 
heavy dot

Lift stylus here
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Graffiti Tips
When writing with Graffiti, keep these tips in mind:

• Accuracy improves when you write large characters. Draw strokes that nearly fill 
the Graffiti writing area.

• To delete characters, simply set the insertion point to the right of the character you 
want to delete and make the backspace stroke (a line from right to left) in the Graffiti 
writing area.

• Write at natural speed. Writing too slowly can generate recognition errors.

• Do not write on a slant. Vertical strokes should be parallel to the sides of the Graffiti 
writing area.
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The Graffiti Alphabet

Letter Strokes Letter Strokes

A N

B
   

O
   

C P
    

D
    

Q

E R
    

F
    

S

G
   

T

H U

I V
   

J W

K X
   

L Y
    

M
    

Z

Space Back Space
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Writing Capital Letters With Graffiti

Note: Make capital letters with the same stroke shapes as the basic 
alphabet characters. First “shift” to caps — just as you press the 
Shift key on a keyboard — and then write the character strokes. 
Graffiti includes a Smart Shifting feature which automatically 
capitalizes the first letter when you create a new entry (by tapping a 
New button or a blank line).

To draw the first letter of a word as a capital letter use the Caps Shift stroke:

Tip: When Caps Shift is active, an “up arrow” symbol displays in the lower-right 
corner of the SPT 1700 terminal screen.

To enter only capital letters (Caps Lock) use the Caps Lock stroke:

Tip: When Caps Lock is active, an underlined “up arrow” symbol displays in the 
lower-right corner of the SPT 1700 terminal screen. To return to lowercase, make 
the Caps Shift stroke.

Writing Numbers With Graffiti
Writing numbers with Graffiti is similar to writing letters, except that you make the character 
strokes on the right-hand side (numbers side) of the Graffiti writing area.

Carriage
Return

Period tap twice

Caps
Shift

   

Caps
Lock
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Graffiti Numbers

Writing Punctuation Marks With Graffiti
Graffiti can create any punctuation symbol that you can enter from a standard keyboard. All 
punctuation marks begin with a single tap on the Graffiti writing area. When you make this 
tap, you activate Punctuation Shift and a dot displays to show it is active. The next stroke 
you make with the stylus creates a punctuation mark.

Number Strokes Number Strokes

0
    

5
    

1
 

6

2 7
 

3 8
    

4
    

9

Symbol Stroke Symbol Stroke

Period
.

 

Dash
—

Comma
,

Left Paren
(

Apostrophe
'

Right Paren
)

Question
?

Slash
/

 

Punctuation shift
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Additional Graffiti Punctuation

Note: When Punctuation Shift is active, you can make a symbol stroke 
anywhere in the Graffiti writing area (the letters or numbers side).

Writing Symbols and Extended Characters
All symbols and extended characters begin with the stroke in the Graffiti writing area of your 
SPT 1700:

When the Symbol Shift is active, a slanted shift symbol displays in the lower-right corner of 
the screen. The next stroke that you make creates the symbol or extended character.

Exclamation
!

Dollar
$

Symbol
Shift

   

@     #     %     ^      &    *     <     >      –     +      =      | 

\      {      }     [       ]     ~     `         ;     :      "      tab

•                           , , ,, , .,

+ – X : = =c Y

? !

ƒ ∅
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Writing Accented Characters
To create accented characters, draw the stroke normally used to letter, followed by an 
accent stroke. Graffiti then adds the accent to the letter.

For example, the following diagram shows the strokes required to draw an accented “e.”

Accent Strokes

Using these accent strokes, you can write the following accented letters:

à á â ã ä å è é ê ‘ “ ’ ” • ò — ô õ ö ù ú û ü – ÿ n ∆ ñ 

Additional Non-English Characters
You can write the following characters in the lowercase alphabet mode without any special 
punctuation or shifting:

Note: You must write these non-English characters in the left side of the 
Graffiti writing area.

Navigation Strokes
In addition to character symbols, Graffiti includes special strokes that you can use to 
navigate within text or fields in your SPT 1700 terminal applications.

= e

a         a       a        a        a       a

c ae
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Graffiti ShortCuts
Graffiti’s ShortCuts are similar to the Glossary or Autotext features of some word 
processors and make entering commonly used words or phrases quick and easy. 

Graffiti comes with several predefined ShortCuts, and you can also create your own. Each 
ShortCut can represent up to 45 characters. For example, you might create a ShortCut for 
your name, or for the header of a memo. Refer to ShortCuts Preferences on page 14-29 to 
learn about creating your own ShortCuts.

To use a ShortCut, draw the ShortCut stroke followed by the ShortCut characters. When 
you draw the ShortCut stroke, the ShortCut symbol displays at the insertion point to show 
that you are in ShortCut mode.

Navigation Command Stroke

Move cursor right  

Move cursor left

Previous field
(Address Book only)

Next Field
(Address Book only)

Open Address Record
(Address Book only)

ShortCut    
3-16

Download from Www.Somanuals.com. All Manuals Search And Download.



Working with Your SPT 1700 Terminal
Your SPT 1700 terminal includes the following predefined Graffiti ShortCuts:

For example, to enter the current date and time, draw the following strokes:

Using the On-Screen Keyboard

You can activate the on-screen keyboard any time you need to enter text or numbers on 
your SPT 1700 terminal as an alternative to Graffiti. Note that you cannot enter Graffiti 
characters while using the on-screen keyboard. 

To use the on-screen keyboard:

1. Open any SPT 1700 terminal application (such as the Memo Pad application, as 
described in the previous section). 

2. Tap any record name, or tap the New button.

Entry ShortCut

Date stamp ds

Time stamp ts

Date / time stamp dts

Meeting me

Breakfast br

Lunch lu

Dinner di
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3. Tap the left target to open the Alpha keyboard, or tap the right target to open the 
Numeric keyboard.

4. Tap the characters of the on-screen keyboard to enter text and numbers. 

Note: The on-screen keyboard also includes a dialog for international 
characters. You can switch among the three dialogs at any time to 
enter the exact text you need.

After you finish, tap the Done button to close the on-screen keyboard and place the text in 
your SPT 1700 terminal application.

Tap here for letters 
keyboard

Tap here for numbers 
keyboard

Backspace

Carriage return

Tab

Caps lock

Caps shift

Tap here to display 
Alpha keyboard 

Tap here to display 
Numeric keyboard 

Tap here to display 
International keyboard 

Alpha 

Numeric International
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Using Application Controls

SPT 1700 applications include several types of controls. Once you become familiar with 
these controls, you can easily select options and navigate through your SPT 1700 terminal 
applications. The following table lists the controls and how to use them.

Check box. When a check mark displays in a check 
box, the corresponding option is active. If a check 
box is empty, tap it to insert a check mark. If a check 
box is checked, tapping it removes the check mark.

Scroll arrows.Tap the up arrow to display the 
previous page of information, or tap the down arrow 
to display the next page. These arrows perform the 
same function as pressing the upper and lower 
portions of the scroll button on the front panel of the 
SPT 1700 terminal. 

Pick list.Tap the arrow to display a list of choices, 
and then tap an item on the list to select it.

Button.Tap a button to perform a command. Buttons 
display with different text depending on their function. 
In most cases, tapping a button opens or closes a 
dialog. A dialog is a screen that displays on your SPT 
1700 terminal, prompting you to enter information or 
make settings. A dialog always contains an OK, 
Cancel or Done button, so you can close the dialog 
when you are through with it. The on-screen 
keyboard is an example of a dialog.

Scroll bar. Drag the slider to scroll the display one 
line at a time. To scroll to the previous page, tap the 
arrow at the top of the scroll bar. To scroll to the next 
page, tap the arrow at the bottom of the scroll bar.
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Using Menus

Menus are a special set of commands available in most of your SPT 1700 terminal 
applications (Memo Pad, Date Book, etc.). The exact commands that display in the menus 
depend on the application that is currently running on your SPT 1700 terminal. 

Some menu commands are common to all SPT 1700 terminal applications. These are 
described in this section; other menu commands are described in the chapters about each 
SPT 1700 terminal application.

To activate the menus:

1. Open an SPT 1700 terminal application (such as the Memo Pad, as described 
earlier in this chapter).

2. Tap the  icon to open the menus for the application at the top of the screen.

In this example, three menus are available: Record, Edit and Options. The Record menu is 
selected and contains the “New Memo,” “Delete Memo” and “Beam Memo” commands.

Choosing a Menu
After you activate the menus for an application, tap the menu that contains the command 
you want to use.

Tap the Menus icon
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The menus and menu commands available depend on the application currently running on 
your SPT 1700 terminal, and vary depending on which part of the application is currently 
on the screen. Using the Memo Pad application as an example, the menus are different for 
the Memo List screen and the Memo screen.

Graffiti Menu Commands
Most menu commands have Graffiti “Command stroke” equivalents — similar to keyboard 
commands on computers. The command letters display on the right side of the menu 
commands. 

To use the Graffiti menu commands, draw the Command stroke followed by the 
corresponding command letter. When you draw the Command stroke, the Command 
symbol displays just above the Graffiti writing area to indicate that you are in Command 
mode.

For example, to activate the Select All command in the previous diagram, draw the 
Command stroke, followed by the letter “s.”

Note: You do not have to tap the  icon or access the menus when you 
use the Graffiti menu commands. However, since the Command 
mode is active for approximately two seconds, you must write the 
letter character immediately to activate the menu command. 

Edit Menu Commands
The Edit menu is available with any screen where you enter or edit text. In general, the Edit 
Menu commands available in the Edit menu apply to text that you select in an application.

To select text in an application:

1. Tap the beginning of the text that you want to select.

2. Drag the stylus over the text to highlight it (in black). 

Note: You can drag across the text to select additional words, or drag 
down to select a group of lines.

Command    
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The following commands may display in an Edit menu:

Undo Reverses the action of the last edit command. 
For example, if you used the Cut command to 
remove text, the Undo command replaces the 
text you removed.

Cut Removes the selected text and stores it 
temporarily in the memory of your SPT 1700 
terminal. You can paste the cut text into another 
area of the application or into a different 
application.

Copy Copies the selected text and stores it temporarily 
in the memory of your SPT 1700 terminal. You 
can paste the copied text into another area of the 
application or into a different application.

Paste Inserts the text that you cut or copied at the 
selected point in your SPT 1700 terminal 
application. The Paste command replaces any 
selected text. If you did not previously cut or copy 
text, the Paste command does nothing.

Select All Selects all of the text on the current record or 
screen. This enables you to cut or copy all of the 
text and paste it elsewhere.

Keyboard Opens the on-screen keyboard. When you finish 
with the on-screen keyboard, tap the Done 
button.

Graffiti Help Opens the dialogs that show the Graffiti character 
strokes. Use this command any time you forget a 
stroke for a particular character.
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Choosing Fonts

In most of your SPT 1700 terminal applications, you can change the font style to make the 
text on the screen easier to read. You can even choose a different font style for each 
application that supports this feature.

Note: The Expense application does not support changing fonts.

To change the font style:

1. Open a SPT 1700 terminal application.

2. Tap the  icon to open the menus at the top of the screen. 

3. Tap Font from the Options menu to open the Select Font screen.

4. Tap the font style you want to use.

Tap here for small font
Tap here for bold font

Tap here for large font
3-23

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
5. Tap the OK button to close the screen and return to the application with the new 
font style.

Using Categories

Categories can help you group Address entries, To Do items, Memos, and Expense 
application records for easy review. You cannot, however, assign categories to Date Book 
events.

When you first create an entry, it is automatically assigned to the currently displayed 
category. For example, if a record is created while the Personal category is displayed, the 
record is assigned to the Personal category. If a record is created while the All category is 
displayed, it will be designated as “Unfiled,” which means it does not belong to any 
particular category. You can leave an entry as Unfiled or assign it to a category at any time. 
Either way, the entry is always available until you delete it. The category you choose is used 
only for sorting and reviewing records, and does not affect the actual contents of the record.

Small font
Large font

Bold font
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Note: The use of categories is optional. You do not need to assign 
categories to use SPT 1700 terminal applications.

To assign a category to an entry:

1. Tap a To Do item, Memo, Expense record or an Address Book entry.

2. Tap the Details button to open the Details screen (for an Address Book entry, you 
then tap the Edit button).

3. Tap the Category pick list to display a list of available categories.

4. Tap the category that you want to assign to the entry.

5. Tap the OK button to close the Details screen and activate your setting.

Using Categories in Lists
After you assign categories to your entries, you can easily display lists of your entries by 
category. 

To use categories in a List screen:

1. Tap the category pick list in the upper-right corner of the List screen.

Tap here
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2. Tap the category of entries that you want to view. The List screen changes to show 
only the records filed in that selected category.

3. Repeat the previous steps, and tap All in the category pick list to restore the list of 
all Address Book entries.

Tip: Pressing the application button on the front panel of the SPT 1700 terminal 
toggles through the available categories.

Defining a New Category
Your SPT 1700 terminal comes with two default categories: Business and Personal. In 
addition, the Address Book contains the QuickList category, designed as a “quick 
reference” of commonly used names, addresses and phone numbers (such as doctor, 
lawyer, etc.).

You can change the names of these default categories, or add new categories to suit your 
needs. You can define up to 15 categories for each application.

To define a new Address Book category:

1. Tap the category pick list in the upper-right corner of the screen.

Tap here
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2. Tap the Edit Categories item to open the Edit Categories screen.

3. Tap the New button to open another Edit Categories screen.

4. Enter the name of the new category, and tap the OK button to close the Edit 
Categories screen.

5. Tap the OK button to close the first Edit Categories screen and view your new 
category in the pick list.

Note: You can edit any of your records and file them in the new categories 
as appropriate.

Renaming Categories
You can also use the Edit Categories screen to change the names of any existing category.

To change the name of an Address Book category:

1. Tap the category pick list in the upper-right corner of the screen.
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2. Tap the Edit Categories item to open the Edit Categories screen.

3. Tap the category that you want to rename, then tap the Rename button to open 
another Edit Categories screen.

4. Enter the new name that you want to assign to the category, and tap the OK button 
to close the Edit Categories screen.

5. Tap the OK button to close the first Edit Categories screen and view the new name 
in the pick list.

Note: You can “merge” two or more Categories by assigning them the 
same name. For example, if you change the name of the “Personal” 
category to the name “Business,” all entries formerly in the Personal 
category display in the Business category.
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Attaching Notes

SPT 1700 terminal applications (except the Memo Pad) enable you to attach a note to an 
entry. A note is anything that you want to write, and can be up to several thousand 
characters long. For example, if you have an appointment in the Date Book application, you 
could attach a note with directions to the location.

To attach a note to an entry:

1. Display the entry where you want to add a note. 

2. Tap the Details button to open the Details screen. 

Note: In the Address Book only, the Edit button is used.

3. Tap the Note button to open the Note screen.

4. Write Graffiti character strokes or the on-screen keyboard for the text you want to 
appear in the note. Use the Carriage Return stroke to move down to new lines in 
the note.

5. Tap the Done button to close the note and return to the application screen. A note 
icon displays at the right side of any item that has a note attached. To review or edit 
a note, tap the  icon. To delete a note, tap the  icon, Delete, and then Yes to 
confirm.

Note icon
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Marking Private Entries
In SPT 1700 terminal applications you can mark individual entries as Private. Private 
entries remain visible and accessible until you change the Security setting to hide all Private 
entries. Refer to Chapter 15, Applications: Security for complete information about how to 
activate and use the SPT 1700 terminal Security settings.

To mark an entry as Private:

1. Display the entry that you want to mark as Private. 

2. Tap the Details button to open the Details screen. 

3. Select the Private check box to insert a check mark and mark the entry as Private.

The Private Records screen displays:

Beaming Information to Other SPT 1700 Terminals

Your SPT 1700 terminal is equipped with an IR (infrared) port that can “beam” information 
to other compatible printers and terminals. The IR port is located on the back of the 
terminal. Refer to Parts of the SPT 1700 on page 1-4 for the exact location of the IR port.

Note: If you are using a device other than an SPT 1700 terminal, confirm 
that your device includes the required infrared hardware before you 
use this feature.

You can beam the following information between SPT 1700 terminals:

• The current Address Book, Date Book, To Do List or Memo Pad entry

• All the Address Book, To Do List or Memo Pad entries in the current category

• A special Address Book entry which you designate as a “business card” (refer to 
Beaming Address Entries to Other SPT 1700 Terminals on page 5-10 for details).

• An application installed in RAM memory.
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To beam information:

1. Locate the entry, category, business card or application you want to beam.

2. Tap the  icon.

3. Tap the Beam command from the Record menu to open the Beam Status screen. 

4. Point the IR port directly at the IR port of the receiving SPT 1700 terminal.

Tip: SPT 1700 terminals transmit data at varying distances up to three ft., 
depending on lighting conditions when IR is activated. For best results, the IR 
windows should be aligned and clear of obstacles.

5. Wait for the Beam Status screen to indicate that the transfer is complete before you 
continue working on your SPT 1700 terminal.

To receive beamed information:

1. Turn on your SPT 1700 terminal.

2. Point the IR port directly at the IR port of the transmitting SPT 1700 terminal to open 
the Beam Status screen.

3. Tap the Yes button to accept the transmission.

4. Wait for the Beam Status screen to indicate that the transfer is complete, then tap 
the OK button to display the new entry.

Note: Incoming entries are filed under the “Unfiled” category. 
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To turn beaming off:

1. Tap the Applications icon, then Prefs.

2. In the pick list in the upper right corner, pick General.

The Beam Receive pick list gives you the options of On or Off.

Scanning with the SPT 1700

The SPT 1700 has an integrated laser bar code scanner which, if your unit is configured to 
use scanning input, allows you to collect data by scanning bar codes. 

To scan bar codes with the SPT 1700:

1. Start your scanning application.

2. Aim the scanner at the bar code.

3. Press either the right, left or center scan trigger. Make sure the red scan beam 
covers the entire bar code. The green scan LED lights and a beep sounds to 
indicate a successful decode.
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Finding Information With Your SPT 1700 
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Finding Information With Your SPT 1700 Terminal
Introduction

This chapter explains how to locate information on your SPT 1700 terminal with the Find 
command and the Phone Lookup command.

Using the Find Command

The Find command locates any text that you specify and is available in any SPT 1700 
terminal application. You can search for whole words or the beginning letters of a word. The 
Find command searches all the data on your SPT 1700 terminal and lists which 
applications contain the text.

For example, suppose you want to find a particular name, but aren’t sure where you stored 
it. The Find command immediately lists all instances of that name and enables you to jump 
directly to the name.

To use the Find command:

1. Tap the  icon from any SPT 1700 terminal application to open the Find screen.

Tip: If you select text in an application before you tap the Find button, the selected 
text automatically displays in the Find screen.

2. Enter the text that you want to find in your SPT 1700 terminal. 

Note: The Find command is not case-sensitive. In other words, searching 
for the name “davidson” also finds “Davidson.” The Find command 
also searches the contents of notes.

3. Tap the OK button to display a list of all instances of the text that you specified.
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Note: As your SPT 1700 terminal searches for the text, you can tap the 
Stop button to stop the search at any time. For instance, if the entry 
you want displays before your SPT 1700 terminal finishes the 
search. To continue the search after you tap Stop, tap the Find More 
button.

4. Tap the text that you want to review. The selected entry and its corresponding SPT 
1700 terminal application display on the screen.

Using Phone Lookup

In addition to using the Find feature to locate text, you can search for and display phone 
numbers with the Phone Lookup menu command. After you find a phone number, you can 
paste it directly into an SPT 1700 terminal application.

For example, if you want to include a phone number in a memo, use the Phone Lookup 
feature to find the phone number and transfer it directly into the memo.

To use the Phone Lookup command:

1. Display the entry where you want to insert a phone number. This can be an event 
in the Date Book, a To Do List Item or a memo in the Memo Pad application.

Note: The Phone Lookup feature is not available in the Address Book and 
Expense applications.

2. Tap the  icon to open the menus for your application.
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3. Tap Phone Lookup from the Options menu to display the Phone Number Lookup 
screen.

4. Tap the phone number you want to use. 

Note: To find a phone number more quickly, you can enter the first letter of 
the name you want to find in the Look Up line at the bottom of the 
screen. The list scrolls to the first name that starts with that letter. 
You can continue to add letters to narrow your search.

5. Tap the Add button to close the Phone Number Lookup screen and paste the name 
and phone number you selected into the entry selected in step 1.

Phone Lookup Tips
You can also use the Graffiti Command stroke “/L” to activate the Phone Lookup feature. 

• You can use Phone Lookup while entering text. For example, to insert the full name 
and phone number for someone with the last name “Williams,” write the Graffiti 
characters for “Wi”, then the Phone Lookup Command stroke “/L.” 
Assuming you have only one Address Book entry that begins with “Wi,” your SPT 
1700 terminal inserts the full name “Williams” (and the corresponding phone 
number). If you have more than one name that begins with “Wi,” the Phone Lookup 
screen displays.

• The Phone Lookup feature also works for selected text. Drag to highlight the text, 
and then write the Phone Lookup Command stroke “/L.” Your SPT 1700 terminal 
replaces the selected text and adds the phone number to the name that it finds.
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Applications: Address Book
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Applications: Address Book
Introduction

The Address Book enables you to keep names, addresses, phone numbers and other 
information about your personal or business contacts.

With the Address Book, you can:

• Quickly look up or enter names, addresses, phone numbers and other information.

• Enter up to five phone numbers (home, work, fax, car, etc.) or e-mail addresses for 
each name.

• Define which phone numbers appear in the Address List screen for each Address 
Book entry. 

• Attach a note to each Address Book entry where you can enter additional 
information about the entry.

• Assign categories to your Address Book entries, so you can quickly sort and view 
them in logical groups.

Opening the Address Book
To open the Address Book:

1. Press the Address Book button on the front panel of the SPT 1700 terminal to open 
the Address Book and display a record list.

Tip: Press the Address Book button repeatedly to cycle through the categories in 
which you have records.

Address Book
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Address Book Entries

An Address Book entry is where you store name and address information about people or 
businesses. Your SPT 1700 terminal makes it easy to create, edit and delete Address Book 
entries.

Creating an Address Book Entry
You can create Address Book entries on your SPT 1700 terminal, or use the Symbol Palm 
Terminal Desktop software to create Address Book entries on your computer and download 
the entries to your SPT 1700 terminal with the next HotSync operation. Refer to Chapter 9, 
Applications: HotSync® for details.

Note: The Symbol Palm Terminal Desktop software also has data import 
capabilities that enable you to load database files into the Address 
Book on your SPT 1700 terminal. Refer to the online documentation 
supplied with the Symbol Palm Terminal Desktop software for 
details.

To create a new Address Book entry:

1. Press the  button on the front of your SPT 1700 terminal to display the Address 
List screen.

2. Tap the New button to display the Address Edit screen.

Tap New

Cursor 
at Last 
name
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3. Enter the last name of the person you want to add to your Address Book. 

Note: Your SPT 1700 terminal automatically capitalizes the first letter of 
each field (except numeric and e-mail fields). You do not have to use 
the Graffiti capital stroke to capitalize the first letter of the name. 

4. Tap the Last Name selected field.

5. Enter the person's information in that field.

6. Repeat steps 4 and 5 to enter the other information that you want to include in this 
Address Book entry.

7. Tap the  arrows to move to the next page of information.

8. After you finish entering information, tap the Done button to return to the Address 
List screen.

Note: You can also attach a note to an entry simply by tapping Note and 
entering the necessary information. 

Tip: You can create an Address Book entry that always displays at the top of the 
list by beginning the Last name (or Company name) field with a blank space. For 
example, you might create an “If Found Call” entry that contains your name and 
phone number in case you lose your SPT 1700 terminal.

Tap Done
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Deleting an Address Book Entry
Use the Menu Commands (described in Record Menu on page 5-12) or the Address Entry 
Details screen to delete an entry.

To delete an entry with the Address Entry Details screen:

1. Tap the Address Book entry that you want to delete to display the Address View 
screen for that entry.

2. Tap the Edit button to display the Address Edit screen.

3. Tap the Details button to open the Event Details screen.

4. Tap the Delete button to open the Delete Address alert.

5. Tap the OK button to confirm you want to delete the entry.

Duplicating an Address Book Entry
You can duplicate existing entries, which can be helpful when you want to enter multiple 
people from a single organization. When you duplicate an entry, the word Copy displays 
next to the name in the First Name field. 

To duplicate an entry:

1. Tap the name you want to duplicate.

2. Perform one of the following:

• Tap the Address Edit tab at the top of the screen; then tap Duplicate Record in 
the Record menu. 

• In the Graffiti text area of your device’s screen, drag a diagonal line from the 
lower left to upper right to display the Command toolbar; then write a T in the 
Graffiti text area to initiate the Duplicate Record command.

3. Edit the record as necessary. 

Working with Address Book Entries
Your SPT 1700 terminal enables you to quickly find your Address Book entries, group them 
by category, and display the entries by name or company name. You can also choose the 
type of information you want your entries to include and exchange Address Book 
information with other SPT 1700 terminal users.
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Looking Up Address Book Entries
When working with the Address Book, the scroll button on the front panel of the SPT 1700 
terminal makes it easy to navigate among your address entries. In the Address List screen, 
the scroll button moves up or down an entire screen of address entries. If you hold down 
the scroll button, you accelerate the scrolling so that it displays every third screen. In the 
Address View screen, the scroll button moves to the previous or next address entry.

You can also use the Address List Look Up feature to quickly scroll to any of your Address 
Book entries. 

To look up an Address Book entry:

1. Display the Address List screen.

2. Enter the first letter of the name you want to find.

Note: The letter displays on the Look Up line and the list scrolls to the first 
entry that begins with that letter. If you write another letter, the list 
scrolls to the first entry that starts with those two letters. For 
example, writing an “s” might scroll to “Sands,” and writing “sm” 
might scroll further to “Smith.” If you sort the list by company name, 
the Look Up feature scrolls to the first letter of the company name.

3. Tap any entry to view its contents, or use the carriage return stroke to view the 
selected entry.

Choosing Types of Phone Numbers
Your SPT 1700 terminal enables you to choose the types of phone numbers or e-mail 
addresses that you associate with an Address Book entry. Any changes you make apply 
only to the current Address Book entry. 

Look Up line
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To choose other types of phone numbers in an Address Book entry:

1. Tap the Address Book entry. 

2. Tap the Edit button to display the Address Edit screen for that entry.

3. Tap the pick list next to the label you want to change. 

4. Tap the new label you want to use.

Assigning Address Categories
Categories can help you file individual Address Book entries into groups for easy review. 
You can assign and edit categories in the Address Book or by using the Categories pick list 
in the Details screen (Refer to Using Categories on page 3-24 for a complete description 
of categories). 

To assign a category to an Address Book entry:

1. Tap the Address Book entry you want to assign to a category. 

2. Tap the Edit button in the Address View screen to display the Address Edit screen.

3. Tap the pick list in the upper-right corner and tap the category that you want to 
assign to the Address Book entry.

Sorting by Name or Company
You can sort the entries in the Address List screen by Company and Last Name, rather than 
by Last Name and First Name. These settings do not change your Address Book data; they 
merely change the view.

Tap triangle
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To sort the entries in the Address List screen:

1. Display the Address List screen. 

2. Tap the  icon to open the Address Book menus.

3. Tap Preferences from the Options menu to open the Address Book Preferences 
screen.

4. Tap the setting that you want for the Address List screen.

5. Tap the OK button to display the Address List screen with your new setting.

Note: Entries with no company name sort by last name. 

Editing Address Entry Details
The Address Entry Details screen provides a variety of options that you can associate with 
an Address entry. 

To open the Address Entry Details screen:

1. Tap an Address Book entry to display the Address View screen for that entry.

2. Tap the Edit button to display the Address Edit screen.

3. Tap the Details button to open the Address Entry Details screen.
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4. Select any of the following settings:

Beaming Address Entries to Other SPT 1700 Terminals
The IR port on your SPT 1700 terminal enables you to beam the following Address Book 
entries to other SPT 1700 terminals:

• Business card. A specially designated entry containing information you want to 
exchange with business contacts. You can send your business card quickly with 
one-touch beaming.

• Current address entry. The entry currently selected on your SPT 1700 terminal. 
For example, you may want to beam the name of a business contact to a coworker 
who also uses an SPT 1700 terminal.

• Category of address entries. All entries assigned to the selected category. For 
example, you might want to share your list of restaurants with a friend. 

Note: For more on the IR port, refer to Beaming Information to Other SPT 
1700 Terminals on page 3-30.

To select a business card:

1. Create an Address Book entry containing the information you want on your 
business card.

2. Tap your business card entry to display the Address View screen for that entry.

3. Tap the  icon to open the Address Book menus.

4. Tap Select Business Card from the Record menu, and tap Yes to accept this entry 
as your business card.

To beam a business card:

1. Tap your business card entry to display the Address View screen for that entry.

2. Tap the  icon to open the Address Book menus.

Show in List Choose which type of phone or other information displays on the 
Address List screen for the current entry. Your options are: Work, 
Home, Fax, Other and E-mail.

Category Assign the entry to a particular category. Your options are: Business, 
Personal, QuickList, Unfiled and Edit Categories.

Private Hide this entry when the security features are turned on.
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3. Tap Beam Business Card from the Record menu to beam your card to another SPT 
1700 terminal.

Tip: You can press the  button for about two seconds to beam your card.

To beam the current entry:   

1. Tap an Address Book entry that you want to beam to display the Address View 
screen for that entry.

2. Tap the  icon to open the Address Book menus.

3. Tap Beam Address from the Record menu to beam the current entry to another 
SPT 1700 terminal through the IR port. 

Tip: You can set the full-screen pen stroke to beam the current entry. Refer to Pen 
Preferences on page 14-5 for details. 

To beam the current category: 

1. Display the Address List screen.

2. Tap the pick list in the upper-right corner and tap the category you want to beam to 
display the entries in that category.

3. Tap the  icon to open the Address Book menus.

4. Tap Beam Category from the Record menu to beam the entries in the current 
category to another SPT 1700 terminal through the IR port. 

Address Book Menu Commands

The Address Book includes menu commands to make it fast and easy to perform common 
file and editing tasks. This section explains the menu commands specific to the Address 
Book.

Refer to Using Menus on page 3-20 for information about menu commands common to all 
of your SPT 1700 terminal applications.
5-11

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
Record Menu
When you select the Record menu, its commands display on the screen. The menu 
commands are slightly different depending on the current screen.

Delete Address Opens an alert screen prompting you to confirm deletion of the current 
entry. Tap the OK button to delete the entry from your SPT 1700 
terminal, or tap the Cancel button to close the alert screen and keep the 
entry.
Note: By default, your SPT 1700 terminal removes the entry from the 
Address Book, but retains a copy of the entry and transfers it to an 
archive file on your computer the next time you perform a HotSync 
operation. To remove the entry completely, clear the Save archive copy 
on PC check box. 

Attach Note Opens the Address Book Note screen where you can create a Note for 
the current entry.

Delete Note Opens an alert screen prompting you to confirm deletion of the Note 
attached to the entry. Tap the OK button to delete the Note, or tap the 
Cancel button to close the alert screen and keep the note. 

Beam Address Beams the current Address Book entry to another SPT 1700 terminal 
through the IR port.

Beam Category Beams all Address Book entries in the current category to another SPT 
1700 terminal through the IR port.

Select Business 
Card

Enables you to select the current Address Book entry as your business 
card. To beam your business card to other SPT 1700 terminals, use the 
Beam Business Card command.

Beam Business 
Card

Sends the current business card to another SPT 1700 terminal through 
the IR port. You can also initiate this command by holding down the 
Address Book button for at least two seconds. This is a convenient way 
to exchange business cards with other SPT 1700 terminal users.

Address List 

Address View
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Options Menu
When you select the Options menu, its commands display on screen:

Font Opens the Select Font screen where you can choose a different 
font (text) style for your Address Book entries. Refer to 
Choosing Fonts on page 3-23 for details.

Preferences Opens the Address Book Preferences screen.

• Remember last category. Determines how the 
Address Book displays when you return from another 
Palm application (Memo Pad, To Do List, etc.). If you 
select this check box, the Address Book shows the last 
category you selected. When you clear it, the Address 
Book shows the address entries for all categories.

• List By. Determines whether address entries sort by 
last name, first name or by company name, last name 
in the Address List screen.

Address List 
Address View
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Rename 
Custom Fields

Enables you to define custom field names. Each Address Book 
entry contains four “custom fields” that you can rename. Any 
changes you make to the names of the custom fields display in 
all of your Address Book entries. 

About Address 
Book

Shows version (revision) information for the Address Book 
application.
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Introduction

The Calculator enables you to perform basic mathematical calculations. You can also store 
and retrieve values in the Calculator’s memory.

Opening the Calculator

To open the Calculator:

1. Tap the  icon.

Using the Calculator Screen

The Calculator performs general mathematical functions including addition, subtraction, 
multiplication and division. 

To use the Calculator screen, tap the Calculator buttons that appear on the screen.

Special Calculator Buttons
The Calculator includes several buttons to help you perform calculations.

Clears the last number you entered. Use this button if you make a 
mistake while entering a number in the middle of a calculation. This 
button enables you to re-enter the number without starting the 
calculation over.
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Calculator Menu Commands

The Calculator supports Copy and Paste commands. You can use these commands to 
copy a value from the Calculator and paste it into another application on your SPT 1700 
terminal. Similarly, you can copy values from other applications on your SPT 1700 terminal, 
such as Expense, and paste the values into the Calculator. For additional information on 
the Copy and Paste commands, refer to Using Menus on page 3-20.

Clears the entire calculation to begin a new calculation.

Toggles the current number between a negative and positive value. If 
you want to enter a negative number, enter the number first and then 
press the +/- button.

Places the current number into Memory. Each new number you enter 
with the M+ button is added to the total already stored in memory. The 
number that you add can be either a calculated value, or any number 
you enter by pressing the number buttons. Pressing this button has no 
effect on the current calculation (or series of calculations); it merely 
places the value into memory until it is recalled.

Recalls the stored value from memory and inserts it in the current 
calculation.

Removes any value stored in the Calculator memory.
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Recent Calculations
The Recent Calculations command enables you to review the last series of calculations, 
and is particularly useful for confirming a series of “chain” calculations.

To display the Recent Calculations:

1. Tap the  icon to open the Calculator menus.

2. Tap Recent Calculations from the Options menu to display the Recent Calculations 
screen.

3. When you finish reviewing the screen, tap the OK button to close the Recent 
Calculations screen and return to the Calculator.
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Introduction

The Date Book enables you to quickly and easily schedule appointments or any kind of 
activity associated with a time and date.

With the Date Book, you can:

• Enter a description of your appointment and assign it to a specific time and date.

• Schedule: events by time and /or date, repeating events such as weekly meetings, 
and continuous events such as a three day conference.

• Display a chart of your appointments for an entire week. The Week View feature 
makes it easy to spot any potential scheduling overlaps or conflicts. They can also 
be displayed by Day, Month, or Agenda.

• Display a monthly calendar to quickly spot days where you have morning, lunch or 
afternoon appointments.

• Set an alarm to sound prior to the scheduled activity. 

• Create reminders for events that are based on a particular date, rather than time of 
day. Birthdays and anniversaries are easy to track with your SPT 1700 terminal.

• Attach notes to individual events for a description or clarification of the entry in your 
Date Book.

Opening the Date Book
To open the Date Book, press the Date Book button on the front panel of the SPT 1700 
terminal.

Tip: Press the Date Book button repeatedly to cycle through the Day, Week, Month 
and Agenda Views.

Date Book button
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Using the Date Book

Each entry in the Date Book is called an event, any kind of activity that you associate with 
a day. When the Date Book screen first displays, it shows the current date and a list of times 
for a normal business day. You can enter a new event on any of the available time lines. 

Scheduling an Event
When you create an event, its description displays on the time line, and its duration is 
automatically set to one hour. These are referred to as timed events. You can easily change 
the start time and duration for any timed event.

You can also include events in your Date Book that occur on a particular date but have no 
specific start or end times, such as birthdays, holidays and anniversaries. These are 
referred to as untimed events. Untimed events display at the top of the Date Book screen 
with a diamond in the time list. You can have several untimed events on a particular date.

To schedule a timed event for the current day:

1. Tap the time line that corresponds to your event in the Date Book screen.

2. Use the stylus to write Graffiti character strokes (or use the on-screen keyboard) to 
describe your event. You can enter up to 255 characters.

3. If your appointment is longer or shorter than an hour, tap the time of the event to 
open the Set Time screen. If your appointment is one hour long, skip to step 7.

Tap a time

Time bar
shows

duration
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Note: You can also open the Set Time screen to select a start time by 
writing a number on the number side of the Graffiti writing area. No 
event can be selected.

4. Tap the time columns on the right side of the Set Time screen to set the Start Time.

5. Tap the End Time box, and then tap the time columns to set the End Time.

6. Tap the OK button to confirm your selection and close the Set Time screen.

7. Tap a blank area of the screen to de-select the event. A vertical line displays next 
to the time, indicating the duration of the event.

Tap the time 
of an event

Start Time
highlighted

Tap to scroll to 
earlier hours

Tap to scroll to 
later hours

Tap to change 
hours

Tap to change 
minutesTap to set an all

day meeting

Tap to change a
timed event into

an untimed event
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To schedule a timed event for another day:

1. Select the date you want for the event by doing one of the following:

• Tap the day of the week that you want in the Date Bar at the top of the Date 
Book screen. If necessary, tap the Previous week or Next week scroll bars to 
move to another week.

• Tap the Go To button to open the Go to Date screen. Select a date by tapping 
a year, month and day in the calendar.

• Press the scroll button on the front panel of the SPT 1700 terminal to scroll to 
another day. Press the upper half of the button to move to the previous day or 
the lower half to move to the next day. 

2. After you locate the date, follow the steps described in the previous section, To 
schedule a timed event for the current day:

Note: You can also add Address Book information to an event using the 
Phone lookup option. Refer to Using Phone Lookup on page 4-4 for 
details.

Previous
week

Next 
week

Tap to select the day of 
the current week

Previous year Next year

Tap to select 
current date

Tap to scroll to 
earlier hours

Tap to scroll to 
earlier hours
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To schedule an untimed event:

1. Select the date that you want for the event as described in the previous section, To 
schedule a timed event for another day:

2. Tap New to open the Set Time screen.

3. Tap OK, so that no start or end times are defined for the new event.

Note: You can also create a new untimed event by making sure no event 
is selected, then writing letters in the Graffiti writing area.

4. Enter a description for the event (which displays at the top of the Date Book 
screen).

5. Tap a blank area on the screen to de-select the untimed event.

No time 
selected

New 
untimed 
event
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Note: If you create an event and decide later that there is no particular start 
or end time, you can easily change it to an untimed event. Tap the 
time of the event in the Date Book screen, tap the No Time button, 
then tap the OK button to confirm your selection and close the Set 
Time screen.

Rescheduling an Event
You can easily make changes to your schedule with your SPT 1700 terminal. 

To reschedule an event:

1. Tap the event (not the time of the event) you want to reschedule.

2. Tap the Details button to open the Event Details screen for that event.

3. To change the time, tap the Time box and select the new time as described earlier 
in this chapter.

4. To change the date, tap the Date box and select the new date as described earlier 
in this chapter.

5. Tap the OK button to close the Event Details screen and return to the Date Book 
screen.

Setting an Alarm for an Event
The Alarm setting enables you to set an audible alarm for events in your Date Book. You 
can set an alarm to sound minutes, hours or days before an event. When you set an alarm, 
an  icon displays to the far right of the event with the alarm. When the alarm tone 
sounds, a reminder message also displays on the SPT 1700 terminal screen. 

The default Alarm setting is 5 minutes before the time of the event, but you can change this 
to any number of minutes, hours or days.

To set an alarm for an event:

1. Tap the event to which you want to assign an alarm.

2. Tap the Details button to open the Event Details screen for that event.
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3. Select the Alarm check box in the Event Details screen to activate the alarm. (Refer 
to Options Menu on page 7-19 for details about setting alarm options.)

4. Tap the Alarm units pick list to select Minutes, Hours or Days.

5. Select the “5” (default) and enter any number from 0 to 99 (inclusive) as the 
numeric alarm setting.

6. Tap the OK button to close the Event Details screen and return to the Date Book 
screen.

Note: You can set a silent alarm for an untimed event. In this case, the 
alarm triggers at the specified period of minutes, hours or days 
before midnight (beginning) of the day of the untimed event. No 
audible alarm sounds for an untimed event; instead, the reminder 
message displays on the screen of the SPT 1700 terminal.

For example, you could create a reminder for an untimed event that occurs on February 
4th. If the alarm reminder is set for 5 minutes, the alarm reminder displays at 11:55 PM on 
the night of February 3rd. The reminder remains on the screen until you turn on your SPT 
1700 terminal and tap the OK button to dismiss it.

Once an alarm has gone off, you can dismiss the alarm for a 5 minute period using the 
Snooze option.

Tap here to 
select alarm unit

Enter numeric 
setting here
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To dismiss an alarm using the Snooze option:

1. When the alarm goes off, the alarm screen displays:

Scheduling Repeating Events
The Repeat function enables you to schedule events that recur at regular intervals. A 
birthday is a good example of an event that repeats annually. Another example would be a 
weekly guitar lesson that falls on the same day of the week and the same time of day. After 
you enter a repeating event, a  icon displays to the far right of the event.

To schedule a repeating event:

1. Tap anywhere on the text of an event in the Date Book screen.

2. Tap the Details button to open the Event Details screen.

3. Tap the Repeat box in the Event Details screen to open the Change Repeat screen.

4. Tap Day, Week, Month or Year in the Change Repeat screen.

Tap to delay the 
alarm for 5 minutes

Tap the 
Repeat 
box
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5. Enter a number that corresponds to how often you want the event to repeat in the 
“Every” area. For example, if you select Month and enter the number “2,” the event 
repeats every other month.

6. If you want to specify an ending date for the repeating event, tap the End on pick 
list and tap Choose Date. Use the Date Picker to select an end date.

7. Tap the OK button to close the Change Repeat screen and activate your settings.

Considerations for the Repeat Function
• If you change the start date of a repeating event, your SPT 1700 terminal 

calculates the number of days you have moved the event, then automatically 
changes the end date to maintain the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a repeating event, past 
occurrences (prior to the day on which you change the setting) are left alone and 
your SPT 1700 terminal creates a new repeating event.

• If you change the date of an occurrence of a repeating event (e.g., from January 
14th to January 15th) and apply the change to all occurrences, the new date 
becomes the start date of the repeating event. Your SPT 1700 terminal adjusts the 
end date to maintain the duration of the event.

• If you change other repeat settings (e.g., time, alarm, private) of a repeating event 
and apply the change to all occurrences, your SPT 1700 terminal creates a new 
event. The start date of this new event is the day on which the setting is changed. 
Past occurrences (prior to the day of the change) are left alone and not changed.

• If you make a change to one occurrence of a repeating event (e.g., time), that 
occurrence no longer shows the Repeat icon.

Tap the 
Month 
box
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Marking a Private Event
You can designate a specific event as “private.” When you activate the Security features, 
your SPT 1700 terminal hides all private entries and you must enter a password to display 
them on the screen.   

To mark an event as private:

1. Tap the event you want to mark as private.

2. Tap the Details button to open the Event Details screen for that event.

3. Select the Private check box.

4. Tap the OK button to close the Event Details screen and return to the Date Book 
screen.

Deleting an Event
There are three ways to delete an event from the Date Book application: simply delete the 
text of the event, use the Menu Commands (described in the Record Menu section later in 
this chapter), or use the Event Details screen.

Note: If you delete the text of a repeating event, you delete all instances of 
that event. If you use the Menu Command or the Event Details 
screen, you can delete one occurrence of the event (as an 
exception) or all occurrences.

To delete an event with the Event Details screen:

1. Tap anywhere in the text area of the event to delete.

2. Tap the Details button to open the Event Details screen. 

3. Tap the Delete button to open the Delete Event alert.

4. Tap the OK button to confirm you want to delete the event.
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Changing the Date Book View

In addition to displaying the calendar for a specific day, you can also display your Date Book 
by the week, month, and agenda.

To toggle through the different views, press the Date Book button repeatedly to display the 
next view or select one of the Date Book View icons.

To display the current time tap the date in the Date Book title bar to display the current time.

Note: After a few seconds, the title bar reverts to show the date.

Working in Week View
The Week View shows a chart of your events for an entire week. This view lets you quickly 
review your appointments and available time slots. The graphical display helps you spot 
overlaps and conflicts in your schedule.

To display the Week View:

1. Tap the Week View button in the Date Book screen.

2. Tap the navigation controls to move forward or backward a week at a time, or to 
display details of an event. 

Note: The Week View also shows untimed events and events that are 
before and after the range of times shown.

Date Book view icons

Tap the date Current time displays
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3. Tap any of the events to show a description of the event.

Tips for Using Week View
• To reschedule an event, tap and drag the event to a different time or day.

• Tap a blank time on any day to move directly to that day with the Day View screen. 

• Tap any of the days and dates that display at the top of the Week View to move 
directly to that day without selecting an event.

• The Week View shows the time span defined by the Start Time and End Time in 
the Date Book Preferences settings. If you have an event before or after this time 
span, a bar displays at the top or bottom of that day's column, and these  on-
screen scroll arrows display if your scheduled events go beyond the displayed time 
range.

Previous week Next 
week

Bar indicates later event 

Dot indicates untimed event

Bar indicates earlier event

Week View button

Event details

Tap to show event details.
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Spotting Event Conflicts in Week View
With the ability to define specific start and end times for any event, it’s possible to schedule 
events that overlap (an event that starts before a previous event finishes).

In this case, any event conflict (time overlap) displays in the Week View as overlapping 
bars. The Day View displays bracketed bars to the left of the conflicting times.

Working in Month View
The Month View screen shows which days have events scheduled. Dots and lines in the 
Month View indicate events, repeating events and untimed events.

Tips for Using Month View
• Tap any day that displays in the Month View screen to move directly to that day with 

the Day View screen. 

Event 
conflicts

Previous/next month

Dots on right side indicate events.

Dashed line indicates continuous event.

Dots below date indicate untimed events.

Month View button
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• Tap the arrows at the top to move forward or backward a month. 

• Tap the Go To button to open the Date Picker and choose a different month.

• When the Month View is on the screen, you can use the scroll button on the front 
panel of the SPT 1700 terminal to move between months. Press the upper half of 
the button to display the previous month, or press the lower half to display the next 
month.

Note: You can control the dots and lines that display in the Month View. 
Refer to Options Menu later in this chapter.

Working in Agenda View
The Agenda view shows your appointments, untimed events, and To Do List items in a 
single screen. You can also use the Agenda view to check off completed To Do List items. 

To display the Agenda View:

1. Tap the Agenda View button in the Date Book screen.

2. Tap the desired event to go to a Day View of any event on the Agenda view screen.

Tips for Using Agenda View
• Tap any appointment while in Agenda view to display the Day View of the 

appointment. 

• Check off completed To Do List items in the Agenda view, or click a description of 
an item to go directly into the To Do List application. 

Agenda View button
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Date Book Menu Commands

The Date Book includes menu commands to perform common file and editing tasks. This 
section explains the menu commands that are specific to the Date Book. 

Refer to Using Menus on page 3-20 for information about menu commands common to all 
of your SPT 1700 terminal applications.

Record Menu
When you select the Record menu, its commands display on screen.

New Event Creates an event and opens the Set Time screen where you can 
choose start and end times for the new event. If you do not enter start 
and end times, it creates a blank untimed event.

Delete Event Opens an alert screen, prompting you to confirm that you want to 
delete the current event. You must tap an event before you use the 
Delete Event command. Tap the OK button to delete the event from 
your SPT 1700 terminal, or tap the Cancel button to close the alert 
screen and keep the event.

Note: By default your SPT 1700 terminal removes the event from the 
Date Book, but retains a copy of the event and transfers it to an archive 
file on your computer the next time you perform a HotSync operation. 
To remove the event completely, clear the Save archive copy on PC 
check box. 

Attach Note Opens the Note screen, where you can create a Note for the current 
event.

Delete Note Opens an alert screen, prompting you to confirm that you really want 
to delete the Note attached to the event. Tap the OK button to delete 
the Note from the memory of your SPT 1700 terminal, or tap the 
Cancel button to close the alert screen and return to the Date Book.
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Purge Opens an alert screen, prompting you to confirm that you want to 
purge events older than a certain time period — based on the current 
date on the internal clock on the SPT 1700 terminal. You can use the 
Purge command to conserve memory on your SPT 1700 terminal. The 
default setting for the Purge alert is to “Save archive copy on PC.” This 
setting removes events from the Date Book, but retains copies and 
transfers them to an archive file on your computer during the next 
HotSync operation.
Note: The Purge command also deletes repeating events if they end 
before the date that you activate the Purge command.

Beam Event Beams the current event to another terminal through the IR port. Refer 
to Beaming Information to Other SPT 1700 Terminals on page 3-30 for 
more information.
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Options Menu
When you select the Options menu, its commands display on screen.

Font Opens the Select Font screen where you can choose a different font 
(text) style for your Date Book entries. Refer to Choosing Fonts on 
page 3-23 for details.

Preferences Enables you to set the range of times that display in the Date Book, 
and to automatically activate alarms for each event.

• Start/End Time. Enables you to define the start and end 
times for the Date Book screens. If the time slots you select 
do not fit on one screen, you can tap the  arrows to scroll up 
and down.

• Alarm Preset. Automatically sets an alarm for each new 
event. The silent alarm for untimed events is defined by 
minutes, days or hours before midnight of the date associated 
with the event. 

• Alarm Sound. Controls the tone the alarm generates when it 
sounds (i.e., Alert, Bird, Concert, Phone, etc.)

• Remind Me. Defines how many times the alarm sounds. The 
choices are: Once, Twice, 3 times, 5 times and 10 times.

• Play Every. Defines how often the alarm sounds. The choices 
are every: Minute, 5 minutes, 10 minutes and 30 minutes.
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Display Options Allows you to change the Date Book’s appearance and which events 
display.

• Show Time Bars. Activates the time bars that display in the 
Day View. The time bars show the duration of an event and 
illustrate event conflicts.

• Compress Day View. Controls how times display in the Day 
View. When Compress Day View is off, all time slots display. 
When it is on, start and end times display for each event, but 
blank time slots toward the bottom of the screen disappear to 
minimize scrolling. 

• Month View settings. These check boxes apply to the Month 
View of the Date Book. You can activate any or all of these 
settings to show that you have Timed, Untimed or Daily 
Repeating events in the Month View only.

Phone Lookup Activates the Phone Lookup feature. Refer to Using Phone Lookup on 
page 4-4.

Security Opens the Change Security screen where you can change the 
security of the open memo. Refer to Chapter 15, Applications: Security 
for details.

About Date 
Book

Shows version (revision) information for the Date Book application.
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Introduction

The Expense application enables you to keep track of your expenses and then transfer the 
information to a spreadsheet on your computer.

With the Expense application you can:

• Record dates, type of expenses, amount spent, payment method and other details 
associated with any money that you spend.

• Create categories for expenses (such as business and personal) associated with 
a range of dates.

• Keep track of vendors (companies) and people involved with particular expenses.

• Log miles traveled for a particular date or expense category.

• Sort your expenses by date or expense type.

• Transfer your expense information to a Microsoft® Excel spreadsheet (version 5.0 
or later) on your computer. (Microsoft Excel is not included with the SPT 1700 
package.)

Opening Expense

To open Expense:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to display the Expense List screen.
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Using Expense

Expense enables you to record the date, expense type and the amount that you spent. You 
can sort your expense items into categories or add other information that you want to 
associate with the item.

Creating an Expense Item
To create an expense item:

1. Tap the New button in the Expense List to create a new item.

Note: You can also create a new expense item by writing on the number 
side of the Graffiti pad while in the Expense List screen. The first 
number you write begins your new expense item.

2. Enter the amount of the expense. 

3. Tap the Expense Type pick list and select a type from the list.

Tap New

Cursor 
of new 
item

Tap here
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Note: As soon as you select an expense type, your SPT 1700 terminal 
saves your entry. If you do not select an expense type, it does not 
save the entry.

Tip: Here’s a quick way to create a new expense item: make sure that no item in 
the Expense List has been selected, then write the first letter(s) of the expense 
type, followed by the numerical amount of the expense item. This technique takes 
advantage of the application’s automatic fill feature. Refer to Options Menu later in 
this chapter for details.

Changing the Expense Item Date
Initially, expense items display with the date you enter them on your SPT 1700 terminal. 
You can use the Expense application to change the date associated with any expense item.

To change the date of an expense item:

1. Tap the expense item you want to change to highlight the date.

2. Tap the date of the selected item to open the Date screen. 

3. Tap the date you want for the expense item.

For more information about the Date screen, refer to Scheduling an Event on page 7-4.

Entering Receipt Details
The Expense application provides a variety of options that you can associate with an item. 
These options display in the Receipt Details screen.

Tap date
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To open the Receipt Details screen:

1. Select the expense item you want to assign details.

2. Tap the Details button to open the Receipt Details screen.

3. Select any of the following options:

Category Defines the category for the Expense item. Your SPT 1700 terminal 
provides two sample categories, New York and Paris, to show how 
you might sort your expenses according to different business trips.
When All is selected, the default Category is Unfiled. Otherwise, 
the default is the currently selected Category. An expense item 
remains in the default category until you change it.
Choose Edit Categories from the pick list to change existing or to 
create new expense categories. For example, you might create a 
category for a range of dates, such as a week or month, or you 
might delete or rename the New York and Paris categories. 

Type Opens a pick list of the expense type options so that you can 
change the expense type for any of your expense items. Refer to 
Options Menu later in this chapter for information about filling in the 
expense type automatically.

Payment Enables you to choose the payment method used to pay the 
expense item. If the item is prepaid (such as airline tickets supplied 
by your company), you can choose Prepaid to place your expense 
in the appropriate company-paid cell of your printed expense 
report spreadsheet. Refer to Transferring Your Data to Microsoft 
Excel later in this chapter for more information.
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Note: You can tap the Lookup button to display the names (and the 
corresponding companies) of the people in your Address Book. The 
Lookup button’s function is similar to the Phone Lookup feature 
described in Using Phone Lookup on page 4-4.

4. Tap the OK button to close the Receipt Details screen and activate your selections.

Currency Enables you to choose the type of currency used to pay the 
expense item. The default currency unit is defined in the 
Preferences screen (refer to Preferences on page 8-17 later in this 
chapter). You can also display up to four other common types of 
currency. Refer to Customizing the Currency Pick List on page 8-8 
for details.

Vendor and City Enable you to record the name of the vendor (usually a company) 
associated with the expense and the city where the expense took 
place. For example, a business lunch might be at Rosie's Cafe 
(Vendor) in San Francisco (City).

Attendees Displays Attendees screen which resembles a memo in the Memo 
Pad. You can use this screen to list the people who attended the 
activity associated with the expense or to make notes, such as the 
purpose of the expense.

Tap here
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Customizing the Currency Pick List
You can select the currencies and symbols that display in the Currency pick list.

To customize the Currency pick list:

1. Tap the Currency pick list in the Receipt Details screen, then tap the Edit 
Currencies selection to open the Select Currencies screen.

2. Tap each Currency pick list to choose the country whose currency you want to 
display on that line.

3. Tap the OK button to close the Select Currencies screen and activate your 
selections.

Note: If the currency you want to use is not in the list of countries, create 
your own custom country and currency symbol. Refer to Options 
Menu on page 8-17 for details.

Tap Edit 
currencies
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Show Options

The Show Options define the sort order and other settings that relate to your expense 
items.

To open the Show Options screen:

1. Tap the Show button in the Expense List to open the Show Options screen.

2. Select any of the following options:

3. Tap the OK button to close the Show Options screen and activate your selections.

Sort By Sorts the Expense entries by date or expense 
type.

Distance Displays Mileage entries in miles or kilometers.

Show Currency Shows or hides the currency symbol in the 
expense list.

Tap Show
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Transferring Your Data to Microsoft Excel

After you enter your expenses into the Expense application on your SPT 1700 terminal, the 
Symbol Palm Terminal Desktop software allows you to view and print the data with your 
computer. 

Note: You need Microsoft Excel version 5.0 (or later) to view and print your 
Expense data using one of the provided templates. Microsoft Excel 
is not included with the SPT 1700 terminal package. The procedures 
in this section assume that you have installed the Symbol Palm 
Terminal Desktop software; refer to Symbol Palm Terminal Desktop 
Software on page 1-23 for more information.

Printing an Expense Report

Symbol Palm Terminal Desktop makes it quick and easy to print your Expense data. 

To print your expense report:

1. Perform a HotSync operation to transfer your latest Expense data to your computer 
and make it available to Symbol Palm Terminal Desktop. Refer to Chapter 9, 
Applications: HotSync® for details.

2. Click the Expense button in Symbol Palm Terminal Desktop to open Microsoft 
Excel and the Expense Report configuration screen. 

Note: If you launch Expense from the Start menu (instead of Symbol Palm 
Terminal Desktop), you must first choose your SPT 1700 terminal 
user name.
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3. Select the expense category that you want to print.

Tip: Press Ctrl+click to select multiple categories. To print the expenses associated 
with all of your Expense categories, click the All button in the Categories area.

4. Define an end date for the expense report in the End Date area.

Note: If you do not specify an end date, all expense entries for the selected 
categories display — up to the date of the last HotSync operation 
with your SPT 1700 terminal.

Click to select 
Categories
8-11

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
5. Click the Print button to display the expense report in the Print Preview screen.

6. Click the Print button in the Microsoft Excel window to print your expense report.

Viewing your Expense Report in Microsoft Excel

To view your Expense data in a Microsoft Excel spreadsheet:

1. Perform a HotSync operation to transfer your latest Expense data to your computer 
and make it available to Symbol Palm Terminal Desktop.

2. Click the Expense button in Symbol Palm Terminal Desktop to open Microsoft 
Excel and the Expense Report configuration screen.
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Note: If you start Expense from the Start menu (instead of Symbol Palm 
Terminal Desktop), first choose your SPT 1700 terminal user name.

3. Click the expense category that you want to use. 

Tip: You can press Shift+click to select multiple categories. If you want to view the 
expenses associated with all of your Expense categories, click the All button in the 
Categories area.

4. If you want to define an end date for the expense report, enter the date in the End 
Date area.

Note: If you do not specify an end date, all expense entries for the selected 
categories will display — up to the date of the last HotSync 
operation.

Click to select 
Categories
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5. Click the Create button to display a Microsoft Excel spreadsheet containing your 
Expense data.

At this point, your Expense data displays in Microsoft Excel spreadsheet form. You can 
enter information, make formatting changes and save and print the file in the normal 
manner.

Using Expense Report Templates

Symbol Palm Terminal Desktop software comes with several expense report templates. 
When you use one of these templates, you can edit your Expense data in Microsoft Excel. 
If you want to streamline or customize your expense reports, you can change these 
templates. For example, you can add your company name to a template. Refer to Appendix 
A, Using Expense Templates and Custom Expense Reports for sample templates and for 
details on changing templates.

To view your Expense data using a Microsoft Excel template:

1. Display your Expense data in a Microsoft Excel spreadsheet as described in 
Viewing your Expense Report in Microsoft Excel.

2. Click the Options button to open the Expense Report Options screen.
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3. Enter name, department and other information as necessary for your expense 
report.

4. Click the Templates menu, then click an expense template. Refer to Appendix A, 
Using Expense Templates and Custom Expense Reports for samples.

Note: If you want to create your own custom expense template and have 
it display in the Templates menu, refer to Appendix A, Using 
Expense Templates and Custom Expense Reports.

5. Click the OK button to return to the Expense Report Options screen.

Expense Menu Commands

The Expense application includes menu commands to perform common file and editing 
tasks. This section explains the menu commands that are specific to the Expense 
application.

Refer to Using Menus on page 3-20 for information about menu commands that are 
common to all of your SPT 1700 terminal applications.

Choose expense 
template

Enter name and 
other information
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Record Menu
When you select the Record menu, its commands display on screen.

Delete Item Opens an alert screen, prompting you to 
confirm that you want to delete the current 
expense item. You must tap an item before you 
can use the Delete Item command. Tap the OK 
button to delete the item from your SPT 1700 
terminal, or tap the Cancel button to close the 
alert screen and keep the item.
Note: By default your SPT 1700 terminal 
removes the item from the Expense application, 
but retains a copy of the item and transfers it to 
an archive file on your computer the next time 
you perform a HotSync operation. To remove 
the item completely, clear the Save archive 
copy on PC check box.

Purge Conserves memory on your SPT 1700 terminal 
by deleting expense categories that you no 
longer use.
The Purge command prompts you to confirm 
that you want to purge all the records from the 
selected category.
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Options Menu
When you select the Options menu, its commands display on screen.

Preferences Activates the Preferences screen, which is used to 
activate the automatic fill feature and to set the 
default currency symbol.

• Use automatic fill. Enables you to select 
an expense type by writing the first letter 
of an expense type in the Graffiti writing 
area. For example, if you write the letter 
“T,” it enters the “Taxi” expense type. 
Writing “T” and then “E” enters 
“Telephone” which is the first expense 
type beginning with the letters “TE.” 

• Default currency. Sets the default 
currency symbol for the Expense 
application. 

Custom 
Currencies

Enables you to define additional currency symbols 
for the Expense application.
Note: Use this command only if the currency 
symbol you need is not available in the Currency 
pick list of the Receipt Details screen (refer to 
“Entering Receipt Details” earlier in this chapter).

About Expense Shows version (revision) information for the 
Expense application.
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To define a custom currency symbol:

1. Choose Custom Currencies from the Options menu to open the Custom 
Currencies screen.

2. Tap one of the four Country boxes to open the Currency Properties screen.

3. Enter the name of the country and the symbol that you want to display in the 
Expense application, then tap the OK button to define your setting.

4. Tap the OK button to close the Custom Currencies screen.

Note: If you want to use your custom currency symbol as the default for all 
Expense entries, choose the symbol in the Preferences screen. To 
use your custom currency symbol only for particular expense items, 
choose the symbol in the Receipt Details screen associated with 
those items.

Tap a Country 
button
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Introduction

HotSync technology enables you to synchronize (exchange and update) data between one 
or more SPT 1700 terminals and the Symbol Palm Terminal Desktop software. To 
synchronize data, you must connect your SPT 1700 terminal and Symbol Palm Terminal 
Desktop either directly with a cable or cradle, or indirectly with a modem or network.

With HotSync technology you can:

• Synchronize the data entries on your SPT 1700 terminal with the entries on your 
host system, and vice versa.

• Manage individual or multiple SPT 1700 terminals with a centralized computer.

• Keep your data safe by automatically creating backup copies each time you 
synchronize.

The HotSync Process and the HotSync Manager

The HotSync process automatically synchronizes data between your SPT 1700 terminal 
and Symbol Palm Terminal Desktop. Changes you make on your SPT 1700 terminal or 
Symbol Palm Terminal Desktop display in both places after a HotSync operation. HotSync 
technology synchronizes only the needed portions of files, thus reducing synchronization 
time. You can synchronize your data by connecting your SPT 1700 terminal directly to your 
computer with either the single- or four-slot serial cradle or Synchronization/Charging 
Cable, or indirectly with a modem or network. 

The HotSync Manager oversees the synchronization process. It runs in the background 
and monitors a communications port on your computer for a HotSync command from an 
SPT 1700 terminal. When it “hears” a HotSync command, HotSync Manager synchronizes 
data in the Date Book, Address Book, To Do List, Memo Pad, Mail and Expense 
applications, even when the Symbol Palm Terminal Desktop is not running!

Once you complete a few simple setup steps, performing a HotSync operation is as simple 
as pressing a button. Follow the steps in the next section to complete the setup. 

Performing a HotSync Operation for the First Time

The first time you synchronize your data, you need to enter user information on both the 
SPT 1700 terminal and the Symbol Palm Terminal Desktop. Once you enter this information 
and synchronize, the HotSync Manager recognizes your SPT 1700 terminal and doesn’t 
ask for this information again. If you are a System Administrator preparing several SPT 
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1700 terminals for a group of users, refer to Conducting Wireless HotSync Operations on 
page 9-18 performing the following steps.

Important: You must perform your first HotSync operation with a local, direct connection, 
rather than using a modem.

Note: The following instructions assume that you have already installed 
Symbol Palm Terminal Desktop software on your computer. If you 
have not yet installed the software, refer to Symbol Palm Terminal 
Desktop Software on page 1-23 for details.

To perform a HotSync operation for the first time:

1. Double-click the Symbol Palm Terminal Desktop icon on the Windows desktop (or 
select Symbol Palm Terminal Desktop from the Start menu) to start the Symbol 
Palm Terminal Desktop software.

2. Click the  icon in the Windows System Tray to open the HotSync Manager 
menu. 

Tip: The Windows System Tray is usually in the lower-right corner on your 
computer display. The location may vary depending on the location of the taskbar 
and the version of Windows you are using.

3. Click Local from the HotSync Manager menu to indicate that you are using the 
cradle or the synchronization/charging cable to synchronize.

4. Turn on the SPT 1700 terminal and slide it into the cradle.
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Note: If you are using the synchronization/charging cable, connect one 
end of the cable into the serial port on the back of your computer, 
and the other end into the serial port on the bottom of the terminal.

            

Tip: The curved edge on the bottom of the SPT 1700 terminal should align 
smoothly with the cradle when it is inserted properly.

5. Press the  button on the front of the SPT 1700 cradle and open the New User 
dialog.

Note: If you are using the synchronization/charging cable, tap the  icon 
on the terminal.
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6. Enter a user name for your SPT 1700 terminal and click the OK button to open the 
HotSync Progress dialog and start the synchronization process. 

Important: Every SPT 1700 terminal should have a unique name. Never try to 
synchronize more than one SPT 1700 terminal to the same user name.

7. Wait for the Symbol Palm Terminal Desktop to display a message indicating that 
the process is complete.

Using User Profiles
If you need to configure a number of SPT 1700 terminals with specific information (such as 
a company phone list) before distributing them to their users, you can create a User Profile 
to load the data into a SPT 1700 terminal without associating that data with a user name. 
The User Profile feature is designed only for the first-time HotSync operation, before you 
assign a User ID to a particular SPT 1700 terminal. Refer to Conducting Wireless HotSync 
Operations on page 9-18 for information about loading data after you assign a User ID.

HotSync 
button
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To create a User Profile:

1. Open the Symbol Palm Terminal Desktop software.

2. Click Users from the Tools menu to open the Users dialog.

3. Click the Profiles button to open the Profiles dialog. 

4. Click the New button to open the New Profile dialog.

5. Enter a unique name for the Profile and click the OK button to return to the Profiles 
dialog. 

6. Repeat steps 3 and 4 for each Profile that you want to create, then click the OK 
button to return to the Symbol Palm Terminal Desktop. 

7. Select the Profile from the User drop-down box in the upper right hand corner of 
the screen and create the data for the Profile (e.g., company phone list, etc.).
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To use a Profile for the first-time HotSync operation:

1. Place the new SPT 1700 terminal in the cradle, and press the  button on the 
cradle to open the Users dialog.

2. Click the Profiles button to open the Profiles dialog.

3. Choose the Profile that you want to load on the SPT 1700 terminal, and click the 
OK button to open the following alert dialog:

4. Click the Yes button to transfer all the Profile data to the SPT 1700 terminal.

The next time you perform a HotSync operation, the Symbol Palm Terminal Desktop 
prompts you to assign a User name to the SPT 1700 terminal.

Using File Link
The File Link feature enables you to synchronize the Address Book and Memo Pad 
information on your SPT 1700 terminal with a separate external file such as a company 
phone list. HotSync Manager stores the data in a separate category on your Symbol Palm 
Terminal Desktop and your SPT 1700 terminal. You can configure the File Link feature to 
check for changes to the external file when you perform a HotSync operation. 

With File Link you can synchronize with data stored in any of the following formats:

• Comma delimited (*.csv)

• Tab delimited (*.tsv)

• Memo Pad archive (*.mpa)

• Address Book archive (*.aba)

• Text (*.txt)

For information on how to set up a File Link, refer to the Symbol Palm Terminal Desktop 
Software online Help.
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Conducting a Local HotSync Operation

After you complete the first HotSync operation, the HotSync process is even faster and 
easier!

To conduct a local HotSync operation:

1. Insert the SPT 1700 terminal in the cradle, or connect the synchronization/charging 
cable.

2. Start the HotSync Manager.

3. Press the  button on the front of the CRD1700-1000S cradle to start the 
HotSync process. If you are using the synchronization/charging cable or the CRD 
1700-4000S cradle, tap the  icon on the terminal’s application screen.

Synchronization begins immediately.

4. Wait for the Symbol Palm Terminal Desktop to display a message indicating that 
the process is complete.

Selecting HotSync Setup Options

You can choose when you want HotSync Manager to run, and adjust the local, modem, and 
network HotSync settings.

To set the HotSync Options:

1. Click the  icon in the Windows System Tray to open the HotSync Manager menu 
and click Setup. The Setup dialog displays with the General tab open:

.
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2. Select one of the following options:

Tip: If you’re not sure which option to use, use the Always available default setting.

3. Click the Local tab to display the settings for the connection between your 
computer and the SPT 1700 cradle or synchronization cable, and adjust the 
options as needed.

Always available Adds HotSync Manager to the Startup folder and constantly 
monitors the communication port for SPT 1700 terminal 
synchronization requests. With this option, the HotSync 
Manager conducts synchronizations even when the Symbol 
Palm Terminal Desktop is not running.

Available only 
when the Symbol 
Palm Terminal 
Desktop is 
running

Starts HotSync Manager and monitors requests automatically 
when you open the Symbol Palm Terminal Desktop software.

Manual Starts the HotSync Manager and monitors requests only when 
you select HotSync Manager from the Start menu.

Serial Port Identifies the port Symbol Palm Terminal Desktop will use to 
communicate with the cradle or the synchronization/charging 
cable. This selection should match the port number where you 
connected the cradle or synchronization/charging cable.
Note: Your SPT 1700 terminal cannot share this port with an 
internal modem or other device. If you have trouble determining the 
correct serial port, refer to Troubleshooting on page 20-9.
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4. Click the Modem tab to display the Modem settings and adjust the options as 
needed. 

5. Click the Network tab to display Network settings and adjust the options as needed.

Speed Determines the speed at which data is transferred between your 
SPT 1700 terminal and Symbol Palm Terminal Desktop. We 
suggest you try the As Fast As Possible rate first, and adjust 
downward if you experience problems. This setting allows the 
Symbol Palm Terminal Desktop and SPT 1700 terminal to find and 
use the fastest speed.

Serial Port Identifies the port where the modem is located. If you are unsure of 
the port assignment, review the Modem Properties in the Windows 
Control Panel.

Speed Determines the speed at which data is transferred. We suggest you 
try the As Fast As Possible rate first, and adjust downward if you 
experience problems. This setting allows the Symbol Palm 
Terminal Desktop and SPT 1700 terminal to find and use the 
fastest speed.

Modem Identifies the modem type or manufacturer. Refer to your modem 
manual or face plate for its type or settings. If you’re not sure of 
your modem type or your modem doesn’t match any that appear in 
the list, choose Hayes Basic.

Setup String Identifies the setup string for your particular modem. Not all 
modems require a setup string. Refer to your modem manual and 
enter the setup string if recommended by the manufacturer.
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Note: You must have Network HotSync software installed to use this 
feature. Refer to Configuring NetSync Options on page 9-22.

6. Click TCP/IP Settings to obtain the Primary PC Name, Address, and Subnet Mask 
(optional) for the selected user.

7. Click OK to close the Setup dialog.

Customizing HotSync Application Settings

For each application you can define a set of options that determines how records are 
handled during synchronization. These options are called a “conduit.” By default, the 
Symbol Palm Terminal Desktop synchronizes all files between the SPT 1700 terminal and 
the Symbol Palm Terminal Desktop. In general, you should leave the settings to 
synchronize all files. The only reason you might want to change these settings is to 
overwrite data on either your SPT 1700 terminal or Symbol Palm Terminal Desktop, or to 
avoid synchronizing a particular type of file because you don’t use it.

In addition to the standard application conduits, the Symbol Palm Terminal Desktop 
includes System and Install conduits. The System conduit backs up the system information 
stored in your SPT 1700 terminal, including Graffiti software ShortCuts. The Install conduit 
is used to install Palm-compatible applications. 

To customize HotSync application settings:

1. Click the  icon in the Windows System Tray to open the HotSync Manager 
menu.
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Tip: You can also click the HotSync command on the Symbol Palm Terminal 
Desktop menu bar to open the HotSync Manager menu.

2. Click Custom from the HotSync menu to open the Custom dialog.

3. Select the appropriate user name from the drop-down list.

4. Select an application in the Conduit list to choose the conduit you want to change.

5. Click the Change button to open the Change HotSync Action dialog.

6. Determine the action you want to take.

Note: Changing the HotSync setting from the default affects only the next 
HotSync operation. Thereafter, the HotSync Actions revert to their 
default settings. To use a new setting on an ongoing basis, check the 
Set As Default box. Clicking the Default button in the Custom dialog 
will revert to the new default settings.

Check here to 
make new settings 
the default

Click to skip data
transfer for an

application
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7. Repeat steps 2 through 6 to change conduit settings for other applications or for a 
different user name.

8. Click the OK button to close the Change HotSync Action dialog and activate your 
settings.

Conducting a HotSync Operation via Modem

You can use a modem to synchronize your SPT 1700 terminal when you are away from 
your computer.

Note: You must first conduct an initial local HotSync operation using any 
of the SPT 1700 cradles before you perform a modem HotSync 
operation. Refer to Conducting a Local HotSync Operation on page 
9-9 for details.

To perform a HotSync operation via modem you need:

• A modem connected to your computer. 

• A modem connected to your SPT 1700 terminal with a special modem cable. (The 
cradle is not used for a modem HotSync operation.) 

• The Symbol Palm Terminal Desktop software configured for use with a modem as 
described in Selecting HotSync Setup Options on page 9-9. 

Preparing Your Computer for a Modem HotSync Operation
There are several steps you must perform to prepare your computer for a modem HotSync 
operation. Be sure to perform these steps before you leave your office so that your 
computer is ready to receive a call from your SPT 1700 terminal. 
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To prepare your computer for a modem HotSync operation: 

1. Confirm that the computer modem is connected and turned on, and that no 
communications applications, such as fax or telephony software, are running on a 
COM port.

Note: Make sure the computer is disconnected from all online services, 
such as America Online (AOL) and CompuServe. This helps to 
avoid conflicts with the COM port.

2. Start HotSync Manager and select Modem from the HotSync Manager menu. 
Refer to Selecting HotSync Setup Options on page 9-9 for details about this 
screen.

Preparing Your SPT 1700 Terminal for a Modem HotSync 
Operation
To prepare your SPT 1700 terminal for a modem HotSync operation:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open the HotSync screen.

3. Tap Modem and select your modem from the pick list.

Note: This will vary, dependent upon the SPT terminal you are using: SPT 
1733 terminals use Merlin, SPT 1734 terminals use GSM modem, 
and SPT 174x terminals use Spectrum24.

4. Tap Enter Phone # to open the Phone Setup screen.
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Note: If you have Network HotSync software installed on your SPT 1700 
terminal, the Remote Setup screen displays instead. Refer to 
Network Preferences and Symbol Palm Terminal Desktop TCP/IP 
Software on page 14-13 for more information.

5. Enter the telephone number to access the modem connected to your computer.

6. If needed, enter a dial prefix (such as “9”) to access an outside line, and then tap 
the Dial Prefix check box.

Tip: You can enter a comma in the field to introduce a “pause” in the dialing 
sequence. 

7. If the phone line you’re using for the SPT 1700 terminal has “Call Waiting,” select 
the Disable call waiting check box to avoid an interruption during the modem 
HotSync operation. 

8. If you want to use a calling card to place the call, select the check box and enter 
the calling card number. 

9. Tap OK to return to the HotSync screen.

10. Tap the  icon to open the HotSync menus.

11. Tap Modem Sync Preferences from the Options menu to display the Modem Sync 
Preferences screen.

12. Select Direct to Modem.

13. Click OK.

Selecting the Conduits for a Modem HotSync Operation
The Conduit Setup screen on your SPT 1700 terminal enables you to define which files 
and/or applications synchronize during a modem HotSync operation. Use these settings to 
minimize the time required to synchronize data with a modem. 

To change the Conduit Setup for a modem HotSync operation:

1. Tap the  icon to display the HotSync screen.

2. Tap the  icon to open the HotSync menus.

3. Tap Conduit Setup from the Options menu to open the Conduit Setup screen.
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4. Tap the check boxes to de-select the files and/or applications that you do not want 
to synchronize during a modem HotSync operation. The default setting is to 
synchronize all files. 

Note: Applications that do not have a database (such as games) do not 
synchronize — even if the item is selected in the Conduit Setup 
screen. 

5. Tap the OK button to close the Conduit Setup screen and activate your settings for 
the next modem HotSync operation.

Performing a HotSync Operation via Modem
To perform a Modem HotSync operation:

Note: If you are not using a PalmPilot modem, you need a special modem 
cable and an external modem. Connect one end of the special 
modem cable to the serial connector on the SPT 1700 terminal and 
the other end to the external modem. Do not attempt to use other 
kinds of cables, even if they appear to be similar.

1. Tap the  icon to open the HotSync application.

2. Tap the large  icon to dial the Symbol Palm Terminal Desktop modem and 
synchronize the applications selected under Conduit Setup.

3. Wait for the HotSync operation to complete. 

If you have any problems conducting a HotSync operation, refer to Troubleshooting 
on page 20-9.
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Conducting Wireless HotSync Operations

Using HotSync you can take advantage of the LAN and WAN connectivity available in 
business environments. You can dial in to a network or use a cradle that is connected to 
any computer on your LAN or WAN (provided that the computer connected to the cradle 
also has HotSync installed, your computer is on, and the HotSync Manager is running).

Setting Up for a Wireless HotSync 

The SPT 1733, 1734, and 174x terminals allow you to perform a HotSync without using a 
cradle over a terminal specific wireless LAN (174x) or WAN (173x). This section describes 
the setup necessary for a wireless HotSync to occur.

Before a wireless HotSync can be performed, each terminal must be properly configured 
for use. Refer to Chapter 2, Network Setup for specific instructions for each terminal.

Once the terminal is properly configured for use, it must be set up to perform a wireless 
HotSync over the LAN or WAN.

To properly configure your terminal:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open the HotSync application.

3. Tap the  icon to display the HotSync Options menu and select Modem Sync 
Prefs. 

Select Network and tap OK.

4. Tap LANSync Prefs from the Options menu and select Local HotSync.

5. Tap Primary PC Setup on the Options menu.

Note: The Primary PC Setup is extremely important! It tells the terminal 
how to locate the machine which it will synchronize with on the 
network.
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The Primary PC Setup screen displays:

The information required for this screen is located by selecting the TCP/IP button 
on the Network tab of the HotSync Manager on the machine you are hotsyncing to. 
Copy down the Primary PC Name, Primary PC address, and the Subnet mask, and 
enter that information manually on the above screen. Refer to Selecting HotSync 
Setup Options on page 9-9 for details on how to access the Network tab.

Note: If the Subnet Mask box on your PC is empty, you do not need to 
enter anything in that section on your terminal.

6. Tap OK.

7. Tap Connection Setup on the Option menu and select:

a. Spectrum24 for a SPT 174x terminal

b. Merlin for a SPT 1733 (CDPD) terminal — or —

c. GSM Modem for a SPT 1734 terminal

Performing a Spectrum24 HotSync

Note: This function is available on SPT 174x terminals only.

To perform a HotSync via the Spectrum24 wireless LAN:

1. Ensure the terminal has been properly configured for use. Refer to Setting Up for 
a Wireless HotSync on page 9-18 for details.

2. Select the HotSync application from the main application screen.

3. Tap Modem, and tap Select Service to display the Network Preference Screen.
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Verify that Spectrum24 displays in the Service pick list and that phone setup 
information is accurate and tap Done.

4. Tap the HotSync button to initiate the HotSync.

Performing a CDPD HotSync

Note: This function is available on SPT 1733 terminals only.

To perform a HotSync via the CDPD wireless WAN:

1. Ensure the terminal has been properly configured for use. Refer to Setting Up for 
a Wireless HotSync on page 9-18 for details.

2. Tap the  icon to open the HotSync application.

3. Tap Modem, and tap Select Service to display the Network Preference screen.

4. Verify that Merlin displays in the Service pick list and that phone setup information 
is accurate and tap Done. 

5. Tap the HotSync button to initiate the HotSync.
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Performing a GSM HotSync

Note: This function is available on SPT 1734 terminals only.

Before performing a GSM HotSync, you must first set up the modem registration 
information. To do so:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open the GSM Demo application. The main screen displays:

3. Select the Leave modem registered checkbox.

Note: This option can only be set if the modem has been registered.

4. Exit GSM Demo.

Ensure the terminal has been properly configured for use. Refer to Setting Up for a 
Wireless HotSync on page 9-18 for details.

5. Tap the  icon to open the Applications Launcher.

6. Tap the  icon to open the HotSync application.

7. Tap Modem, and tap Select Service to display the Network Preference Screen.

8. Verify that the GSM modem displays in the Service pick list and that phone setup 
information is accurate and tap Done.

9. Tap the HotSync button to initiate the HotSync.

When the HotSync is complete and if a registered modem is no longer needed, 
open GsmDemo and de-register the modem (Refer to Using GsmDemo on page 
18-3 for details). This action will save battery life.
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Setting Up the Ethernet Cradle for HotSync

The CRD1700-4000E appears to SPT 1700 terminals inserted into the cradle as a dial-up 
PPP service. Therefore, just as you would set up a Palm III terminal to connect to an 
Internet Service Provider (ISP) like Compuserve or Earthlink, the SPT 1700 terminals must 
be configured for use with the cradle. This section describes the steps necessary to 
configure both the SPT 1700 terminal and the CRD1700-4000E.

Installing NetSync
An SPT 1700 terminal must have NetSync installed and configured for it to communicate 
with the CRD1700-4000E. Additionally, NetSync extensions to the HotSync Manager must 
be installed on the host system which the SPT 1700 terminal is to synchronize with. The 
Network HotSync software is a free add-on for SPT 1700 terminals and is available at http:/
/www.palm.com/custsupp/downloads/netsync.html.

Follow the instructions to install the network HotSync software on your host PC, then 
perform a HotSync to install the program on your SPT 1700 terminal.

Configuring NetSync Options
Once NetSync is installed on your SPT 1700 terminal, it must be configured for use with the 
CRD1700-4000E. From the HotSync panel on your SPT 1700, select each of the option 
panels available from the “Options” menu (accessed by tapping the Menu icon) and 
configure them as follows:

1. To configure Modem Sync Preferences:

2. Tap the  icon to open the HotSync menus.

3. Tap Modem Sync Preferences from the Options menu to display the Modem Sync 
Preferences screen.

4. Select Network.

5. Tap OK.

6. To configure the Local Sync Preferences:

a. Tap the  icon to open the HotSync menus.

b. Tap LANSync Preferences from the Options menu to display the LANSync 
Preferences screen.

c. Select Local HotSync (the CRD1700-4000E doesn’t use LANSync 
functionality).

d. Tap OK.
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7. To configure the Primary PC Setup, refer to the Setting Up for a Wireless HotSync 
on page 9-18 for details:

Note: Primary PC Setup is extremely important! It tells the terminal how to 
locate the machine which it will synchronize with on the network.

8. Tap the  icon to open the HotSync menus and select Conduit Setup.

a. Check any items that you want synchronized and uncheck any items that you 
don’t want synchronized.

b. Tap OK.

9. Tap the  icon to open the HotSync menus and select Connection Setup.

a. For optimal performance, choose a communication rate of 57600 bps and a 
Standard modem.

b. Tap Done.

Creating a CRD1700-4000E Modem Sync Service
The SPT 1700 terminal communicates with the CRD1700-4000E via a Modem Sync. The 
Modem Sync offers many options which must be configured for use with the CRD1700-
4000E.

Create a separate CRD1700-4000E network configuration and select it as your default 
Modem Sync service. Use either Graffiti or the keyboard feature (click in the lower left-hand 
corner of the scratch pad on the abc to access the keyboard) to enter the following 
information:

1. Tap the  icon to open the HotSync application.

2. Choose the Select Service box under the Modem Sync icon to create a new 
CRD1700-4000E service.

3. To select the Earthlink service, Click Menu, Duplicate.

4. Change the service name to CRD1700-4000E. Leave the user name and 
password blank. You may enter any phone number you want, except ‘00’, or you 
may leave it blank. The SPT 1700 terminal will not be able to HotSync if you use 
‘00’ as a phone number. 
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Configuring the Remote Host PC for Use with the Ethernet 
Cradle
The remote PC you wish to HotSync the SPT 1700 to must be set up for Network HotSync 
and configured to run from the network.

1. Make sure HotSync Manager is installed and running.

2. From the HotSync Manager, make sure Network is checked. If you don’t want 
HotSync Manager to use a serial port, make sure Local is unchecked.

Note: The PC must be configured for proper TCP/IP network operation. 

The Ethernet HotSync Process
Once the CRD1700-4000E is properly connected, data communication between an SPT 
1700 terminal and the host computer can take place. When a terminal is inserted in the 
cradle, the cradle detects its presence and attempts to initiate the HotSync process on the 
terminal. All local slots in the cradle operate simultaneously; the HotSync procedure starts 
immediately when any terminal is inserted into a local slot.

As stated earlier, if multiple slots are to be HotSync’d simultaneously, each must 
communicate with a different host PC. If the application requires simultaneous connection 
to a single host database, additional software, available from Symbol, is required.

Terminals inserted into daisy-chained cradles are HotSync’d in a round-robin fashion 
simultaneously with any HotSyncs from local slots. Daisy-chained cradles share a logical 
“fifth slot” on the CRD1700-4000E, which, while it shares equal priority with the local slots, 
allows only one HotSync at a time.

Performing HotSync with the Ethernet Cradle
To initiate communication between the terminal and the host, gently insert the SPT 1700 
terminal into a local cradle slot, or a slot on an inter-connected serial cradle. Do not force. 
When properly inserted, the slot’s LED turns red, then changes to flashing green, indicating 
that the host and the terminal are communicating. Removing the terminal from the cradle 
while the LED is flashing green will result in a disruption of communication data may be lost.

If the terminal is inserted into an inter-connected serial cradle slot while another terminal on 
the serial cradle chain is communicating with a host, the terminal waits (its LED remains 
red) until the first terminal finishes communicating. After the communication session 
completes, the slot’s LED turns solid green and remains green until the terminal is removed 
from the slot. To remove the terminal, pull it straight up from the slot.
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Introduction

This chapter explains how to configure and use the ScoutSync Client on an SPT 1700 
terminal. By reading this chapter, you will learn how to perform a synchronization and view 
your ScoutSync Client synchronization log. 

Note: Before performing the procedures found in this chapter, your system 
administrator should install, set up, and run ScoutSync on a 
computer. Your system administrator must also grant you access to 
a Scout Server.

Overview of the ScoutSync Client
The ScoutSync Client is an application that enables you to connect your SPT 1700 terminal 
to a Scout Server. A Scout Server resides on a Windows NT server or workstation that your 
system administrator manages and is responsible for transferring data between the 
ScoutSync Client and your company’s back-end applications and databases. Using Scout’s 
powerful technology, you can seamlessly transfer data using an SPT 1700 terminal from 
virtually anywhere to your company’s data stores.

Using the ScoutSync Client on your SPT 1700 terminal, you can:

• Run ScoutSync Conduits

A ScoutSync Conduit is the central processing component that implements the 
synchronization logic during a synchronization session. Your system administrator 
installs conduits on your device.

• Initiate a synchronization session

• View your SPT 1700 terminal’s synchronization log.
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Configuring the ScoutSync Client 

The Scout Preferences settings enable you to connect a mobile device to a ScoutSync 
Server. When configuring the preferences, you must specify the Scout host/server name, 
the command port used for ScoutSync Client/Server communications, and the user's 
profile/ID.

Note: You must configure the settings before performing a 
synchronization.

To configure the ScoutSync Client preferences of an SPT 1700 terminal:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open ScoutSync. The main ScoutSync screen displays:

3. Tap the Preferences button. The following screen displays:

4. Enter the Scout Server Name and the Port Number. The default connection port is 
8025 and should not be changed unless instructed by your system administrator.

5. Enter the Profile.
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6. Tap the word “Unassigned” in the Password field to display the Password box. If 
applicable, enter a password and tap the OK button. If not, tap Cancel.

Note: “Assigned” replaces “Unassigned” after you enter a password.

7. Tap the More button. The Advanced Preferences screen displays:

• To synchronize on application launch, tap the Start sync on app launch check 
box.

• To close the network connection after a synchronization, tap the Close 
connection after sync check box.

• To be notified about errors, tap the Notify about errors during sync check box.

• To indicate that you are using a Novatel Minstrel modem, tap the Check modem 
status before sync check box.

8. Tap OK twice to close the Scout Preferences screen.

Selecting Conduits for Synchronization
Developers have the ability can create custom conduits for synchronizing data. Before 
performing a synchronization, you can specify the conduits you want activated. Each 
conduit is associated with an application and determines how data is handled during a 
synchronization session. When a conduit is selected for synchronization, it knows what 
actions to perform and how to process the files and databases.

To select conduits for synchronizing an SPT 1700 terminal:

1. Tap the  icon to open ScoutSync. The main ScoutSync screen displays.

2. Tap the  icon to open the Conduit List. 

3. Tap the checkboxes of the conduits that you want to synchronize.

4. Tap Done.
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Performing a Synchronization
To perform a synchronization:

1. Tap the  icon from the Applications Launcher. The following screen displays:

2. Tap the  icon.

The synchronization process begins.

Automatically Synchronizing Using a Cradle
You can configure a mobile device to automatically start and connect to a server when 
placed in the cradle. Once the device is configured, when placed in a cradle it will 
automatically perform a synchronization until you disable the feature.

To automatically synchronize using a cradle with an SPT 1700 terminal:

1. Open the Applications Launcher.

2. Tap the  icon. 

3. Tap the pick list in the upper-right corner and select Buttons. The following screen 
displays:
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4. Tap the HotSync button to open HotSync. The following screen displays:

5. Select ScoutSync from the Cradle pick list.

6. Return to the Applications Launcher and tap the  icon. The main ScoutSync 
screen is displayed.

7. Tap Preferences, then More. The Advanced Preferences screen displays:

8. Select the Start sync on app launch check box and tap OK.

9. Place the SPT 1700 terminal in the cradle.

Viewing the Synchronization Log
The synchronization log of a mobile device displays a record of the date and time a user 
logged on and off a server. It also displays the list of files and databases installed on the 
mobile device and other informational messages.

To view the Synchronization Log:

1. Tap the  icon. The main ScoutSync screen is displayed.

2. Tap the View Log button.

The ScoutSync Log is displayed.

Note: Only the most recent synchronization session log displays.
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ScoutSync Client Menu Commands

ScoutSync Client includes menu commands to make it fast and easy to perform common 
tasks. This section explains the menu commands specific to ScoutSync.

Refer to Using Menus on page 3-20 for information about menu commands common to 
most of your SPT 1700 terminal applications.

Options Menu
When you select the Options menu, its commands display on the screen.

Conduit List Allows you to choose which conduits run during ScoutSync.

ScoutSync Automatically attempt a ScoutSync connection.

Preferences Opens the Scout Preferences screen, where you can enter the Scout 
Server name, port number, profile, and password.

Network 
Settings

Opens the Preferences screen, where you set up your service and 
connection preferences.

About Provides version information.
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Introduction

The AvantGo Client is used to view channels, which are sets of related Web pages. Mobile 
Link helps the SPT 173x terminal communicate with Web-based information on a network 
when it is synchronized. Your system administrator defines and provides most channels for 
you, although you may define your own personal channels as well. 

Note: AvantGo Client and Mobile Link are available on SPT 173x terminals 
only.

AvantGo Client 

To open AvantGo Client:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon. The main screen displays:

Navigating in AvantGo Client
Like other Web browsers, AvantGo Client navigation tools allow you to go back, forward, 
Open a Page, Reload a Page, and go Home. 
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Icon Descriptions

Using the Channel Manager 

The Channel Manager is used to view a channel's size or clear its contents.

To open the Channel Manager:

1. Tap the  icon to open the AvantGo Client menus and select Channels, Channel 
Manager. The following screen displays:

A list of channels to which you are subscribed are displayed, including each 
channel's size.

2. Tap a channel's title to view its pages. 

Open Page Icon Enables online browsing. Tap to navigate to a URL you want to view.

Reload Page Icon Tap to clear form data, reload the contents of your subscribed 
channels, or reload a specific page in a channel.

Backward and 
Forward

Tap for backward and forward navigation.

Home Tap to navigate to your home page.
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3. Mark the check box next to the channel you want to clear. 

4. Tap the Select All button to clear all channels. 

5. Tap the Clear button to remove selected channels from the device.

The channel size for each changes to 0K. The channel contents will be restored 
the next time you synchronize your data.

Note: If you wish to unsubscribe from a group channel, please contact your 
administrator.

Updating Channel Pages
To update your channel's pages, all you need to do is sync your device:

1. Place the SPT 173x terminal in its cradle.

Make certain the cradle is connected by its serial cable to your desktop. 

2. Open Hotsync on your desktop via the Windows system tray. 

3. Click the  icon on the SPT 173x terminal (or on the device cradle) to activate 
HotSync. The HotSync in Progress screen displays:

HotSync automatically connects your device to the AvantGo Server and updates 
your channels. 
11-5

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
Using the Forms Manager 

To view the Forms Manager:

1. Tap the  icon to open the AvantGo Client menus. Select Forms Manager from 
the Channel menu. 

AvantGo Client displays a list of forms that you've submitted or are going to submit 
during the next sync. 

2. If the form was submitted successfully, the word success displays to the right of the 
form's name. 

3. Tap the Success button to view the form. 

AvantGo Client displays the result page sent by the channel the next time you 
synchronize your data.

Editing Forms in the Forms Manager Cue 
1. Tap the  icon to open the AvantGo Client menus. Select the Forms Manager 

from the Channel menu.The Forms Manager displays.

2. In the third column, tap the linked title of the form. The form displays.

3. Edit the form then tap the Submit button.

AvantGo Client displays a message indicating the form will be submitted on the 
next synchronization.

4. Tap OK.
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Deleting Forms in the Forms Manager 
1. Tap the  icon to open the AvantGo Client menus. Select Forms Manager from 

the Channel menu. The Forms Manager displays.

2. Tap Delete All or tap the checkbox to the left of the form(s) listed in the Forms 
Manager that you want to delete.

3. Tap Delete.

4. Tap OK to confirm the deletion.

Using HTML Forms 
You can use AvantGo Client to fill out and submit HTML forms, just like you do in Web 
browsers on a desktop.

AvantGo Client handles forms differently in online and offline modes. When you are in 
online mode, tap the Submit button and AvantGo sends the request to the Web site which 
sends back a response, and displays the results on your SPT 173x terminal. 

When in offline mode, AvantGo Client can't send the request to the Web site until you sync 
your device with your desktop computer. Therefore, you are not able to view the current 
stock prices until after the form is submitted and the results returned through the 
synchronization process. In this case, the form submittal is saved on the SPT 173x in the 
Forms Manager until you sync. At that time, it is submitted to the Web site, which sends 
back a response. Depending on the page, this response can be viewed in the channel 
where it was submitted or in the Forms Manager.

Submitting the Form 
To submit HTML forms in AvantGo Client: 

1. Fill out the form and tap the Submit button. 

AvantGo Client displays a message saying the form will be submitted on the next 
synchronization. 

2. Tap OK. 

The form has been added to the Forms Manager cue. Tap manage forms to view 
the status of the form you submitted on the Forms Manager page. 

Sending the Form Using HotSync
You can send the form to the Web site by performing a HotSync operation with your desktop 
computer. AvantGo Client uploads the form to your desktop computer, which connects to 
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the Internet and forwards the form to the appropriate Web site. The Web site responds, and 
that response is downloaded to your SPT 173x terminal. Refer to Chapter 9, Applications: 
HotSync® for details.

Sending the Form Using a Modem 
AvantGo Client uses the modem settings you've provided to connect to AvantGo Server 
and send your request to the appropriate Web site. This way, you can get an immediate 
response, and you don't have to sync all of the other data on your device. Refer to the Using 
AvantGo Client With a Modem section for details.

Displaying the Response 
The channel can respond to a form submission in one of two ways: 

• It can alter the channel pages that you initially downloaded. 

• It can send down a separate response page. 

Using AvantGo Client With a Modem 

You can use your SPT 173x terminal to connect to the Internet or your company's intranet 
directly from the device.

Note: Before you can use AvantGo Client with a modem, make sure the 
modem is set up properly and that you have network access to your 
Internet Service Provider. Refer to Chapter 14, Applications: 
Preferences to set up your modem and network access.

Browsing Online 
You can use your SPT 173x terminal to browse online when you have an active modem 
connection, an active wireless connection, or are continuously syncing cradle connection. 

To browse the Internet using AvantGo Client: 

1. Tap the  icon to open the AvantGo Client menus. Select Connect from the 
Channels menu. 

A service connection attempt is made. A flashing vertical bar in the upper right 
corner indicates you are online. 
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To go to a specific URL:

1. Choose an existing connection or configure a new one and wait for the device to 
connect. 

2. Tap the Open Page icon. 

3. Enter the URL.

4. Tap OK. 

Synchronizing With a Modem
If you use a modem with your SPT 173x terminal, you can synchronize your AvantGo 
channels without going through HotSync. When you do this, your terminal connects directly 
to the AvantGo server through a modem and downloads all channel information just like it 
does when you sync using a desktop computer. 

To synchronize to the AvantGo server on your SPT 173x terminal, tap the  icon and 
select Modem Sync from the Channels menu. AvantGo Client automatically accesses the 
modem and connects to AvantGo Server. 

Using Connect
You can select the Connect option on the Channels menu to establish a connection with 
your online service. To connect using a modem connection, tap the  icon and select 
Connect from the Channels menu. The service connection is established. 

Using Disconnect on Your SPT 173x Terminal
To disconnect your modem, tap the  icon and select Disconnect from the Channels 
menu. The service connection is closed. 
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AvantGo Client Menu Commands

AvantGo Client includes menu commands to make it fast and easy to perform tasks. This 
section explains the menu commands specific to AvantGo.

Refer to Using Menus on page 3-20 for information about menu commands common to all 
of your SPT 1700 terminal applications.

Note: Refer to www.avantgo.com for additional information about these 
commands.

Channels Menu
When you select the Channels menu, its commands display on the screen.

Open Page Opens a page.

Reload Page Reloads/refreshes a page.

Forms Manager Opens the Forms Manager. Contains a list of forms you’ve created.

Channel 
Manager

Opens the Channel Manager. Displays a list of channels and sizes.

Online Cache 
Manager

Opens the Online Cache Manager. Contains a list of online pages in 
cache.

Modem Sync Initiates synchronization of the device to your online service. Refer to 
Synchronizing With a Modem on page 11-9 for details.

Connect Connects to your online service using a modem connection.

Disconnect Disconnects from your online service.
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Go Menu
When you select the Go menu, its commands display on the screen.

Options Menu
When you select the Options menu, its commands display on the screen.

Home Brings you directly to your home page.

Back Returns to the previous page.

Forward Advances to the next page.

Choose Server Displays a list of servers available to this terminal.

Preferences Displays a list of preferences you can choose, including show tables, 
show images, auto-connect, and enable scanner.

Server 
Preferences

Opens the main Mobile Link screen where you specify the name 
address, port, user name and password for a particular server.

Font 
Preferences

Displays Variable and Fixed font preferences. System Variable is the 
font used for most text.

About AvantGo Displays copyright and version information for AvantGo.
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Mobile Link 

Mobile Link is software that helps your SPT 173x terminal communicate with Web-based 
information on a network when you synchronize. You rarely need to use Mobile Link 
directly. It is installed as part of AvantGo, and is configured at that time. The only time you 
may need to use Mobile Link is to set up the connection to a proxy server or to perform 
some server configuration maintenance.

Typically, you synchronize the contents of your SPT 173x terminal with similar contents on 
your desktop computer. For example, the SPT 173x has a calendar application that you 
synchronize with a calendar application on your desktop to make sure they both have the 
same contents. To do this, you connect the SPT 173x terminal to your desktop computer, 
and HotSync operation transfers data between the two. 

Mobile Link provides a common way for such remote servers to communicate with your 
desktop computer and SPT 173x terminal. Once it is installed, your terminal can 
synchronize with any server that understands the Mobile Link protocol. To sync through 
your desktop computer, all you have to do is perform the HotSync operation as you 
normally would. Mobile Link takes care of accessing the remote server and passing data 
back and forth between the server and the SPT 173x.

Note: Refer to www.avantgo.com for additional documentation about 
configuring and using Mobile Link desktop software.

To access Mobile Link, point to Programs, AvantGo and click Mobile Link.
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Servers Tab 

Before configuring any element of Mobile Link, make certain you have chosen the profile 
associated with your SPT 173x terminal. Profiles are created when you first sync a device 
on a desktop. Refer to Using User Profiles on page 9-6 for details.

The Servers tab is used to add, remove, or modify the server settings for each device 
installed on your computer.

Add Opens a blank version of the Edit Server 
Profile panel.

Remove Removes the selected server from the Server 
settings for the currently selected device list 
box.

Properties Opens the Edit Server Profile panel for the 
selected server.

Content  Opens a Web browser where you can view 
the interface for the selected server.

Help Opens Mobile Link Online Help.
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The Device profiles drop down lists all of the profiles associated with the desktop computer.

Edit Server Profile Panel
You can use the Edit Server Profile panel to change and/or edit your server address, and 
change your account information (user name or password), change your connection 
options, and view details about the selected server.

1. Click the Add button or Properties button and the Edit Server Profile panel displays:

Server Address
Enter the name and port of your host server.

Test Tests the connection between the named 
server and your desktop.
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Your Account
Enter the user name and the password for the server. This information allows you to 
authenticate a connection with a server in a single sync.

Connection Options
Set and change sync connection options. This includes enabling/disabling a server to 
connect during a sync, refreshing or not refreshing content at the next sync, or enabling a 
secure connection to the named server.

Server Information
Displays the details of address, port, and server name for the server named in the 
Hostname field. It also provides the location on the Internet or intranet where you can 
configure your account settings. 

Set Password Opens the Change Password dialog where 
you can enter your password as it appears on 
the server you entered in the Address field.

Connect to this server 
during device 
synchronizations 

Enables or disables the connection between 
the server and your device during the next 
sync.

Refresh all content at next 
sync 

Overrides the refresh settings for the server 
syncing with your device. All of the content 
(regardless of the individual settings on 
channels and applications) will refresh.

Connect to this server 
using a secure protocol 

Mobile Link automatically detects whether the 
server is a secure or unsecure server. If the 
server is secure, this checkbox is 
automatically enabled.
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Connection Tab 

The Connection tab is used to autodetect and change your connection settings, and view 
your computer's proxy settings:

Change Changes the settings for your HTTP, SOCKS 
or Secure server. 

Autodetect Now Automatically detects a device’s network 
connection.

Show Details Becomes available when an autodetect 
attempt is made and opens a log of the 
connection. You can copy this log into another 
application by clicking the Copy log to 
clipboard button and pasting the text into the 
application of your choice.

Tap here to
change proxy

server settings
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Advanced Connection Settings
To set up proxy servers:

1. Tap the Change button. The Advanced Connection Settings screen displays:

2. Enter the unique address of your server into the Address field of the Proxy Servers 
box. The address entry should be the same as the address for the server used by 
your organization.

3. Enter a port number in the Port field. 

The Use HTTP authentication checkbox is enabled. HTTP authentication enables 
user name and password verification.When this checkbox is active, the Password 
field is enabled. 

4. Enter a password.

5. To enable a connection when using a SOCKS server, enter its address and port. 

6. Enter the address for the server that provides secure SSL connections. 

7. Enter settings for exceptions to those set in the previous section. 
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Using the Mobile Link Application on Your 
SPT 173x Terminal

A component of Mobile Link software is installed on your SPT 173x terminal when you 
install AvantGo. This software allows you to synchronize the SPT 173x terminal with a 
remote server either by going through a sync operation or by connecting directly to the 
server through a modem attached to the terminal. You must not delete Mobile Link or its 
related files from your terminal.

As with its desktop software, Mobile Link can usually complete its job with no user 
intervention. However, you may need to perform some maintenance tasks.

To access the available servers:

1. Tap the  icon on the SPT 173x terminal to open the Applications Launcher.

2. Tap the  icon to open Mobile Link.

Note: You can also access Mobile Link via the Server Preferences setting 
on the AvantGo Options menu.

3. Tap the Server drop down list to display available servers.

Enabling a Secure Connection on Your SPT 173x Terminal
When you enable secure connections, Mobile Link uses the HTTPS protocol to connect to 
a server during a HotSync. 

The following are pre-requisites for connecting using secure protocols: 

• Your system administrator has installed the security module add-on to the AvantGo 
Server and has enabled the use of secure protocols. 

• You have entered a secure server as the hostname. 

• You have synchronized your device at least once with the secure server. 

To enable a secure connection: 

1. Tap the  icon to open Mobile Link.

2. Choose the server from the pop-up list. 

3. Check the Connect securely box. 

4. Tap OK to return to AvantGo Client. 
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Disabling a Server on Your SPT 173x Terminal
You can disable a server from your SPT 173x terminal directly. 

To disable a server on your terminal:

1. Tap the  icon to open Mobile Link.

2. Choose the server that you want to disable from the pop-up list. 

3. Deselect the Enabled box. 

Modem Syncing With a Server Using Your SPT 173x Terminal
To synchronize with Mobile Link servers on your SPT 173x terminal: 

1. Tap the  icon to open Mobile Link.

2. Tap the Modem Sync button. 

Setting up a New Server on Your SPT 173x Terminal
There are two ways that you can set up a new server on your terminal: from within AvantGo 
Client, and from within Mobile Link. The following sections provide instructions for setting 
up a new server using both of these methods. 

Note: Most applications that use Mobile Link automatically add necessary 
server configurations for you. You rarely have to add a server 
configuration manually.

From Mobile Link:

1. Tap the  icon and tap  icon. 

2. Tap the  icon and select New Server from the Server menu. 

Enter the Server Name, Address, Port, User Name, and Password.

From AvantGo:

1. Tap the  icon and tap the AvantGo  icon. 

2. Tap the  icon and select Server Preferences from the Options menu. 

Enter the Server Name, Address, Port, User Name, and Password.
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Removing a Server on Your SPT 173x Terminal
To remove a server on your terminal: 

1. Tap the  icon to open Mobile Link.

2. Select the server you wish to delete. 

3. Tap the  icon. 

4. Select Delete from the Server menu. 

Refreshing Content on Your SPT 173x Terminal
In rare instances, you might need to refresh all data from a server. 

To refresh all content on your terminal from AvantGo:

1. Tap the  icon, then select Server Preferences from the Options menu. 

2. Choose the server and select the Refresh All Content checkbox.

Note: Mobile Link displays this screen when the  icon is selected.
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Mobile Link Menu Commands

Mobile Link includes menu commands to make it fast and easy to perform tasks. This 
section explains the menu commands specific to Mobile Link.

Refer to Using Menus on page 3-20 for information about menu commands common to all 
of your SPT 1700 terminal applications.

Note: Refer to www.avantgo.com for additional information about these 
commands.

Server Menu
When you select the Server menu, its commands display on the screen.

Options Menu
When you select the Options menu, its commands display on the screen.

New Server Manually adds a new server configuration manually.

Delete Removes a server from the terminal’s configuration.

Modem Sync Synchronizes the AvantGo server with the SPT 173x terminal.

About Mobile Link Displays Mobile Link version information.
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Troubleshooting

If you do not see any channels or the channels you expect, check the following:

• If you have just installed AvantGo Client on your SPT 173x terminal, you must re-
sync to synchronize your SPT173x terminal and the host.

• If you must access AvantGo Server through a proxy server or a firewall, AvantGo 
attempts to set up the connection through the proxy server during the installation 
process, but sometimes it fails to do so. If it fails, you must set up the AvantGo 
connection manually.

• You may not have Mobile Link installed on your device. 

Mobile Link is an application that helps AvantGo Client access AvantGo Server, 
and it typically gets installed with AvantGo Client. To check this, tap the  icon 
and search for the Mobile Link application. 

• You don't have Mobile Link installed on your desktop. 

If you connect to AvantGo Server through a HotSync operation, you must have 
Mobile Link both on the device and on your desktop computer. Go to your desktop 
computer and look in Start, Programs, AvantGo for an application named Mobile 
Link. If this option exists, you probably have Mobile Link installed. If you do not 
have Mobile Link installed, refer to Using the Mobile Link Application on Your SPT 
173x Terminal on page 11-18. 
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Introduction

The Mail application enables you to manage your e-mail while away from your desk. Mail 
synchronizes the mail in your desktop e-mail application with the mail on your SPT 1700 
terminal. 

For example, if you read a message on your SPT 1700 terminal and leave it in your inbox, 
your next HotSync operation marks it as read on your desktop e-mail. Similarly, if you delete 
messages from your SPT Mail, your next HotSync operation also deletes the messages 
from your desktop e-mail application — so you never have to delete messages twice. 

With Mail, you can:

• Use your SPT 1700 terminal to send and/or retrieve e-mail messages from your 
desktop e-mail application.

• View, delete, file and/or reply to incoming mail.

• Create outgoing messages as well as drafts of messages that you can complete 
later.

• Create simple or complex filters, which allow you to decide the type of e-mail that 
your SPT 1700 terminal retrieves from your desktop e-mail application.

Setting Up Mail on the Desktop

Before you use Mail for the first time, make sure your desktop e-mail application is up and 
running. You must also set up the Symbol Palm Terminal Desktop software for use with your 
desktop e-mail application.

Note: The following instructions assume that you have already installed 
Symbol Palm Terminal Desktop software on your computer and that 
you did not set up Mail during the installation. If you have not yet 
installed the Symbol Palm Terminal Desktop software, the 
installation procedure will prompt you to set up Mail as part of the 
Symbol Palm Terminal Desktop software installation.

To set up Mail:

1. Click Start on the Windows desktop to open the Start menu.

2. Point to Programs, point to Symbol Palm Terminal Desktop, then click SPT Mail 
Setup to start the setup procedure.
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3. Follow the instructions on the screen to set up your SPT 1700 terminal for use with 
your desktop e-mail application.

To select HotSync options:

1. Click the  icon in the Windows System Tray to open the HotSync menu. 

2. Click Custom from the HotSync menu to open the Custom dialog.

3. Click Mail in the Custom list box.

4. Click the Change button. The Change HotSync Action dialog displays:

5. Select one of the following settings:

Tip: To turn off mail, check Do Nothing, then check the Set as Default check box.

Synchronize 
the files

Synchronizes the mail on your SPT 1700 terminal and your desktop e-
mail application.

Desktop 
overwrites 
handheld

Replaces the mail on your SPT 1700 terminal with the mail in your 
desktop e-mail application. Use this option only if, for some reason, the 
two inboxes get out of sync. This setting applies for only one HotSync 
operation, then reverts back to the default setting.

Do Nothing Turns off communication between your SPT 1700 terminal and 
desktop e-mail application. This setting applies for only one HotSync 
operation, then reverts back to the default setting.

Set As 
Default

Changes the default setting on an ongoing basis. (When you first set 
up Mail, Synchronize the files is the default setting.)
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To change your Mail setup options:

1. Click the  icon in the Windows System Tray to open the HotSync menu. 

2. Click Custom from the HotSync menu to open the Custom dialog.

Tip: You can also click Custom from the HotSync menu in the Symbol Palm 
Terminal Desktop software.

3. Click Mail in the Conduit list to indicate that you want to change these settings.

4. Click the Change button to open the Change HotSync Action dialog for the Mail 
conduit.

5. Modify your settings as needed.

6. Click the OK button to confirm your changes and close the Change HotSync Action 
dialog.

Synchronizing Mail with Your E-Mail Application

After you have enabled and configured Mail, perform a HotSync operation to synchronize 
Mail with your desktop e-mail application. For a complete explanation of how to use the 
HotSync feature, refer to the Chapter 9, Applications: HotSync®.

Opening Mail on Your SPT 1700 Terminal

To open mail:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to display the Message List screen.

Viewing Messages

The Message List lists your incoming messages, who sent them and the date they were 
received. Messages you’ve read appear with a check next them and high-priority 
messages appear in bold.
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To view a message:

1. Tap a message in the list to open it.

Messages display by default in the abbreviated mode. To switch from the 
abbreviated mode to the full header mode, refer to Displaying Full Header 
Information on page 12-6.

2. Tap the Done button to close the message and return to the Message List.

Message Fonts
You can modify the way messages display by changing the font (text) style. Refer to 
Choosing Fonts on page 3-23 for details. 

Displaying Full Header Information
By default, Mail displays abbreviated header information, which includes only the From and 
Subject fields. The full header provides complete information about the sender, receiver 

Previously read

Recipient
Sender

Time and date sent

Message body

Subject

Header mode icons
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and CC recipients, in addition to the subject and date the message was created. Mail uses 
the header type you select for all your messages.

To display full header information:

1. Open a message.

2. Tap the Complete Header icon to display the full header.

3. To display the abbreviated header, tap the Abbreviated Header icon. 

Creating Messages

Create messages with your SPT 1700 terminal the same way you create messages with 
your desktop e-mail application: identify the recipient(s) of the message, define a subject 
and create the body of the message.

Create original messages and replies in the New Message screen. All messages must 
contain information in the To and Subject fields. 

Complete Header icon

Abbreviated Header icon
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To create a message:

1. Tap the New button in the Message List screen to display the New Message 
screen.

Note: You can also display the New Message screen by tapping New on 
the Message menu.

2. Use the on-screen keyboard or Graffiti character strokes to enter the e-mail 
address of the recipient. The cursor indicates where new text will display.

Note: Enter the address as if you are entering it from your desktop e-mail 
application. For example, network users sending a message to a 
user on the same network do not need to add Internet information, 
such as @3com.com.

Tap New
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3. To send a carbon copy of this message to additional recipients, tap the CC field, 
then enter the e-mail addresses of the additional recipients, separating the 
addresses with a comma followed by a space.

4. Tap the Subj field, then enter a subject for your message. 

5. Tap the Body field, then enter the body text.

To reply to a message:

1. Tap a message in the Message List to display it on the screen.

2. Tap the Reply button to open the Reply Options screen.

3. Select who you want to receive the reply: only the Sender, All recipients and the 
sender, or Forward the message to someone else.

4. Select whether you want to Include original text and Comment original text.

5. Tap OK to close the Reply Options screen and display the New Message screen.

6. Enter your reply text.

Tap to return to New Message screen

Tap the name of the field to open
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Note: You have several message options including setting the priority. 
Refer to Adding Message Details on page 12-11 for details.

7. Tap Send to place your reply in the Outbox.

Looking Up an Address

To identify the recipient of a message, enter that person’s e-mail address in the appropriate 
field of the Message screen. You can do this either by entering the data directly into the field 
or using the Look Up command to access the information in your Address Book. 

To look up an address:

1. On the New Message screen, tap either the To or CC field and expand it.

2. Enter a few letters of the address you want to find. 

3. Tap the Lookup button. 

4. If the letters you enter identify a unique listing from your Address Book, your SPT 
1700 terminal completes the address for you. If not, the Lookup screen displays.

Note: You can also open the Look Up screen in the New Message screen 
by tapping Lookup from the Options menu or by using the Command 
stroke /L. 

5. Enter the first letter of the entry you want to find to scroll to the first entry that begins 
with that letter. If you write an additional letter, the list scrolls to the first entry that 

Tap here
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starts with those two letters. For example, writing a “c” might scroll to “Carter,” and 
writing “ch” might scroll farther to “chu.”

6. Tap an address to select it, then tap the Add button to enter the address in the field.

7. Tape Done to return to the New Message screen.

Adding Message Details

Before you send your message, you can attach additional attributes (called message 
details) to your message, such as a blind carbon copy, or flagging the message as high-
priority. These features are dependent on the desktop e-mail application you use. If your e-
mail application does not support the message detail you select, your SPT 1700 terminal 
cannot attach that attribute to your message.

Note: The Priority and BCC settings are valid only for the current message 
and must be set with each subsequent message you create.

Priority Flags a message as high, normal or low priority.

BCC Creates a blind carbon copy field in the New Message screen. 

Signature Attaches previously defined text as a signature block. Refer to Adding a 
Signature to Your Message on page 12-13 for details.

Confirm 
Read

Requests a confirmation telling you when the message was read.

Confirm 
Delivery

Requests a confirmation telling you when the message was delivered.

Tap here to enter address in field

Tap to select
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Setting a Priority
To set a priority for your message:

1. Tap the Details button in the New Message screen to open the Message Details 
screen.

2. Tap the Priority pick list and select the priority you want.

3. Tap the OK button to confirm your selection and return to the New Message screen.

Note: Your SPT 1700 terminal can flag messages with a specific priority 
only if your desktop e-mail application supports this feature.

Sending a Blind Carbon Copy
To add a BCC field to your message:

1. Tap the Message Details button and select the BCC check box in the Message 
Details screen. This will add the BCC field to the New Message screen. 

Tap here

Tap here

Tap to select priority
12-12

Download from Www.Somanuals.com. All Manuals Search And Download.



Applications: Mail
2. Tap the OK button to confirm your selection and return to the New Message screen.

3. Tap the BCC field and enter the address. 

Adding a Signature to Your Message
By defining information as a signature, you can automatically attach it to the close of e-mail 
items and avoid recreating the information for each e-mail item. A signature can contain 
information on you or your company—such as your name, address, phone and fax 
numbers, and any other text you want to include.

Adding a signature to your message is a two-part process: first, you must create your 
signature, then you must select the signature option from the Message Detail screen.

To create a signature:

1. Tap the  icon to open the Mail menus.

2. Tap Preferences from the Options menu to open the Preferences screen.

3. Tap in the Signature Text field and enter up to six lines of text. 

4. Tap the OK button to confirm your selection and return to the previous screen.

BCC field

Add signature 
text here
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To add a signature to your message:

1. Tap the Details button in the New Message screen to open the Message Details 
screen.

2. Select the Signature check box to add a signature to the end of your message. 

3. Tap the OK button to confirm your selection and return to the New Message screen.

Note: The signature block does not display in your message; only your 
recipient sees the signature block.

Requesting Confirmations
To receive a confirmation when your message is read:

1. Tap the Details button in the New Message screen to open the Message Details 
screen.

2. Select the Confirm Read check box to request a confirmation when the recipient 
reads your message. 

3. Tap the OK button to confirm your selection and return to the New Message screen.

To receive a confirmation when your message is delivered:

1. Tap the Details button in the New Message screen to open the Message Details 
screen.

2. Select the Confirm Delivery check box to request a confirmation that the recipient 
received your message. 

3. Tap the OK button to confirm your selection and return to the New Message screen.

Sending Messages

When you send messages from your SPT 1700 terminal, it stores them in the Outbox folder 
until the next time you synchronize your SPT 1700 terminal with your computer. During 
synchronization, all messages stored in the Outbox folder are transferred to the Outbox 
folder in your desktop e-mail application. Messages created on your SPT 1700 terminal are 
transmitted the next time you send mail from your desktop e-mail application.

After you create a message, tap the Send button in the New Message screen to send it. 
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Editing an Unsent Message

You can edit or make changes to a message that has not been sent, as long as you have 
not yet performed a HotSync operation. When you edit a message, your SPT 1700 terminal 
removes the message from the Outbox folder and takes you back to the New Message 
screen, where you can edit the message and resend it, save it as a draft, or cancel it.

To retrieve a message:

1. In the Message List screen, tap Outbox from the pick list in the upper-right corner 
to display the messages contained in the Outbox.

2. Tap the message you want to retrieve to display the message.

3. Tap the Edit button to remove the message from the Outbox folder and place it 
back in the New Message screen.

4. Edit the message as desired. To return the message to the Outbox tap Send. 

Tap to display folder list

Tap here 
to select 
message

Tap to 
modify 
message
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Draft Messages

There are times when you may not want to immediately send a message you compose — 
for example, you may want to add additional information before sending it. Your SPT 1700 
terminal stores such messages in the Draft folder until you are ready to edit them. When 
you edit a draft, it becomes a new message again.

Note: When you’re creating or editing a message, you can also save a 
message as a draft by canceling it. When you cancel a message, the 
SPT 1700 terminal opens a dialog asking if you want to save the 
message. If you tap the Yes button, your SPT 1700 terminal saves 
a draft of your message.

To save a message as a draft:

1. Create a message in the New Message screen.

2. Tap the  icon to open the Mail menus.

3. Tap Save Draft from the Message menu to move the message to the Draft folder.

To edit a message saved as a draft:

1. In the Message List screen, tap Draft from the pick list in the upper-right corner to 
display a list of the messages in the Draft folder.

2. Tap the draft you want to display.

3. Tap the Edit button to move your draft to the New Message screen.

4. Enter your changes, then either save it again as a draft or tap the Send button to 
move the message to your Outbox folder.

Tap to select 
message

Tap to edit 
draft in the 
New Message 
screen
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Filing a Message

Your SPT 1700 terminal can store any message you receive or create in the Filed folder. A 
back-up copy of the Filed folder is stored on your computer hard drive, but the contents of 
this folder do not automatically synchronize with your desktop e-mail application during a 
HotSync operation.

To file a message:

1. Open a message.

2. Tap the  icon to open the Mail menus.

3. Tap File from the Message menu to display the Message File Options screen.

4. Tap No to save the message and move it to the Filed folder or tap Yes to file the 
message and keep a copy in the Inbox.

To remove a message you created from the Filed folder:

1. In the Message List screen, tap Filed from the pick list in the upper-right corner to 
display the contents of the Filed folder.

2. Tap the message you want to restore.

3. Tap the Edit button to display and modify the message.

Note: After you display and modify the message, you can send it, save it 
as a draft, or return it to the Filed folder.

Deleting Messages

Your SPT 1700 terminal stores deleted message in the Deleted folder until you perform the 
next HotSync operation. If you delete a message from SPT 1700 terminal, it is deleted on 
your desktop e-mail application after you perform a HotSync operation.

To delete a message:

1. Open the message you want to delete.

2. Tap the Delete button. 

3. If you selected the Preference option to confirm message deletion, tap the Yes 
button to confirm that you want to delete the current message. 
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Restoring a Message From the Deleted Folder
You can reverse the deletion of a message (by removing it from the Deleted folder) as long 
as you have neither performed a HotSync operation nor purged the contents of the Deleted 
folder.

To restore a message you received from the Deleted folder:

1. In the Message List screen, tap Deleted from the pick list in the upper-right corner 
to display the contents of the Deleted folder.

2. Tap the message you want to restore. 

3. Tap the Undelete button to move the selected message to the Inbox and mark it as 
read.

To remove a message you created from the Deleted folder:

1. In the Message List screen, tap Deleted from the pick list in the upper-right corner 
to display the contents of the Deleted folder.

2. Tap the message you want to restore. 

3. Tap the Edit button to display and modify the message.

Note: After you display and modify the message, you can send it or save 
it as a draft.

Purging Deleted Messages
Because your SPT 1700 terminal stores deleted messages in the Deleted folder until you 
perform a HotSync operation, deleted messages can monopolize storage space. To avoid 
or correct this problem, you can purge the contents of your Deleted folder. Messages that 
you purge are still deleted from your desktop e-mail application during the next HotSync 
operation.

To purge the contents of the Deleted folder:

1. Tap the  icon to open the Mail menus. 
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2. Tap Purge Deleted from the Message menu. The following alert displays:

3. Tap the Yes button to confirm that you want to purge the contents of the Deleted 
folder. 

Note: You cannot restore messages after you purge them.

Message List Options

Message List Options enable you to manage the way the Message List displays 
information.

Folders
Your SPT 1700 terminal provides five different folders, each pertaining to a particular mail 
category. The Message List displays the messages in the folder you select. Folders provide 
an efficient way to manage the mail you send and receive.

Tap the pick list in the upper-right corner to open the following list of folders:

Inbox Contains the mail from your desktop e-mail application Inbox, minus any 
that you have excluded using filtering options. Refer to Creating Special 
Filters on page 12-22 for details.

Outbox Contains the mail you created and sent on the SPT 1700 terminal since 
the last HotSync operation.

Deleted Contains the messages you deleted since the last HotSync operation.

Filed Contains the messages you are storing on the SPT 1700 terminal.

Draft Contains the messages you created using the SPT 1700 terminal but are 
not yet ready to send.
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Date Column
The Date Column is optional in the Message List. By default, the Date Column is hidden to 
increase the available screen space. 

To show the Date Column:

1. Tap the Show button in the Message List to open the Show Options screen.

2. Select the Show Date check box to show the Date Column. 

3. Tap OK to close the Show Options screen and return to the Message List.

Sorting the Message List
You can sort the Message List by the date it was sent, by sender or by subject.

Note: High-priority messages always display first, no matter how you sort 
your message list.

To sort the Message List:

1. Tap the Show button in the Message List to open the Show Options screen.

2. Tap the Sort by pick list and select one of the following options:

Date Sorts messages by date and displays the most recent message at the 
top of the screen.

Sender Sorts messages by the sender’s user name and displays them in 
ascending alphabetical order —based on the first word of the sender 
field.

Tap Show
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3. Tap OK to close the Show Options screen and return to the Message List. 

HotSync Options

HotSync Options enable you to manage your e-mail more effectively by selecting which 
messages download when you synchronize your computer and your SPT 1700 terminal. 
Different settings can be defined for local and remote synchronization. For example, you 
may want to download all of your messages during local synchronization and only urgent 
messages during remote synchronization. Once defined, your SPT 1700 terminal 
determines if synchronization is occurring locally or remotely and uses the appropriate 
HotSync Options settings.

To activate the HotSync Options screen:

1. Tap the  icon to open the Mail menus.

2. Tap HotSync Options from the Options menu to open the HotSync Options screen.

3. Tap the Settings for pick list and select Local HotSync or Remote HotSync.

Note: For more information about Local and Remote HotSync operations, 
refer to Chapter 9, Applications: HotSync®.

Subject Sorts messages by subject and displays them in ascending alphabetical 
order based on the first word of the subject field.

Tap here to 
display 
HotSync 
options 
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4. Tap the filtering option you want to apply.

Note: The All setting does not mean that all information included in each 
message downloads to your SPT 1700 terminal. Truncation settings 
(explained in a following section) for long messages still apply. Also, 
Mail never downloads any attachments to your SPT 1700 terminal. 
The message and any text information display, but the attachment is 
left in your desktop e-mail application.

5. If you selected All, Send Only or Unread, tap the OK button to confirm your 
selection and close the HotSync Options screen. If you selected Filter, continue to 
the next section.

Creating Special Filters
You can create special filters to control the type of messages that download to your SPT 
1700 terminal during synchronization. Special filters tell your SPT 1700 terminal what to 
look for in the To, From, and Subject header fields to single out certain messages. 

All During synchronization, all messages in your desktop e-mail Inbox 
synchronize with your SPT 1700 terminal and all messages in your 
SPT 1700 terminal Outbox are sent to your desktop e-mail application.

Send Only During synchronization, only the messages in your SPT 1700 terminal 
Outbox are sent to your desktop e-mail application where they are sent 
to their final destination.

Filter During synchronization, all messages in your SPT 1700 terminal 
Outbox are sent to your desktop e-mail application, and messages in 
your desktop e-mail Inbox that meet specific criteria download to your 
SPT 1700 terminal. When you select the Filter setting, the HotSync 
Options screen opens and displays additional filter settings. Refer to 
Creating Special Filters on page 12-22 for details.

Unread During synchronization, only unread messages download to your SPT 
1700 terminal from your desktop e-mail Inbox, and all messages in 
your SPT 1700 Outbox are sent to your desktop e-mail application.
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1. To specify filter options, tap the Filter box in the HotSync Options screen to display 
the filter settings.

Ignoring or Receiving Messages
To define whether to ignore or receive messages that match the information you specify, 
tap the pick list in the middle of the HotSync Options screen and select one of the following 
settings:

Ignore 
Messages 
Containing

Tells your SPT 1700 terminal to exclude the messages that meet the 
defined criteria and download all other messages during 
synchronization. In general, this filter downloads more mail during 
synchronization because it blocks only one defined subset of mail.

Tap here to 
display 
Filter 
options

Select Filter option

Tap here 
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Defining Filter Strings
Messages are filtered based on the information contained in their To, From and Subject 
header fields. The information that defines what your SPT 1700 terminal is looking for is 
called a filter string. You create a filter string by listing the words you want your SPT 1700 
terminal to find and separating them with either a comma or a space. Each word in the filter 
string is joined by an implicit OR; do not enter connecting words such as AND or OR.

To create a more complex filter, you can define filter strings for the To, From and Subject 
fields simultaneously. Your SPT 1700 terminal joins the filter strings for these fields using 
an implicit AND, so do not add connecting words. Your SPT 1700 terminal does that for you.

For example, suppose you want to receive only messages from John Smith 
(jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo Project. You 
would create the following filter strings:

To field filter string: jsmith@aol.com, jjones@aol.com

Subject field filter string: Apollo Project

Your SPT 1700 terminal interprets this as, “Accept messages about the Apollo Project from 
John Smith or Jack Jones. Do not accept messages from other people. Do not accept 
messages from John or Jack about any other subject.”

When you define a string, note that your SPT 1700 terminal searches for any instance of 
that collection of characters. For example, if you create a filter that retrieves only messages 
containing the string “info,” your SPT 1700 terminal considers “info,” “rainforest” and 
“kinfolk” appropriate matches.

Retrieve 
Only Msgs 
Containing

Tells your SPT 1700 terminal to include only the messages that meet 
the defined criteria and to ignore all other messages during 
synchronization. This filter may block more mail during synchronization 
because it downloads only one subset of mail.
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To define filter strings:

1. Tap a header field in the HotSync Options screen.

2. Enter your filter string for the selected header field using commas or spaces to 
separate the words, not AND or OR.

3. If your string exceeds the length of the field, tap the name of the field to display the 
Notes screen for that header field. For more information about header field Notes 
screens, refer to Creating Messages on page 12-7.

4. Tap the Done button to return to the HotSync Options screen.

5. Tap the OK button to confirm your filter strings and close the HotSync Options 
screen.

Tap here to 
insert cursor

Tap Done to return to
HotSync Options

Enter filter data
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High-Priority Messages
The Retrieve All High Priority setting lets you retrieve messages marked high-priority, even 
if those messages would have been blocked by a defined filter.

To retrieve high-priority messages:

1. Tap the Filter box in the HotSync Options screen to display additional filter options.

2. Select the Retrieve All High Priority check box to retrieve all messages marked 
high-priority. 

3. Tap OK to confirm your selection and close the HotSync Options screen.

Note: This setting is applicable only if your e-mail application has the 
capacity to flag high-priority messages.

Truncating Messages
The Truncate feature lets you set a point at which long messages truncate when 
downloading to your SPT 1700 terminal. By default, this Truncate value is 4000 characters. 
By truncating long messages, you reduce the time it takes to synchronize your desktop e-
mail and SPT 1700 Mail as well as the amount of storage space e-mail uses on your SPT 
1700 terminal.

Note: Truncation is separate and independent from filtering.

Tap
check

box
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To truncate messages:

1. Tap the Truncate button in the HotSync Options screen to open the Truncate 
Options screen.

2. Tap to select the truncation setting you want. The values range from 250 characters 
to 8000 characters.

Tip: If you select a low truncation value, you will have more room on your SPT 1700 
terminal to store messages.

3. Tap OK to confirm your selection and return to the HotSync Options screen.

Tap 
Truncate 

Tap to
 select 
maximum 
length
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Mail Menu Commands

The Mail application includes menu commands to make it fast and easy to perform common 
file and editing tasks. Refer to Using Menus on page 3-20 for information about menu 
commands that are common to all of your SPT 1700 terminal applications.

Message Menu
The Message menu varies based on whether you are viewing a message, creating a 
message or viewing the Message List.

New Displays the Create Message screen, where you can create a new e-mail 
message.

Save Draft Saves the current message as a draft and moves it to the Draft folder where 
it is stored until you send or delete it.

File Moves the current message to the Filed folder where it is stored until you 
delete it.

Delete Moves the current message to the Deleted folder. Your SPT 1700 terminal 
stores deleted messages in the Deleted folder until you perform a HotSync 
operation, which permanently removes deleted messages.

Message Menu 
when viewing 
Message List Message Menu 

when creating a 
New Message 

Message Menu when 
Viewing a Message
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Options Menu
When you select the Options menu, its menu commands vary depending on whether you 
are creating or editing a message.

Purge 
Deleted

Empties (purges) the contents of the Deleted folder. Your SPT 1700 terminal 
stores deleted messages in the Deleted folder until you perform a HotSync 
operation. Purging deleted messages frees up storage space on your SPT 
1700 terminal before the next HotSync operation.
Note: The Purge Deleted command displays an alert, prompting you to 
confirm that you want to purge all messages from the Deleted folder. If you 
tap Yes, all deleted messages are purged from the memory of your SPT 
1700 terminal.
Important: Messages that you purge are deleted from your desktop e-mail 
application during the next HotSync operation.

Font Enables you to adjust the size of the text on the screen. This can make 
it easier to read the text or to fit more text in the display area.

Preferences Enables you to define a specific string of text as a signature and to 
select whether or not your SPT 1700 terminal displays an alert when you 
delete a message.

HotSync 
Options

Opens a screen, where you can select different ways to filter messages 
synchronized between your desktop e-mail application and your SPT 
1700 terminal. You can create simple or complex filters to control the 
type of messages downloaded to your SPT 1700 terminal. In addition, 
you can define separate settings for local and remote synchronizations.

Options Menu when viewing 
Message List Options Menu when 

viewing a New Message
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Look Up Opens a screen, which contains the Address List from your Address 
Book. By tapping a selection, you enter that address into the To field of 
any message you are creating.
Note: The Look Up command is available only when you are creating a 
message.

About Mail Shows version (revision) information for the Mail application.
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Applications: Memo Pad
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Introduction

The Memo Pad provides a place to take notes that are not associated with Date Book, 
Address Book or To Do items.

With the Memo Pad, you can:

• Take notes or write any kind of message on your SPT 1700 terminal. 

• Drag and drop memos into popular computer applications like Microsoft Word, 
when you synchronize using Symbol Palm Terminal Desktop software and 
HotSync technology.

• Assign categories for memos. This enables you to quickly view your business-
related memos, personal memos or any other category that you define.

• Quickly jot down phone numbers and other types of information. Later, you can 
copy and paste this information to other applications. 

Opening the Memo Pad
To open the Memo Pad:

1. Press the Memo Pad button on the front panel of the SPT 1700 terminal to display 
the Memo List screen.

Tip: Press the Memo Pad button repeatedly to cycle through the categories in 
which you have memos.

Memo Pad button
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Creating a New Memo

A memo is the record where you enter, review and modify the individual Memo Pad entries. 
A memo can contain up to 4,000 characters; the number of memos you can store is 
dependent only on the memory available on your SPT 1700 terminal. 

To create a new memo:

1. Open the Memo Pad application.

2. Tap the New button to create a new memo.

Note: In the Memo List screen, you can also begin writing in 
the Graffiti writing area to create a new memo. The first letter is 
automatically capitalized and begins your new memo.

3. Enter the text you want to appear in the memo. Use the carriage return stroke to 
move down to new lines in the memo.

4. After you finish, tap the Done button to return to the Memo List screen. 

Tap New
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Reviewing Memos

Each time you create a memo, the first line of the memo displays in the Memo List screen. 
This makes it easy to locate and review your memos. 

To review the contents of a memo:

1. Tap the text of the memo that appears in the Memo List screen to display the memo 
on the screen.

2. Review or edit the text in the memo. If the message is more than one page, a scroll 
bar will display for easy navigation. If the message is longer than one page, use the 
Options menu items to navigate.

3. Tap the Done button to save your changes to the memo and return to the Memo 
List screen.

Arranging Memos

The Memo Preferences screen enables you to sort your memos alphabetically or in any 
order that you want. 

To select a sort option:

1. In the Memo List screen, tap the  icon to open the Memo Pad menus.

2. Tap Preferences from the Options menu to open the Memo Preferences screen. 

Tap a 
memo to 
review its 
contents
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3. Tap the Sort by pick list and choose Manual or Alphabetic.

4. Tap the OK button to close the Memo Preferences screen and activate your setting.

Manually Arranging the Memo List
If you choose the Manual option for the Sort by setting, you can rearrange the order of the 
memos in the Memo List screen. Your SPT 1700 terminal renumbers all the memos to 
reflect the new order.

Note: The Manual setting of the Memo Preferences is not transferred to 
the Symbol Palm Terminal Desktop. If you choose to display your 
memos alphabetically on the Symbol Palm Terminal Desktop and 
then perform a HotSync operation, the memos are still arranged in 
the order defined in the Memo Preferences setting.

To rearrange the order of your memos:

1. Select the Manual option in the Preferences screen as described in the previous 
procedure.

2. In the Memo List screen, tap and drag the memo to a new location in the list. When 
you lift the stylus from the SPT 1700 terminal screen, the memo displays in its new 
location.

Choosing a Memo Category

Categories are used to file individual memos into groups for easy review. You can assign 
and edit categories using the Categories pick list (in the upper-right corner of the screen) 
or the Details screen. Refer to Using Categories on page 3-24 for a complete description 
of categories. 

Marking a Private Memo

You can designate a specific memo as “private.” When you activate the Security features, 
your SPT 1700 terminal hides all private entries and you must enter a password to display 
them on the screen.
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To mark a memo as private:

1. Tap the memo you want to mark as private to display it on the screen.

2. Tap the Details button to open the Memo Details screen for that memo.

3. Select the Private check box.

4. Tap the OK button to close the Memo Details screen and return to the memo 
screen.

Deleting a Memo

There are three ways to delete a memo: simply delete the text of the memo, use the Menu 
Command (as described in the Record Menu on page 13-8) or use the Memo Details 
screen.

To delete a memo with the Memo Details screen:

1. Tap the memo that you want to delete to display it on the screen.

2. Tap the Details button to open the Memo Details screen.

3. Tap the Delete button to open the Delete Memo alert.

4. Tap the OK button to confirm that you want to delete the current memo.
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Memo Pad Menu Commands

The Memo Pad includes menu commands to make it fast and easy to perform common file 
and editing tasks. Refer to Using Menus on page 3-20 for information about menu 
commands that are common to all SPT 1700 terminal applications.

Record Menu
When you select the Record menu, its commands display on screen: 

Beam Category Beams all memos in the current category to another terminal through 
the IR port. 

New Memo Creates a new memo.

Delete Memo Opens an alert screen, prompting you to confirm that you want to 
delete the current memo. Tap the OK button to delete the memo from 
your SPT 1700 terminal, or tap the Cancel button to close the alert 
screen and keep the memo.

Note:By default your SPT 1700 terminal removes the memo from the 
Memo List, but retains a copy of the memo and transfers it to an 
archive file on your computer the next time you perform a HotSync 
operation. To remove the memo completely, clear the Save archive 
copy on PC check box.

Beam Memo Beams the current memo to another SPT 1700 terminal through the IR 
port.

Record Menu when viewing 
Memo List Record Menu when viewing 

the Memo screen
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Options Menu
When you select the Options menu, its commands display on screen.

Font Opens the Select Font screen where you can choose a different 
font (text) style for your Memo Pad entries. Refer to Choosing 
Fonts on page 3-23 for details.

Preferences Activates the Memo Preferences screen and enables you to define 
the sort order for your memos. 

Security Opens the Change Security screen where you can change the 
security of the open memo. Refer to Chapter 15, Applications: 
Security for details.

Phone Lookup Activates the Phone Lookup feature, described in Using Phone 
Lookup on page 4-4.

About Memo Pad Shows version (revision) information for the Memo Pad 
application.

Options Menu when 
viewing Memo List

Options menu when 
viewing the Memo Screen
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Introduction

The Preferences screens enable you to customize the configuration options on your SPT 
1700 terminal.

With the Preferences screens, you can:

• Set the current date and time, the auto shut-off interval, and the overall, system, 
alarm and game sounds.

• Set the display format for dates, times and numbers.

• Configure your SPT 1700 series terminal for use with a modem.

• Assign your name, phone number and other owner information to your SPT 1700 
series terminal.

• Assign different applications to the buttons on the front panel of your SPT 1700 
series terminal.

• Define a list of Graffiti abbreviations.

• Calibrate the screen on your SPT 1700 series terminal.

• Configure your SPT 1700 series terminal for use with a network, including 
Spectrum24 (SPT 174x only), CDPD (SPT 1733 only), and GSM (SPT 1734 only). 

To open the Preferences screens:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to display the last Preferences screen you used. 

3. Tap the pick list in the upper-right corner to select the Preferences screen you want 
to view.

Buttons Preferences

The Buttons Preferences screen enables you to associate different applications with the 
buttons on the front of the SPT 1700 terminal. For example, if you find that you seldom use 
the To Do List application and often use the Expense application, you can assign the To Do 
List button to start the Expense application.

Any changes you make in the Buttons Preferences screen become effective immediately; 
you do not have to switch to a different screen or application.

If you assign a different application to a button, you can still access the original application 
using the Applications Launcher. Refer to Applications on page 3-3.
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To change the Buttons Preferences:

1. On the General Preferences screen choose Buttons from the pick list. This displays 
a list of all the applications installed on your SPT 1700 terminal.

2. Tap the pick list next to the application you want to re-assign a button.

3. Select the new button.

Note: To restore all of the buttons to their factory settings, tap the Default 
button.

Tap arrow to 
show pick list
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Pen Preferences
The Buttons Preferences screen enables you to change the Button assignment of the full-
screen pen stroke. By default, the full-screen pen stroke activates the Graffiti Help screen.

To change the Pen preferences:

1. Tap the Pen button in the Buttons Preferences screen to open the Pen screen.

2. Tap the pick list and select one of the following settings for the full-screen pen 
stroke:

Backlight Activates the backlight feature of the SPT 1700 terminal. You can 
use this setting instead of the power button to turn the backlight on 
and off.

Keyboard Activates the on-screen keyboard for entering text characters.

Drag to top of screen
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3. Tap the OK button to complete your selection and return to the Buttons Preferences 
screen.

HotSync Buttons Preferences
The Buttons Preferences screen also enables you to associate different applications with 
the HotSync button on the CRD1700-1000S. Any changes that you make in the HotSync 
Buttons screen are effective immediately; you do not have to change to a different screen 
or application.

To change the HotSync Buttons preferences:

1. Tap the HotSync button in the Buttons Preferences screen to open the HotSync 
Buttons screen.

2. Tap the pick list next to the button you want to assign to display a list of all the 
applications installed on your SPT 1700 terminal.

3. Tap the application that you want to assign to each button. The default setting for 
each button is the HotSync setting, which means the cradle and optional device 
accessory perform their normal HotSync functions.

Graffiti Help Activates a series of screens that show the complete Graffiti pen 
stroke character set.

Turn Off & Lock Turns off and locks the SPT 1700 terminal. You must assign a 
password to lock the SPT 1700 terminal. When locked, you need to 
enter the password to unlock and use your SPT 1700 terminal.

Beam Data Beams the current entry to another terminal.

Tap arrow to 
show pick list
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Connection Preferences

The Connection Preferences screen enables you to define the settings for the serial, 
modem, and IR communications. 

To define the Connection Preferences:

1. Tap the  icon to display the last Preferences screen you used. 

2. Tap the pick list in the upper-right corner and select Connection. The following 
screen displays:

3. Tap the modem you want to configure and tap New for a new configuration, or Edit 
to re-configure an existing one. The Edit screen displays:
14-7
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4. Tap the Details button. The following screen displays:

5. Tap the Speed pick list and select the speed for communication.

6. Tap the Flow Ctl (Flow Control) pick list and select either Automatic, On or Off Flow 
Control for the modem connection.

7. If necessary, edit the Init String text to change the modem setup string. 

Name If the configuration is new, enter the name of the modem connected 
to the SPT 1700 terminal using the onscreen keyboard. If it is an 
existing configuration, the modem name displays.

Connection 
Method

The preferred method of communication. 
Note: The SPT 1733 terminal can connect via Merlin to PC.

Dialing Select either Touch Tone or Rotary. Select Rotary only if you are 
certain that your telephone service does not support Touch Tone 
dialing.

Volume Speaker volume for the modem.
Note: The Dialing and Volume settings are not configurable for all 
Connection Methods and may not display your screen.
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Digitizer Preferences

The Digitizer Preferences screen activates the digitizer calibration screen. This is the same 
screen that displays when you start your SPT 1700 terminal for the first time. A complete 
description of how to use the digitizer calibration screen can be found in Calibrating the 
Screen on page 1-17.

Formats Preferences

Use the Formats Preferences screen to set the display format of the country, dates, times 
and numbers on your SPT 1700 terminal. 

Country Default
The country default sets date, time, week start day, and number conventions based on 
geographic regions where you might use your SPT 1700 terminal. For example, in the 
United Kingdom, time often is expressed based on a 24-hour clock. In the United States it 
is based on a 12-hour clock with an AM or PM suffix.

All your SPT 1700 terminal applications use the Country default settings. You can, however, 
customize your own preferences as described in Time, Date, Week Start and Numbers 
Formats on page 14-10.

To set the country default:

1. In the Formats Preferences screen, tap the Preset To pick list. The following screen 
displays:

2. Tap the country you want to use. 
14-9
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Time, Date, Week Start and Numbers Formats
These settings define the defaults. Note that the format that you select appears in all 
applications on your SPT 1700 terminal. 

To select the Time, Date, Week start and Numbers format:

1. Tap the Time pick list in the Formats Preferences screen, and select the format that 
you want for your SPT 1700 terminal. 

2. Tap the Date pick list and select the format that you want for your SPT 1700 
terminal.

3. Tap the Week starts pick list and select whether you want the first day of the week 
to be either Sunday or Monday. 

4. Tap the Numbers pick list and select the format that you want for your SPT 1700 
terminal.

Note: This setting controls the Day, Week and Month views in the Date 
Book application and all other aspects of your SPT 1700 terminal 
that display a calendar.

General Preferences

The General Preferences screen is where you set the time, date, auto shut-off interval and 
sounds for your SPT 1700 terminal. 

Setting the Current Time
Use the Set Time button in the General Preferences screen to set the current time for your 
SPT 1700 terminal.
14-10
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To set the current time:

1. Tap the time in the General Preferences screen to open the Set Time screen.

2. Tap the up or down arrows to change the number for the hour.

3. Tap the minutes numbers, and then tap the arrows to adjust the settings for the 
current time.

4. Tap the AM or PM box to select the time of day.

Note: Your SPT 1700 terminal can also display time based on a 24-hour 
clock. Refer to the Formats Preferences on page 14-9. 

5. Tap the OK button to close the Set Time screen and return to the General 
Preferences screen.

Setting the Current Date
Use the Set Date button in the General Preferences screen to set the current date for your 
SPT 1700 terminal.

To set the current date:

1. Tap the date in the General Preferences screen to open the Set Date screen.

Tap here
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2. Tap the arrows at the top to select the current year.

3. Tap a month box to select the current month.

4. Tap the current date to set the date, close the Set Date screen and return to the 
General Preferences screen. 

Auto-Off
Your SPT 1700 terminal has an automatic shutoff feature that turns off the power and 
backlight after a period of inactivity. This feature helps conserve battery power in case you 
forget to turn off your SPT 1700 terminal.

If you find that your SPT 1700 terminal shuts itself off before you finish reviewing the 
information on the screen, increase the time setting of the automatic shutoff feature.

To set the Auto-off delay:

1. Tap Auto-off After in the General Preferences screen to open the pick list. 

2. Tap the setting you want to use for the automatic shutoff feature. You can choose 
a delay of 1 minute, 2 minutes or 3 minutes.

Stay On In Cradle
This option is used to control whether the SPT 1700 terminal stays powered on while it is 
in the cradle. To force the terminal to stay on while it is seated in the cradle, check this box.

Trigger Wake
Your SPT 1700 terminal can be “awakened” or powered on by pressing any one of the 
scanner buttons. If you want this feature enabled, tap the Trigger Wake pick list and select 
the “On” option. If you set this option to “Off”, the scanner buttons will not awaken the 
terminal.

Tap arrows to select year

Tap to select month

Tap to select date
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Overall, System, Alarm and Game Sounds
Your SPT 1700 terminal uses a variety of sounds. The Overall, System, Alarm and Game 
Sound settings enable you to turn the sounds on or off, and to adjust the volume level.

To set the overall, system, alarm and game sounds, tap each option’s pick list and select 
the sound level:

Note: When you turn off the System Sounds, you also turn off the “chime” 
tones associated with the HotSync operation. The Game Sound 
setting works only with games that are programmed to respond to 
this setting. Older games typically do not respond to this setting.

Beam Receive
The Beam Receive preference controls the IRDA receiving. Refer to Beaming Information 
to Other SPT 1700 Terminals on page 3-30 for details.

Network Preferences and Symbol Palm Terminal 
Desktop TCP/IP Software

The Network Preferences settings enable you to use the TCP/IP software that comes with 
your SPT 1700 terminal operating system. You can use the TCP/IP software to connect with 
Internet Service Providers (ISPs) or dial-in (remote access) servers. Because the TCP/IP 
software is a feature of the operating system, you configure all parameters relating to it from 
the Preferences application.

Note: For specific instructions on configuring your terminal for use with a 
Spectrum24, CDPD, or GSM network refer to Chapter 2, Network 
Setup.

To use the Symbol Palm Terminal Desktop TCP/IP, you must configure both the Connection 
Preferences and the Network Preferences settings.
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Note: Connection preferences settings enable your SPT 1700 terminal to 
use an external modem (such as the SPT 1700 Modem Cradle) to 
communicate with remote devices. For example, you can 
communicate with your computer if you are away on travel or your 
ISP server. Refer to Connection Preferences on page 14-7 for a 
complete explanation on how to configure modem parameters.

After you configure both the Network and Connection (modem) Preferences, you can 
establish a PPP (Point-to-Point Protocol), SLIP (Serial Line Internet Protocol) or CSLIP 
(Compressed Serial Line Internet Protocol) connection with your ISP or dial-in server, by 
using menu commands from the Network Preferences screen or by using a third-party 
application. 

Note: Symbol Palm Terminal Desktop TCP/IP provides the ability to 
connect to your ISP or dial-in server, however, it does not come with 
any applications to view the transmitted data. Visit the Symbol 
website (http://www.symbol.com/palm) for information on third-party 
applications that take advantage of TCP/IP.

Selecting a Service
Use the Service setting to choose the service template for your WAN, Internet Service 
Provider or a dial-in server. Service templates are a set of ISP and dial-in server 
configuration settings that you can create, save and reuse.
14-14
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To select a service:

1. Tap the Service pick list in the Network Preference screen to display a list of all the 
predefined service templates.

2. Tap the service you want to use.

Entering a User Name
The User Name setting identifies the name you use when you log into your Internet Service 
Provider or your dial-in server. Although this field can contain multiple lines of text, only two 
lines display on the screen.

To enter a user name:

1. Tap the User Name line in the Network Preferences screen to move the cursor to 
that field. (If you select the Spectrum24 option it does not request a user name.) 

2. Enter your user name.

Note: Most dial-in servers do not accept spaces in the user name.

Entering a Password
The Password field identifies the password you use to log into your server or ISP. Your entry 
in this field determines whether your SPT 1700 terminal prompts you to enter a password 
each time you log into your network.

If you do not enter a password, your SPT 1700 terminal displays the word “Prompt” in this 
field and asks you to enter a password during the login procedure. If you enter a password, 

Tap here to display a list 
of service templates
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your SPT 1700 terminal displays the word “Assigned” in this field and does not prompt you 
to enter a password during the login procedure.

Note: If you are concerned about security, select the Prompt option and do 
not enter a password.To enter a password:

1. Tap the Password box in the Network Preferences screen to open the Password 
screen.

2. Enter the password you use to log into your server. 

3. Tap OK to confirm your entry and return to the Network Preferences screen. 

Note: The Password field updates to display the word “Assigned.”

Adding Connection Settings
Use the Connection pick list to choose your modem.

When you select the Phone field, your SPT 1700 terminal opens a screen where you define 
the telephone number you use to connect with your ISP or dial-in server. In addition, use 
this screen to define a prefix, disable Call Waiting and give special instructions for using a 
calling card.

Note: The phone setup screen works correctly for AT&T and Sprint long-
distance services. However, MCI customers need to put the calling 
card number in the Phone field and the phone number in the Calling 
Card field.

Enter password here

Tap here
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To enter your server phone number:

1. Tap the Phone field to open the Phone Setup screen.

2. Enter the phone number you use to reach your ISP or dial-in server.

Entering a Prefix
A prefix is a number that you dial before the telephone number to access an outside line. 
For example, many offices require that you dial “9” to dial a number outside the building.

To enter a prefix:

1. Select the Dial Prefix check box to activate this feature.

2. Enter the prefix you need on the Prefix line. 

3. Tap OK to confirm your selection and return to the Network Preferences screen.

Enter your ISP 
phone number here

Enter your 
prefix here

Select this box
if you need to

use a prefix
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Disabling Call Waiting
Call Waiting can cause your session to terminate if you receive a call while you are 
connected. If your telephone has Call Waiting, disable this feature before logging into your 
ISP or dial-in server.

To disable Call Waiting:

1. Select the Disable call waiting check box to activate this feature.

2. Enter the code to disable Call Waiting on the Disable call waiting line.

Note: Each telephone company assigns a code to disable Call Waiting. 
Contact your local telephone company for the code that is 
appropriate for you.

Using a Calling Card
The Use Calling Card field enables you to use your calling card when dialing your ISP or 
Intranet server. There is usually a delay before you enter your calling card number. When 
you define your calling card number, add commas at the beginning to compensate for this 
delay. Each comma delays transmission of your calling card number for two seconds.

Enter your disable 
code here

Select this box
if you need to

disable Call
Waiting
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To use a calling card:

1. Select the Use Calling Card check box to activate this feature.

2. Enter your calling card number on the Use Calling Card line.

Note: It’s a good idea to add at least three commas at the beginning of your 
calling card number to compensate for the cue delay.

3. Tap OK to confirm your selection and return to the Network Preferences screen.

Connecting to Your Service
After you set your Modem and Network Preferences, establishing a connection to your ISP 
or dial-in server is easy.

Remember that you need a third-party application, such as a web browser or news reader, 
to take advantage of this connection. Check the Symbol website (http://www.symbol.com/
palm) for the latest information about third-party applications that support SPT TCP/IP.

To establish a connection, tap the Connect button in the Network Preferences screen to dial 
the current service and display the Service Connection Progress messages. 

Tip: To see expanded Service Connection Progress messages, press the lower 
half of the scroll button.

To close a connection, tap the Disconnect button in the Network Preferences screen to 
terminate the connection between your SPT 1700 terminal and your service.

Enter your 
calling card 
number here

Select this box to
use a calling card
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Creating Additional Service Templates
You can create additional service templates from scratch or by duplicating existing 
templates and editing information. After you create a new or duplicate template, you can 
add and edit settings.

To add a new service template:

1. Tap the  icon in the Network Preferences screen to open the menus.

2. Tap New from the Service menu to create a new service template (called Untitled) 
to the Service pick list and display it in the Network Preferences screen.

To duplicate an existing service template:

1. Tap the Service pick list in the Network Preference screen to open a list of all the 
predefined service templates.

2. Tap the service you want to duplicate.

3. Tap the  icon to open the Network Preferences menus.

4. Tap Duplicate from the Service menu to add a copy of the service template to the 
Service pick list and display it in the Network Preferences screen.

Adding Detailed Information to a Service Template
If you are using one of the predefined service templates, you will probably only need to 
enter your user name and telephone number. If you are creating a new Service Templates, 
you may need to provide additional information to your ISP or dial-in server. Use the Details 
screen to add additional information to a selected service template.
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To select a connection type:

1. Tap the service you want to use in the Network Preferences screen.

2. Tap the Details button to open the Details screen.

3. Tap the Connection type pick list and select one of the following connection types:

Note: If you are not sure, try PPP; if that doesn’t work, ask your Internet 
Service Provider or your System Administrator for the correct 
connection type.

Idle Timeout
The Idle Timeout setting defines how long your SPT 1700 terminal waits before dropping 
the connection with your ISP or dial-in server when you switch out of a TCP/IP application.

To set the Idle Timeout:

1. Tap the Idle Timeout pick list and select one of the following options:

PPP Point-to-Point protocol

SLIP Serial Line Internet Protocol

CSLIP Compressed Serial Line Internet Protocol

Immediate Your SPT 1700 terminal drops the connection to your ISP 
immediately when you switch to another application. 

1 minute Your SPT 1700 terminal waits one minute for you to open 
another application before it drops the connection. 

Select connection type
14-21

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
2. Tap the OK button to confirm your selection and return to the Network Preferences 
screen.

Defining Primary and Secondary DNS
The Domain Naming System (DNS) is a mechanism in the Internet for translating names 
of host computers into IP addresses. When you enter a DNS number (or IP address), you 
are identifying a specific server that handles the translation services.

Each IP address has four sections, separated by periods. In the Details screen, enter each 
section separately. Each section of an IP address is made up of a number from 0 to 255; 
numbers are the only allowable characters in this field.

Note: Ask your Internet Service Provider or System Administrator for the 
correct Primary or Secondary DNS IP numbers.

Tip: Many systems do not require that you enter a DNS. If you are not sure, leave 
the DNS field blank. Note that if your ISP or dial-in server requires a DNS number 
and you did not enter that information in the Network Preferences screen, it will 
appear that you successfully logged into your network. However, when you try to 
use an application or look up information, the connection fails. If this occurs, try 
adding a DNS number. Ask your ISP or your System Administrator for the correct 
Primary and Secondary DNS IP numbers.

To enter a primary and secondary DNS:

1. Make sure the Query DNS check box is not selected.

Note: If the Query DNS check box is selected, it queries the connection 
(modem) for the saved DNS information.

2 minutes Your SPT 1700 terminal waits two minutes for you to open 
another application before it drops the connection. 

3 minutes Your SPT 1700 terminal waits three minutes for you to open 
another application before it drops the connection. 

Power Off Your SPT 1700 terminal keeps your PPP or SLIP connection 
until you power off your SPT 1700 terminal (or until it times out). 
This option works best with the PalmPilot Modem.
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2. Tap the space to the left of the first period in the Primary DNS field, then enter the 
first section of the IP address. 

Note: Each section must be a number from 0 to 255.

3. Tap the second section of the Primary DNS field, then enter the second section of 
the IP address, and so on until the sections are completed.

4. Repeat steps 2 and 3 for the Secondary DNS number.

5. Tap the OK button to confirm your selection and return to the Network Preferences 
screen.

IP Address
Everyone who logs on to the Internet needs to have a unique identifier (an IP address), 
whether permanent or temporary. Some networks dynamically assign a temporary IP 
address when clients log in. The IP Address field lets you identify whether your network 
provides automatic (dynamic) temporary IP addressing.

Note: If your IP address is permanently assigned, you will need to get that 
information from your System Administrator. If you are not sure, 
select Automatic.

To identify dynamic IP addressing, select the IP Address check box to activate this option.

Tap to have the 
IP address 
automatically 
assigned
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To enter a permanent IP address:

1. Clear the IP Address check box to disable this option and display a permanent IP 
address field below the check box.

2. Tap the space to the left of the first period then enter the first section of the IP 
address. 

Note: Each section must be a number from 0 to 255.

3. Tap and enter the remaining sections of the IP address.

4. Tap the OK button to confirm your selection and return to the Network Preferences 
screen.

Creating a Login Script
A login script is a series of commands, similar to an autoexec.bat file, that automates 
logging into your ISP. You can create login script files by selecting commands from the 
Command pick list in the Login Script screen. Some of these commands, such as Send, 
require you to supply additional information and have a parameter field for the necessary 
data.

Note: You can also use non-ASCII and literal characters in your login 
script. Refer to Appendix B, Non-ASCII Characters for Login Scripts 
for additional information.

Enter the IP address here
14-24

Download from Www.Somanuals.com. All Manuals Search And Download.



Applications: Preferences
To create a login script:

1. Tap the Script button in the Details screen to open the Login Script screen.

2. Tap the End pick list to open the Command list.

3. Tap the command(s) you want from the Command list.

4. If the command requires additional information, a field displays to the right of it for 
you to enter the information. The following commands are available:

Wait For Tells your SPT 1700 terminal to wait for specific characters from the 
TCP/IP server before executing the next command.

Wait For 
Prompt

Tells your SPT 1700 terminal to wait for a prompt before executing the 
next command.

Send Transmits specific characters to the TCP/IP server to which you are 
connecting.

Send CR Transmits a carriage return or LF character to the TCP/IP server to 
which you are connecting.

Send User ID Transmits the User ID information entered in the User ID field of the 
Network Preferences screen.

Send 
Password

Transmits the Password entered in the Password field of the Network 
Preferences screen. If you did not enter a password in the Password 
field, this command prompts you to enter one. The Password 
command is usually followed by a Send CR command.

Delay Tells your SPT 1700 terminal to wait a specific number of seconds 
before executing the next command in the login script.
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5. Repeat steps 2 and 3 until the login script is complete.

6. Tap OK to confirm your selection and return to the Details screen.

Deleting a Service Template
To delete a service template:

1. Tap the Service pick list in the Network Preference screen to open a list of available 
service templates.

2. Tap the service you want to delete.

3. Tap the  icon to open the menus for the Network Preferences screen.

4. Tap Delete from the Service menu to display the Delete Service alert.

5. Tap the OK button to confirm that you want to delete the service template.

Get IP Reads an IP address and uses it as the IP address for your SPT 1700 
terminal. This command is used with SLIP connections.

Prompt Opens a screen and prompts you to enter text of some kind (for 
example, a password or a security code).

End Identifies the last line in the login script.
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Network Preferences Menu Commands

The Network Preferences screen includes menu commands to make it fast and easy to 
create and edit service templates. This section explains the menu commands that are 
specific to the SPT TCP/IP application.

Refer to Using Menus on page 3-20 for information about menu commands that are 
common to all of your SPT 1700 terminal applications.

Service Menu
When you select the Service menu, its commands display on screen.

Options Menu
When you select the Options menu, its command displays on screen:

New Creates a new (empty) service template and adds it to the 
Service pick list.

Delete Deletes a selected service template from the Service pick list.

Duplicate Copies the selected service template and adds it to the Service 
pick list.

View Log Displays the Network Log screen.
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TCP/IP Troubleshooting
If you are having a problem establishing a network connection using the Desktop TCP/IP, 
check this section and try the suggestions listed.

Displaying Expanded Service Connection Progress Messages
It’s helpful to identify at what point in the login procedure the connection fails. An easy way 
to do this is to display the expanded Service Connection Progress messages, which 
describe the current stage of the login procedure. 

To display the expanded Service Connection Progress messages:

1. From the Network Preferences screen, tap Connect.

2. During login, press the lower half of the scroll button to display the messages.

Viewing the Network Log
If viewing the expanded Service Connection Progress messages does not give you enough 
information to find out why you cannot connect to your ISP or dial-in server, look at the 
Network Log. The Network Log lists all communication that occurs between your modem 
and your dial-in server during the login procedure. The information in the Network Log can 
help your ISP or your System Administrator pinpoint where the login procedure 
communication fails and why.

To view the Network Log:

1. From the Network Preferences screen, tap View Log from the Options menu to 
display the Network Log screen.

2. Tap the up and down arrows of the scroll bar to see the entire Network Log.

3. After you finish, tap the Done button to return to the Network Preferences screen.

Owner Preferences

The Owner Preferences screen enables you to record a name, company name, phone 
number or any other information that you want associated with your SPT 1700 terminal.

If you use the Security application to turn off and lock your SPT 1700 terminal with a 
password, information that you put in the Owner Preferences displays the next time you 
turn on your SPT 1700 terminal. Refer to Chapter 15, Applications: Security for more 
information.
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To personalize your SPT1700 terminal:

1. Tap the Applications icon, followed by the Prefs icon.

2. Select Owner from the Preferences pick list.

Enter the text that you want to associate with your SPT 1700 terminal in the Owner 
Preferences screen. If you enter more text than will fit on one screen, a scroll bar 
automatically displays on the right side of the screen.

If you assign a Password (with the Security application), the information in the Owner 
Preferences screen “locks” and cannot be changed. In this case, an Unlock button displays 
at the bottom of the screen. 

To unlock the Owner Preferences screen:

1. Tap the Unlock button in the Owner Preferences screen. The Unlock Message 
screen displays.

2. Enter the password that you defined in the Security application, and tap the OK 
button.

ShortCuts Preferences

The ShortCuts Preferences screen enables you to define abbreviations for entering text 
with Graffiti. This section describes how to create, edit and delete a shortcut. For details on 
the use of ShortCuts, refer to the Graffiti ShortCuts on page 3-16.

Creating a ShortCut
You can create a ShortCut for any words, letters or numbers. All ShortCuts you create 
display on the list in the ShortCut Preferences screen. All the ShortCuts are available in any 
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of your SPT 1700 terminal applications and are backed up on your computer when you 
perform a HotSync operation.

To create a ShortCut:

1. In the General Preferences screen tap, tap Shortcuts in the pick list and tap New 
to open the ShortCut Entry screen.

2. On the ShortCut name line, enter the letters you want to use to activate the 
ShortCut.

3. Tap the ShortCut Text area and enter the text that you want to appear when you 
write the ShortCut characters.

Tip: You may want to add a space (space character) after the last word in your 
ShortCut text. This way, a space automatically follows the ShortCut text.

4. Tap the OK button to close the ShortCut Entry screen and define your ShortCut.

Tip: To use a ShortCut, draw the ShortCut stroke followed by the ShortCut 
characters. When you draw the ShortCut stroke, the ShortCut symbol appears at 
the insertion point to show that you are in ShortCut mode.

ShortCut    

Tap New
14-30

Download from Www.Somanuals.com. All Manuals Search And Download.



Applications: Preferences
Editing a ShortCut
After you create a ShortCut, you can modify it at any time.

To edit a ShortCut:

1. Tap the ShortCut you want to edit in the ShortCuts Preferences screen.

2. Tap the Edit button to display the ShortCut Name and ShortCut text in the ShortCut 
Entry screen.

3. Make the changes you want and tap the OK button.

Deleting a ShortCut
If you no longer need a ShortCut, you can delete it from the list of ShortCuts.

To delete a ShortCut:

1. Tap the ShortCut you want to delete in the ShortCuts Preferences screen.

2. Tap the Delete button to display an alert screen.

3. Tap the Yes button to confirm that you want to delete the ShortCut.
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Applications: Security
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Introduction

Your SPT 1700 terminal comes with a Security application so that unauthorized users 
cannot view the entries you wish to protect. 

With the Security application you can:

• Hide record entries you mark as “Private.” You can hide private entries with or 
without a password. Without a password, private entries are hidden until you set 
the Security application to show them. With a password, you must enter the 
password to view the private entries.

• Turn off and lock your SPT 1700 terminal so that it does not operate until you enter 
the correct password.

To open the Security application:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to display the Security screen.

Assigning a Password

You can assign a password to protect your private entries and to lock your SPT 1700 
terminal.

To assign a password:

1. Select the Security icon, then tap the Password box to open the Password screen.

2. Enter the password that you want for your SPT 1700 terminal. 

3. Tap the OK button to open a confirmation screen. 

Tap here
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4. Enter the same password a second time, and tap the OK button to assign that 
password to your SPT 1700 terminal.

Hiding Private Entries

You can hide the entries that you mark as private. When hidden, they are not visible 
anywhere in the list. If you assign a password, you must enter it to show entries you mark 
as private. Note that your SPT 1700 terminal merely hides the entries; it does not delete 
them.

To hide Private entries:

1. Select Hide Records from the Current Privacy pick list. The Hide Records screen 
displays:

2. Tap Hide to hide entries you mark Private and to close the Hide Records screen. 

Showing Private Entries

After you hide Private entries, you can use the Security application to display them again.

Tap here 
and select 
Hide 
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To show Private entries:

1. Select Hide Records from the Current Privacy pick list. If you did not assign a 
password, your Private entries should be visible. If you assigned a password, the 
Show Private Records screen displays:

2. Enter your password. 

3. Tap the Show box to close the Show Private Records screen and display Private 
entries in your SPT 1700 terminal applications.

Masking Private Entries

When a private record is masked, a visual placeholder appears where a record would 
normally be displayed.

To mask private entries:

1. Ensure that the record or records you want to mask are defined as Private. To 
make a record private, select the record, tap Edit, Details, and then Private.

2. Select the Security icon.

3. Tap Mask Records from the Current Privacy pick list.

Return to the application. Messages marked as Private are masked with a gray bar.
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Locking Your SPT 1700 Terminal

You can also lock your SPT 1700 terminal, so that you need to enter your password to 
operate it.

Important: If you lock your SPT 1700 terminal as described in the following procedure, you 
need to enter the exact password to re-activate your SPT 1700 terminal. If you forget the 
password, you must perform a hard reset to resume using your SPT 1700 terminal. Using 
the reset button deletes all the entries in your SPT 1700 terminal; however, you can restore 
all synchronized data at the next HotSync operation. For information about how to use the 
reset button, Performing a Hard Reset on page 21-5.

To lock your SPT 1700 terminal with a password:

1. Use the HotSync application to synchronize the data between your SPT 1700 
terminal and your computer. Refer to Chapter 9, Applications: HotSync® for 
information about how to use the HotSync application.

2. Assign a password as described in Assigning a Password on page 15-3.

3. Tap the Lock & Turn Off button in the Security screen to open the System Lockout 
screen.

4. Tap the Off & Lock button to turn off the power for your SPT 1700 terminal.

5. Start your SPT 1700 terminal and enter the password. 

Tap here
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Changing or Deleting a Password

Once you define a password for your SPT 1700 terminal, you can change or delete it at any 
time. You must enter the current password before you can change or delete it.

To change or delete your password:

1. Tap the Assigned box in the Security screen to open the Password screen.

2. Enter the current password. 

3. Tap the OK button to open a screen that prompts you for a new password.

4. To change the password, enter the new password and tap the OK button. To delete 
the password, tap the Delete button.

Tap here
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Recovering from a Lost Password

If the Off & Lock option is not active and you forget or lose your password, you can delete 
the password from your SPT 1700 terminal. Deleting a lost password also deletes all 
entries and files marked as Private.

Important: If you synchronize with your computer before deleting a lost password, your 
SPT 1700 terminal restores your private entries the next time you perform a HotSync 
operation, but it does not restore the password.

To delete a lost password:

1. Tap the Lost Password button in the Security screen to open the Delete Password 
dialog.

2. Tap the Yes button to delete the password, as well as all records and entries 
marked “Private.”
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Introduction

The To Do List is a convenient place to create reminders and prioritize the activities that 
you have to do.

With the To Do List, you can:

• Make a quick and convenient list of things to do.

• Assign a priority level to each task.

• Assign a due date for any or all of your To Do items. 

• Assign a category for any, or all of your To Do items. You can then view your To Do 
List based on category (Business, Personal, etc.).

• Sort your To Do items by due date, priority level or category.

• Attach notes to individual To Do items for a description or clarification of the task.

Opening the To Do List

Press the To Do List button on the front panel of the SPT 1700 terminal to display the To 
Do List screen.

Tip: Press the To Do List button repeatedly to cycle through the categories in which 
you have items.

To Do List button
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Working With To Do Items

A To Do item is a reminder of some task that you have to complete. Your SPT 1700 terminal 
gives you control over the appearance, level of detail and the sort order of To Do items.

To create a To Do item:

1. Tap the New button in the To Do List screen.

2. Enter the text you want to appear in the To Do item. The text can be longer than 
one line.

Note: If a To Do item is not currently selected, writing in the Graffiti writing 
area automatically creates a new To Do item.

3. Tap anywhere on the screen to de-select the To Do item.

Note: You can add a name, address, and phone number to a To Do List 
item using the Phone Lookup option. Refer to Using Phone Lookup 
on page 4-4 for details.

Setting Priority (Optional)
Priority settings for To Do items enable you to arrange the tasks in your To Do List according 
to relative levels of importance. The default setting for the To Do List arranges To Do items 
by priority and due date, with priority 1 items at the top. If you have a number of To Do items 
in your list, changing an item’s priority setting may move its position in the list. 

Tap New

New To 
Do item
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Note: When you create a new To Do item, its Priority is automatically set 
to level “1,” the highest (most important) level. However, if you select 
a To Do item first, the new item displays beneath the selected item 
with the same priority as the selected item. 

To set a Priority level for a To Do item:

1. Tap the Priority number on the left side of the To Do item to open the Priority pick 
list. (Refer to To Do Show Options on page 16-8 if priority numbers are not visible.)

2. Tap the Priority number that you want to set for the To Do item (1 is most important 
and 5 is least important).

Note: You can also change the Priority setting for a To Do item with the To 
Do Details screen described later in this chapter.

Checking Off a To Do Item
The To Do List makes it easy to mark tasks as you complete them. You can set the To Do 
List to record the date that you complete the To Do item and you can choose to show or 
hide complete To Do items. Refer to To Do Show Options on page 16-8.

To check off a To Do List item:

1. In the To Do List, select an entry and tap the Show button. 

2. In the To Do Preferences screen, tap Show Completed Items. 

Tap to 
select 
priority

Tap here
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Note: If you clear this setting, your To Do items disappear from the list 
when you complete (check) them. These items have not been 
deleted, and still reside in the memory of your SPT 1700 terminal. 
You must purge completed items to remove them from memory. 
Refer to To Do Show Options on page -8 for details.

3. Tap the check box on the left side of the item.

To Do Item Details
The To Do Item Details screen enables you to change individual To Do item settings. 

To activate the To Do Item Details screen:

1. Tap anywhere on the text of a To Do item in the To Do List screen.

2. Tap the Details button to open the To Do Item Details screen.

The following sections describe the features and settings that are available in the To Do 
Item Details screen.

Completed To 
Do item
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Choosing a To Do Category
Categories can help you file individual To Do items into groups for easy review. You can 
assign and edit categories using the Categories pick list in the Details screen (refer to Using 
Categories on page 3-24 for a complete description of categories). 

Setting a Due Date
You can associate a due date with any To Do List item. You can also sort the items that 
display in the list based on their due date.

To set a Due Date for a To Do List Item:

1. Tap the “No Date” text in the Details screen to open the Due Date pick list.

2. Tap the Due Date pick list to view potential due dates for the To Do item. The 
following are available:

3. Tap the OK button to confirm your selection and close the To Do Details screen.

Note: If you turn on the Show Due Dates option in the To Do Show options 
screen, you can tap directly on the due date in the To Do List to open 
the pick list shown in step 2. 

Today Assigns the current date.

Tomorrow Assigns tomorrow’s date.

One week later Assigns the date exactly one week from the current date.

No Date Removes the due date from the To Do item.

Choose date Opens the Due Date screen where you can chose any due date 
that you want for the To Do item.

Tap here to view
the Due Date pick list
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Marking a To Do Item Private
An item on your To Do List can be marked as Private by tapping the Private checkbox. Note 
it can only be Private if Security is turned on.

Deleting a To Do Item
There are three ways to delete a To Do item: simply delete the text of the To Do item, use 
the Menu Command (as described in Record Menu on page 16-10), or use the To Do 
Details screen.

To delete a To Do item with the To Do Details screen:

1. Tap anywhere in the text area of the To Do item that you want to delete.

2. Tap the Details button to open the To Do Item Details screen.

3. Tap the Delete button to open the Delete To Do alert screen.

4. Tap the OK button to confirm that you want to delete the To Do item.

To Do Show Options
The Show Options screen enables you to control the appearance of the To Do List 
application.

To change the Show Options settings:

1. Tap the Show button in the To Do List screen to open the To Do Preferences 
screen.
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2. Select any of the following settings:

3. Tap the OK button to confirm your selections and close the screen.

Sort by Enables you to sort the To Do items in one of the following ways: 
• Priority, Due Date

• Due Date, Priority

• Category, Priority

• Category, Due Date

Show 
Completed 
Items

Displays your complete To Do items in the To Do List. If you turn off 
this setting, your To Do items disappear from the list when you 
complete (check) them. They will remain in memory until they are 
Purged (refer to Record Menu on page 16-10 for more information 
about purging).

Show Only Due 
Items

Shows only the To Do items that are currently due, past due or have 
no due date specified in the To Do List. When this setting is active, 
To Do items that are not yet due do not display.

Record 
Completion 
Date

Replaces the due date with the actual completion date (when you 
checked the item). If you do not assign a due date to an item, the 
completion date still records when you complete the item.

Show Due Dates Displays the due dates associated with To Do items in the To Do List 
screen, and displays an exclamation mark next to incomplete To Do 
items after the due date passes.

Show Priorities Shows the priority numbers for the To Do items in the To Do List 
screen.

Show 
Categories

Shows the category for each To Do item on the far right of the To Do 
List screen.
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To Do List Menu Commands

The To Do List includes menu commands to perform common file and editing tasks. Refer 
to Using Menus on page 3-20 for information about menu commands that are common to 
all SPT 1700 terminal applications.

Record Menu
When you select the Record menu, its commands display on screen.

Delete Item Opens an alert screen, prompting you to confirm that you want to delete 
the current To Do item. You must select a To Do item before you can 
delete it. Tap the OK button to delete the To Do item from your SPT 
1700 terminal, or tap the Cancel button to close the alert screen and 
keep the To Do item.

Note: By default your SPT 1700 terminal removes the item from the To 
Do list, but retains a copy of the item and transfers it to an archive file 
on your computer the next time you perform a HotSync operation. To 
remove the event completely, clear the Save archive copy on PC check 
box.

Attach Note Opens the To Do Note screen where you can create a note for the 
current To Do item.

Delete Note Opens an alert screen, prompting you to confirm that you really want to 
delete the note attached to the To Do item. You must select a To Do item 
before you can delete its note. Tap the Yes button to delete the Note 
from the memory of your SPT 1700 terminal, or tap the No button to 
close the alert screen and return to the To Do List.
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Options Menu
When you select the Options menu, its commands displays on screen.

Purge Deletes To Do items that you mark (check) as complete. All complete 
To Do List items remain in the To Do List until you use this command. 
The default setting is “Save archive copy on PC.” This removes 
complete To Do items from the To Do List, but retains copies and 
transfers them to an archive file on your computer the next time you 
perform a HotSync operation.

Beam Item Beams the current To Do item to another SPT 1700 terminal through 
the IR port.

Beam Category Beams all To Do Items in the current category to another SPT 1700 
terminal through the IR port. 

Font Displays the Select Font screen where you can choose a different font 
(text) style for your Address Book entries. Refer to Choosing Fonts on 
page 3-23 for details. 

Phone Lookup Activates the Phone Lookup feature, which is described in Using 
Phone Lookup on page 4-4.

Security Allows you to change the Security on a To Do List item. You can hide, 
show, or mask an item. Refer to Chapter 15, Applications: Security for 
details.

About To Do 
List

Shows version (revision) information for the To Do List application. 
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Introduction

The SPT 1700 has an integrated scanner which allows you to collect data by scanning bar 
codes, provided you have a scanning application loaded on your terminal. The laser is 
emitted from the top of the unit. 

Scanning with the SPT 1700

Included on the Symbol Palm Terminal Utility CD are two demonstration programs: SScan 
and Demo Scan. These programs are designed to assist the applications developer in 
writing an application for the scanner. Source code for these programs is located in the 
Samples subdirectory of the Scanner SDK directory, and the prc files are located in the prc 
subdirectory of the Scanner SDK directory. If your terminal does not contain these 
demonstration programs, contact your distributor. 

To add SScan.prc or ScanDemo.prc to the SPT 1700, use the SPT Install Tool to designate 
the files to be added to the SPT 1700 during the next HotSync.

SScan Application

The SScan application is a basic scanning application. To scan bar codes with the SPT 
1700 using SScan:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open SScan.

3. Aim the terminal at the bar code. 

4. Tap the Scan button, or use the left or right trigger to activate the scan beam.

The scan LED lights and the laser beam is emitted from the top of the terminal. Make sure 
the beam covers the entire bar code. A successful decode is indicated by a green LED and 
a beep. The bar code data is displayed on the screen. In the Bar Type field, the type of 
symbology (e.g., Code 39) is displayed. In the Bar Data field, the actual collected bar code 
data displays.

SScan Menu Commands
Tap the  icon to display the available menu. 
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Options Menu
When you select the Options menu, its commands display on screen:

Demo Scan Application

The Demo Scan application allows you to customize your scanner’s features and scan bar 
codes. 

To open the Demo Scan application:

1. Tap the  icon to open the Applications Launcher.

2. Tap the  icon to open Demo Scan.

The Symbol Scanner Demo screen displays:

Reset Defaults Allows you to reset the default values.

About Provides version information.
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Available Symbologies Allows you to select the symbologies to be 
recognized by the scanner by tapping on the 
box next to the name of the desired 
symbology. When selected, the box has a 
check mark.

Scan Enable When this option is clicked, and the trigger is 
pressed, the laser scanner beam activates. 
The beam remains on for approximately 3 
seconds. Alternatively, tapping on the Scan 
button on the bottom of the screen performs 
the same action.

LED When this box is checked, the green LED 
lights. This serves as a test of the LED. To 
stop the LED test, tap the LED box again.

Trigger Mode Level: only the SPT 1700 scan trigger initiates 
the scan; the laser is turned off when the 
trigger is released or the decode was 
successful.

Pulse: only the SPT 1700 scan trigger initiates 
the scan; the laser is turned off when 
laser_on_time is reached or when the decode 
was successful.

Host (default): The SPT 1700 scan trigger or 
the application’s ScanCmdStartDecode 
command initiates the scan; the laser is 
turned off when the trigger is released, or 
when laser_on_time is reached, the 
ScanCmdStopDecode command is called, or 
the decode was successful.

Bar Type Once a bar code is decoded, displays the type 
of the decoded bar codes (i.e., Code 39, Code 
128, Code 93, etc.)

Bar Data Once a bar code is decoded, displays the 
decoded data.
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Demo Scan Menu Options
Tap the  icon to display the available menus. 

Setup Menu
When you select the Setup menu, its commands display on screen: 

Beep Menu
This menu option allows you to customize the Frequency, Duration and Pattern of the 
scanner’s beep.

Hardware Setting

Beep on Good 
Decode 

Determines if the terminal beeps to indicate a successful decode.

Redundancy Determines if the scanner uses redundancy.

Linear Security Defines the linear security level to be used by the scanner; level 1, 2, 
3, or 4.

Scan Angle Defines the scan angle to be used by the scanner; narrow or wide.

Decode LED On 
Time

Defines the length of time (in seconds) the decode LED remains on 
when a symbol is decoded.

Laser On Time Defines the length of time (in seconds) the laser beam remains on 
when the trigger is pressed.

Aim Duration Defines the length of time the laser pointer beam remains on when the 
trigger is pressed or the scan button is tapped.

Code Setting

Code ID Char Defines the CodeID Character. The options are None, AIM and 
Symbol.

Tx Format Defines the data transmission format.

Prefix/Suffix Defines the Prefix and Suffix values.
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Options Menu
When you select the Options menu, its commands display on screen: 

Scanning 1-D Bar Codes Using Demo Scan
To scan 1-D bar codes: 

1. Tap the  icon to open Demo Scan.

2. Customize your scanner’s features by selecting from the various options described 
previously. 

3. Aim the scanner at the bar code.

4. Press either the right, left or center scan trigger or tap the Scan Button. Make sure 
the red scan beam covers the entire bar code. The green scan LED lights and a 
beep sounds to indicate a successful decode.

Barcode Application
The Barcode application is a basic receiving application, which demonstrates the terminal’s 
scanning and signature capture capabilities. To use Barcode: 

1. Select the Barcode icon  from your main application screen.

Reset Defaults Allows you to reset the default values.

About Provides version information.
17-7

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
The Receiving Demo Screen displays:

To submit the collected data, tap the Submit option. When the submission is 
complete, the fields clear and you can continue collecting data.

Scanning 2-Dimensional Bar Codes
Some models of the SPT 1700 perform 2-Dimensional bar code scanning. To scan a 2-
dimensional PDF417 bar code:

1. Aim the scanner at the PDF bar code and press the trigger. 

2. Hold the trigger down and keep the scan line parallel to the rows of the symbol.

3. Manually raster the scan line by slowly moving the scanner up and down so it 
scans the entire bar code at a rate of one inch per second. 

Item Code Contains the data for an item code once it is 
scanned. A one or two-dimensional bar code 
can be scanned to fill this field.

Quantity This drop-down menu allows you to select the 
appropriate quantity.

Location Contains the location data for a location bar 
code once it is scanned. You can also use 
Graffiti to enter the location data in this field. 
Only one-dimensional bar codes can be used 
to fill this field.

Please Sign Here Sign your name here using the stylus. 
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When PDF Decode Feedback is enabled, a clicking noise lets you know the bar code is 
being decoded. If this parameter is enabled but there’s no clicking noise when you’re 
scanning the bar code, it’s not being scanned properly. 

To improve PDF decoding:

• Check that PDF417 scanning is enabled.

• Make sure the scan line extends at least 1/2” past the left and right edges of the 
bar code.

• Hold the scanner closer for denser symbols, farther away for larger symbols.

• Make sure you scan the top and bottom rows of the symbol.

• Be patient - it may take several attempts to decode the symbol.

The bar code has been completely decoded when you hear a tone, followed by a short, high 
tone beep. The green LED stays lit for two seconds or until the next trigger pull.

Scanning Problems

If the bar code is not being decoded, check the following:

• Make sure the bar code label is not defaced.

• Make sure the bar code is of a symbology which can be read by the scanner.

• Check that the scanner window is not dirty. If it is, gently clean it using a tissue or 
other non-abrasive material. Do not spray any cleaner directly on the scanner 
window.

• Try another bar code. It is possible that your bar code is bad.

• Check your application code.

• Make sure the parameters are set correctly for the bar code being scanned; i.e., 
lengths, symbology, etc.

If you do not hear a beep after a good decode, check that the system sound option is set 
in the general preferences screen, and that Beep on Good Decode is set in the hardware 
setup. Refer to Demo Scan Menu Options on page 17-6 for details.

1/2” 1/2”

Scan Line
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If you have checked all of these things and are still experiencing problems decoding your 
bar codes, please contact Symbol Technologies Technical Support Center. Refer to Symbol 
Support Centers on page -xix for contact information.

Battery Implications While Using the Laser Scanner
If your battery becomes low while the scanning application is active, the scanning 
application deactivates and you receive the message, “Battery Low Error”. The remaining 
desktop applications continue to work until you receive further low battery warnings. You 
should perform a HotSync at this point to avoid data loss. If you attempt to scan when your 
battery is low, you receive the message, “Your battery level is too low for scanning”. 
Recharge the battery and attempt scanning again. 
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Introduction

GsmDemo allows you to explore what features GSM and the SPT 1734 terminal offer you, 
including sending and receiving SMS messages.

Using GsmDemo

The first step in using GsmDemo is to configure the SPT 1734 terminal to work with a 
network.

To start GsmDemo:

1. Tap the  icon, then the  icon. 

GsmDemo opens the internal serial port to the GSM modem and attempts to 
register with a network.The following screen displays:

Status There are three possibilities: Not registered, 
Registered, and Registration failed. 

Register Tap to register with the network now.

De-register Tap to end your network session.

PIN Used for security reasons. If your SIM card 
has this pin enabled, enter your pin number 
here. 
Remember PIN checkbox: Tap and your PIN 
number will be remembered and will be used 
every time the modem is registered.
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On Exit When exiting GsmDemo, you can:
Leave modem registered: Check this box if 
you are going to use the 1734 terminal’s 
HotSync feature. Refer to Configuring a GSM 
WAN Connection (SPT 1734 Only) on page 2-
25 and Performing a GSM HotSync on page 
9-21 for additional details.
Monitor text messages: GsmDemo will 
notify you with a pop-up screen if you’ve 
received any SMS text messages.

Note: this feature is only enabled when you 
have exited the GsmDemo application.

Network Displays the network you are registered with 
(i.e., UK Vodaphone).

Signal Displays signal strength.
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Working with Text Messages
GsmDemo allows you to send, receive, and view text messages with your SPT 1734 
terminal.

Read SMS
To read your SMS messages:

1. Tap the main pick list and select Read SMS. The following screen displays:

2. Select a message from the list and tap the Read button to read a message.

3. Tap the OK button when you are done.

4. Select a message from the list and tap the Reply button to open the Send SMS 
screen and reply to the message.

5. Tap the Delete button to delete a message. 

Displays the message text

Unread

Displays the sender’s
phone number
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Send SMS
To send an SMS message:

1. Tap the main pick list and select Send SMS. The following screen displays:

2. Enter the Phone number of the message recipient and the message. 

3. If you do not know the phone number, tap the Phone book button to access the SPT 
1734 terminal’s Address Book. The following screen displays:

Note: The Phone Book only displays items with a last name and a mobile 
phone number.

4. Tap Look Up to search for a phone number.

To find a phone number more quickly, enter the first letter of the name you want to 
find in the Look Up line at the bottom of the screen. The list scrolls to the first name 
that starts with that letter. You can continue to add letters to narrow your search.

5. Tap the Paste button to insert the phone number into the message on the Send 
SMS screen.

Tap to access 
the terminal’s 
phone book

Tap here to look up a
phone number
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6. Tap the Send button to send the message.A successful message screen displays: 

Data Call
The Data Call feature is used to test and ensure that the modem can send and receive calls. 

Note: You must use the Graffiti writing area when entering information in 
the Data Call screen.

To test the modem:

1. Select Data call from the main pick list. The Data Call screen displays:

Clear screen Clears any entered commands from the screen.

Dial Calls another terminal or modem.

Hangup Disconnects the session.

Action Possible actions include Idle, Connected, 
Hanging up, Hangup failed, or Hung up.

The current activity
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2. Tap the Dial button and the Enter Number screen displays:

3. Tap the Phone Book button to select a number from the SPT 1734 terminal’s phone 
book, or enter the number and tap the Dial button.

Note: The Phone Book only displays items with a last name and a main 
number for the Data Call screen.

Information
The information screen allows you to browse and switch to other networks, and also 
provides diagnostic information about your modem type and driver version.

To view the Information screen:

1. Select Information from the main pick list. The Information screen displays:
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2. Tap the Browse button to browse available networks. The following warning 
displays:

Note: If your modem is not registered you will not be able to browse 
available networks.

3. Tap the Yes button to browse. The following screen displays while the terminal 
searches for available networks:

4. The list of available networks displays. 
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5. Select the network you want to switch to and tap the Switch To button. If the 
network you attempt to switch to is forbidden, the following error displays:

The Diagnostic information displays modem driver version, manufacturer, model, 
revision, and serial number, depending upon the modem’s registration status. 
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GsmDemo Menu Commands

This section explains the menu commands specific to GsmDemo that make it fast and easy 
to perform tasks.

Options Menu
The Options menu can be selected from all screens. When you select Options, its 
commands display on the screen.

1. You may need to change the service centre phone number if it is missing, its phone 
number has changed, or you wish to choose an alternate service center.

2. Tap Set Service Centre. The following screen appears: 

Note: If your modem is not registered you will receive a “Modem not 
registered” error and will be unable to proceed.

3. Enter the new Service Centre Number and click OK.

Set Service Centre Tap to enter the Service Center phone number.
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Help Menu
The Help menu can be selected from all screens. When you select Help, its commands 
display on the screen.

GsmDemo help Opens the GsmDemo help screens.

About Provides version information for GsmDemo.
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Installing and Removing Applications
Introduction

This chapter explains how to install and remove applications on your SPT 1700 terminal 
and how to remove the Symbol Palm Terminal Desktop software from your computer.

Installing Applications

Your SPT 1700 terminal comes with the Date Book, Address Book, To Do List, Memo Pad, 
Expense, Calculator and Mail applications installed and ready to use. 

You can also install additional applications on your SPT 1700 terminal. The SPT Install Tool 
makes it quick and easy to install software on your SPT 1700 terminal during a HotSync 
operation. 

Note: Any game or application that you install on your SPT 1700 terminal 
resides in RAM memory. A hard reset on the SPT 1700 terminal 
automatically deletes these applications; you can also delete them 
manually.

To install software on your SPT 1700 terminal:

1. Copy the application you want to install into the Add-on subfolder in your SPT 
folder on your computer.

Note: If you prefer to copy the application into another folder, navigate to 
that folder before you complete step 5.
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2. Double-click the Symbol Palm Terminal Desktop icon on your Windows desktop (or 
select Symbol Palm Terminal Desktop from the Start menu) to open the Symbol 
Palm Terminal Desktop software.

3. Click the Install button to open the SPT Install Tool screen.
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Tip: You can also access the Install Tool dialog by selecting Install Tool from the 
Symbol Palm Terminal Desktop program group or by double-clicking any file with 
a prc file extension.

4. Select the user name that corresponds to your SPT 1700 terminal in the User drop-
down list.

5. Click the Add button to open the Open dialog. 

6. Click the application(s) that you want to install on your SPT 1700 terminal.

7. Click the Open button to return to the Install Tool dialog.
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Note: Review the list of applications you selected in the Install Tool dialog. 
If you do not want to install an application, click it, then click the 
Remove button. (This does not remove the application from your 
computer, it simply removes it from the list of applications to install.)

8. Perform a local HotSync operation to install the application(s) you selected. Refer 
to Conducting a Local HotSync Operation on page 9-9 for details. 

Installing Games

The CD-ROM that comes with your SPT 1700 terminal includes several games that you can 
install with the SPT Install Tool. These games include:

• HardBall

• Puzzle

• Giraffe

• MineHunt

• SubHunt.

Note: Giraffe is a fun, easy way for you to practice writing Graffiti.

After you install and start a game, the instructions display in the Game menu. Depending 
on the game, the Game menu may also contain commands to show high scores, to start a 
new game or to set Preferences for the game.
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Removing Applications

If you run out of memory or decide that you no longer need an application you installed, you 
can remove applications from your SPT 1700 terminal. You can remove only add-on 
applications, patches and extensions that you install; you cannot remove the applications 
that reside in the ROM portion of your SPT 1700 terminal, including Date Book, Address 
Book, To Do List, Memo Pad, Expense, Calculator and Mail applications.

To remove an add-on application:

1. Tap the  icon on the SPT 1700 terminal screen to open the Applications 
Launcher.

2. Tap the  icon on the SPT 1700 terminal screen to open the Applications 
Launcher menus.

3. Tap Delete from the App menu to open the Delete screen.

4. Tap the application that you want to remove.

5. Tap the Delete button to display a confirmation message.

Note: If you change your mind and do not want to delete an application, do 
not select an application and tap Done.

6. Tap the Yes button to indicate that you want to remove the application from your 
SPT 1700 terminal.

7. Tap the Done button to close the Delete screen and return to the Applications 
Launcher.
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Removing the Symbol Palm Terminal Desktop 
Software

If you no longer want to use the Symbol Palm Terminal Desktop software, you can remove 
it from your computer. 

To remove the Symbol Palm Terminal Desktop software: 

1. Select Settings, then Control Panel from the Start menu to open the Windows 
Control Panel.

2. Double-click the Add/Remove Programs icon. 

3. On the Install/Uninstall tab, select Symbol Palm Terminal Desktop from the list.

4. Click the Add/Remove button.

5. Click Yes to confirm that you want to remove the application.
19-8

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 20  
Getting Help With Your SPT 1700 Terminal

Chapter Contents

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-3
Displaying Online Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-3
SPT 1700 Diagnostics Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-4

System Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-5
Bar Code Scanner Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-6
Serial Port Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-7
Digitizer Alignment Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-8
System Diagnostics Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-8

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-9
Technical Support, Service and Repair . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-15

Technical Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-15
20-1

Download from Www.Somanuals.com. All Manuals Search And Download.



SPT 1700 Series Product Reference Guide
20-2

Download from Www.Somanuals.com. All Manuals Search And Download.



Getting Help With Your SPT 1700 Terminal
Introduction

There are several ways to get help with your SPT 1700 terminal. You can display online tips 
on your SPT 1700 terminal and you can review the troubleshooting section in this chapter 
and on your Symbol Palm Terminal Desktop Software CD. If you need additional 
assistance, there are several ways to contact Symbol Technical Support. This chapter 
provides details on each of these methods.

Displaying Online Tips

Many of the screens that display on your SPT 1700 terminal contain an online tips icon in 
the upper-right corner. Online tips contain a summary of what is required by the screen, 
shortcuts for using the screen or other useful information. Online tips always relate to the 
function that you are currently performing with your SPT 1700 terminal. 

To use the online tips:

1. Tap the  icon in the upper-right corner of a screen to open the Tips screen.

2. After you review the Tips screen, tap the Done button.
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SPT 1700 Diagnostics Utility

The SPT 1700 Diagnostics Utility is used to ensure that your SPT 1700 Terminal is 
operating properly. It can also assist you in troubleshooting problems you may encounter. 
The Diagnostics Utility tests the various features of the terminal, and reports whether or not 
they are operating properly.

To run the Diagnostics Utility, run the Diag Application, which displays on your Terminal’s 
Main Application screen. The Main Diagnostics screen has five options:

• System Information

• Bar Code Scanner

• Serial Port

• Digitizer Alignment

• System Diagnostics.

Tapping any of these options displays screens of related information.
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System Information
The System Information option describes the system attributes of the terminal. Tapping this 
option displays the System Information screen.

Manufacturer The manufacturer of the terminal.

RAM Size The amount of Random Access Memory.

RAM Free/Used The amount of free and used Random Access 
Memory.

ROM Used The amount of free and used Read-Only 
Memory.

Flash ID The serial number assigned to the unit.

User The username of the terminal.

Battery The voltage level of the batteries.
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Bar Code Scanner Test
The Bar Code Scanner option tests the integrated scanner. Selecting the Bar Code 
Scanner option displays the Bar Code Scanner Diagnostics Screen.

To test the scanner:

1. Select the Scanner Enabled checkbox.

2. Page down to the second page by pressing the down button on the terminal, or by 
tapping on the arrow in the lower left corner of the screen with the stylus. 

3. To ensure that a specific type of bar code can be read, select the bar code types 
you would like to read and tap Done.
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Serial Port Test
The Serial Port option tests the terminal’s serial port by sending a test message.

To run the serial port test:

1. Place your terminal in a cradle attached to a computer.

2. Determine which communications port is used by HotSync.
Right-click on the HotSync icon in your computer’s icon tray in the lower left corner 
of the screen, and choose Setup.

3. Select the Local tab and look at the setting specified for the Serial Port. You will 
need this information in subsequent steps. 

4. Click OK to close the window.

5. Shut down HotSync manager on the computer. Right-click on the HotSync icon in 
your computer’s icon tray and select Exit.

6. On your computer, run HyperTerminal, which displays in the Accessories directory 
in the Windows Programs menu.

7. Start a new connection in HyperTerminal.

8. Set the HyperTerminal session to connect directly, and specify the communications 
port determined in Step 3. 

9. Adjust the communications parameters in HyperTerminal and on the terminal so 
they are compatible (e.g., 57,600, 8 data bits, 1 stop bits, no parity).

10. On the terminal, click the Send Msg button to send a test message string from the 
terminal to HyperTerminal on the computer. You can edit the message, and can 
also select the Continuous check box to send the test message multiple times. 

When the serial port is functioning properly, the messages sent from the terminal 
are displayed in HyperTerminal. 
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Digitizer Alignment Test
The Digitizer Alignment option tests the tracking of the stylus on the screen. To run this test, 
tap the stylus in various places on the screen and crosshairs appear under the stylus. You 
may also move the stylus continuously across the screen and the crosshairs track the 
movement of the stylus.

System Diagnostics Test
The System Diagnostics option is an interactive test of all the terminal’s system features. 
This test prompts you to perform different actions and listen for different sounds. The output 
of the system diagnostics is a log file. 

To run system diagnostics tap the Start button. You are prompted to begin. Tap OK to start 
the test. 

The test prompts you to press the different buttons on the terminal. Pressing the specified 
button results in a series of short high-pitched sounds, denoting proper functioning. 
Pressing an incorrect button or having the system timeout results in a low tone, denoting 
failure. 

The test then produces a series of four tones to test the speakers and prompts you, asking 
whether or not you heard all the tones. If you hear all four tones, answer Yes. If you don’t 
hear all the tones, answer No.

The test also prompts you to scan a bar code with the scanner. Press the OK button and 
then scan an item.

System Diagnostics also performs some tests which are not interactive. It reads the system 
information, tests the serial port, tests the memory, and tests the timer. 

A series of tones denotes the conclusion of the test. 

At this point, view the log file by tapping on View Log. This brings up the multi-page test 
results log. You can scroll through the log, one page at a time, by tapping on the arrow 
buttons in the lower left-hand corner of the screen. Alternately, use the scroll bar on the 
right-hand side of the screen.
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Troubleshooting

If you encounter a problem with your SPT 1700 terminal, look in this section for the 
description that most closely matches the symptoms you observe and try the suggestions 
listed. 

Important: For troubleshooting tips not included in this handbook, refer to either the 
README.TXT file or the Help Notes file located in the Symbol Palm Terminal Desktop 
directory. These files are also on the installation CD-ROM.

Problem Cause(s) Solution

Installation

Symbol Palm Terminal 
Desktop installation 
program incorrectly 
detects that a modem 
is attached to one of 
your serial ports.

Do not place your SPT 1700 
terminal in the cradle while 
installing the software.

Serial Cradle

LEDs do not light when 
the cradle is plugged 
in.

Cradle is not receiving power. Make sure the power supply is 
securely connected and receiving 
power.

LED does not light 
when the terminal is 
inserted.

Terminal is not seated firmly in 
the cradle. 

Replace the terminal in the cradle.

Attempt by the cradle 
to HotSync the 
terminal failed.

Terminal was removed from the 
cradle while the LED was 
blinking green.

Terminal’s battery is dead.

Active Error dialog box on 
terminal.

Replace the terminal in the cradle. 
This allows the cradle to attempt 
another HotSync.

Recharge the battery.

Error dialog box must be cleared in 
the terminal. Tap the OK button on 
the terminal’s touchscreen.
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Ethernet Cradle

The unit locks up with 
all LEDs flashing red.

The unit could not configure 
itself, or it lost its lease on one of 
its ID addresses.

Hook the unit up to an Ethernet 
network with a correctly functioning 
DHCP server and 6 available IP 
addresses.

General Issues

SPT 1700 terminal 
does not turn on.

Adjust the contrast control.
Make sure the battery is charged 
and installed properly.

Recharge the battery. If your SPT 
1700 terminal still does not 
operate, try a soft reset; refer to 
Resetting Your SPT 1700 Terminal 
on page 21-5 for details.

Low battery warning 
after recharging the 
batteries.

The battery warning message 
may display immediately after 
recharging the battery. In 
addition, if you check the battery 
gauge in the Applications 
Launcher immediately after 
recharging the battery, the gauge 
may start at “empty” and slowly 
rise to “full.” 

This is normal. It takes a few 
minutes for the battery gauge to 
accurately show the condition of 
the battery.

No sound. The System Sound option may 
not be set correctly in the 
General Preferences screen. 

If the option is set to off, there will 
be no sound. Refer to General 
Preferences on page 14-10 for 
more information.

No sound upon good 
decode.

The System Sound option may 
not be set correctly in the 
General Preferences screen. 

Verify that Beep on Good Decode 
is set (checked) in Hardware Setup 
in the Scan Demo Application. 
Refer to General Preferences on 
page 14-10 for more information.

SPT 1700 terminal 
turns itself off.

Your SPT 1700 terminal is 
designed to turn itself off after a 
period of inactivity. This period 
can be set at one minute, two 
minutes or three minutes. 

Check the “Auto-off after” setting in 
the General Preferences screen, 
and change the setting if you need 
a longer delay before the automatic 
shutoff feature activates. Refer to 
General Preferences on page 14-
10 for more information.

Problem Cause(s) Solution
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SPT 1700 terminal 
doesn’t recognize my 
handwriting.

You need to use the Graffiti 
character strokes for your SPT 
1700 terminal to recognize 
handwriting input with the stylus.

Refer to Writing Graffiti with the 
Stylus on page 3-6 for information 
about how to write Graffiti 
character strokes.

You are making the Graffiti 
character strokes in the display 
part of the screen, not on the 
Graffiti writing area.

Make the Graffiti character strokes 
in the Graffiti writing area.

You are writing the strokes for 
letters in the left-hand side, and 
the strokes for numbers in the 
right-hand side of the Graffiti 
writing area.

Write the strokes on the proper 
side of the Graffiti writing area.

Tapping the screen 
buttons or icons does 
not activate the 
corresponding feature.

The digitizer may need to be 
recalibrated. 

Recalibrate the digitizer. Choose 
Digitizer from the Preferences 
application pick list and follow the 
directions on the screen.

When I tap the  
icon, nothing happens.

Not all applications or screens 
have menus. 

Try changing to a different 
application.

A message displays 
stating that your SPT 
1700 terminal memory 
is full.

You may have too many unused 
records.

Delete unused memos and 
records. If necessary, you can save 
these records on your computer 
using the Save Backup Copy 
option that displays in the Delete 
screens.

Beamed data does not 
transmit.

The terminals may be too far 
apart.

Confirm that the SPT 1700 
terminals are 1 ft. apart or less, and 
that the path between the two 
devices is clear of obstacles.

When receiving 
beamed data an out of 
memory message 
displays.

Your SPT 1700 terminal requires 
at least twice the amount of 
memory available as the data 
you are receiving. For example, 
if you are receiving a 30K 
application, you must have at 
least 60K free.

Verify the amount of free memory 
available.

Problem Cause(s) Solution
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Applications

Tapping the Today 
button doesn’t display 
the current date.

Your SPT 1700 terminal is not 
set to the current date. 

Make sure the Set Date box in the 
General Preferences screen 
displays the current date. Refer to 
General Preferences on page 14-
10 for more information.

Entries seem to be 
missing in various 
applications.

The categories pick list is set for 
a specific category.

Check the Categories pick list 
(upper-right corner of the screen). 
Choose All to display all of the 
records for the application.

Security may have been set for 
certain records.

Check the Security application and 
make sure that the Private Records 
setting is set to Show private 
records.

HotSync Operations

A Local HotSync 
operation does not 
complete successfully.

 HotSync Manager is not 
running. 

If HotSync Manager is running, exit 
and restart it.

Make sure you selected Local from 
the HotSync Manager menu or the 
Symbol Palm Terminal Desktop 
menu.

Check the cable connection 
between the SPT 1700 terminal or 
cradle and the serial port on your 
computer.

Try a lower baud rate setting on the 
Local tab in the Setup screen.

Make sure you are not running 
another program — such as 
America On-line, CompuServe or 
WinFax — that uses the serial port 
you selected in the Setup screen.

Read the HotSync Log for the user 
account for which you are 
performing a HotSync operation.

Problem Cause(s) Solution
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A Modem HotSync 
operation does not 
complete successfully.

Your modem doesn't have an 
auto-off feature enabled.

Make sure your modem is on, and 
that it does not shut down 
automatically as part of an energy-
saving feature.

The Setup String in the Setup 
screen configures your modem 
incorrectly. Confirm that the 
Speed setting in the Setup 
screen is appropriate for your 
modem.

You may need to select a different 
Modem Type or enter a custom 
Setup String. Most modems have a 
Setup String that causes them to 
send initial connection sounds to a 
speaker. You can use these 
sounds to check the modem 
connection.

Make sure the modem connected 
to your computer is turned on and 
is connected to the outgoing phone 
line.

Make sure you selected Modem 
from the HotSync Manager menu.

Security

I forgot the password 
(SPT 1700 terminal is 
not locked).

You can use the Security 
application to delete the password. 
If you do this, your SPT 1700 
terminal deletes all entries marked 
as Private. However, you can 
perform a HotSync operation 
before you delete the password: 
the HotSync process backs up all 
entries, whether or not they are 
marked private. Refer to Changing 
or Deleting a Password on page 
15-7 for details.

 I forgot the password 
(SPT 1700 terminal is 
locked).

If you assign a password and lock 
your SPT 1700 terminal, perform a 
hard reset to continue using your 
SPT 1700 terminal. Refer to 
Resetting Your SPT 1700 Terminal 
on page 21-5 for details.

Problem Cause(s) Solution
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Memo Pad Tips
If you cannot manually arrange the order of the memos in the List screen, check the Memo 
Preferences setting. Make sure that Sort by is set to Manual.

If you choose to view your memos alphabetically on Symbol Palm Terminal Desktop and 
then perform a HotSync operation, the memos on your SPT 1700 terminal still appear in 
the order defined in the Memo Preferences setting. In other words, the sort settings that 
you use with Symbol Palm Terminal Desktop are not transferred to your SPT 1700 terminal.

Date Book Tips
In the Week View, you cannot select overlapping events that have the same start time. If 
you have two or more events with the same start time, choose the Day View for the 
particular day to see the overlapping events.
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Technical Support, Service and Repair

If you have a problem using your SPT 1700 terminal, make sure you have reviewed the 
following:

• The Troubleshooting section earlier in this chapter

• The README file and Help Notes located in the folder where you installed the 
Symbol Palm Terminal Desktop software on your computer (or on your installation 
CD) 

• The Symbol Palm Terminal Desktop software Online Help.

For further assistance, contact your regional technical support office by e-mail, phone or 
fax. Before requesting support, experiment a bit to reproduce and isolate the problem. 
When you do contact support, be ready to provide the following information:

• The version of Windows you are using

• The actual error message or state you are experiencing

• The steps you take to reproduce the problem.

Technical Support 

United States and Canada

Phone:1-800-659-2240
Web site:http://www.symbol.com/palm

Outside North America, contact your local Symbol representative. Refer to page xix for the 
Technical Support number in your country.
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Introduction

This chapter provides information to help you take proper care of your SPT 1700 terminal 
and prolong battery life. It also discusses how to reset your SPT 1700 terminal.

Caring for Your SPT 1700 Terminal

Your SPT 1700 terminal is designed to be reliable and to provide years of trouble-free 
service. However, you should observe the following tips when using your SPT 1700 
terminal:

• Take care not to scratch the screen of your SPT 1700. When working with your SPT 
1700, use the supplied stylus or plastic-tipped pens intended for use with a touch-
sensitive screen. Never use an actual pen, pencil or other sharp metallic object on 
the surface of the SPT 1700 screen.

• Although your SPT 1700 is water and dust resistant, it should not be exposed to 
rain or moisture for an extended period of time. In general, treat your SPT 1700 as 
you would a pocket calculator or other small electronic instrument.

• The touch-sensitive screen of your SPT 1700 contains a glass element. Take care 
not to drop your SPT 1700 or subject it to any strong impact. 

• Protect your SPT 1700 from temperature extremes. Do not leave your SPT 1700 
on the dashboard of a car on a hot day, and keep it away from heaters and other 
heat sources.

• Do not store or use your SPT 1700 in any location that is extremely dusty, damp or 
wet.

• Use a soft lens cloth to clean your SPT 1700. If the surface of the SPT 1700 screen 
becomes soiled, clean it with a soft cloth moistened with diluted isopropyl alcohol 
(rubbing alcohol).

Battery Considerations
Please note the following considerations when charging the battery in your SPT 1700 
terminal:

• Under normal conditions, your SPT 1700 terminal battery should provide 
approximately 8 hours of use before the battery requires recharge. You can 
conserve battery life by minimizing the use of the backlight feature, and selecting 
the “Auto-off after” setting that automatically turns the SPT 1700 terminal off after 
a period of inactivity (Refer to General Preferences on page 14-10).
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Note: When the scanner is in use, battery life is shorter, and depends on 
the number of scans performed per minute. 

• If the battery becomes low while using the scanner application, the scanner 
application de-activates, and you receive the message, “Battery low error”. The 
other functions still work until another low battery alert occurs. When the scanner 
de-activates, perform a HotSync synchronization to back up your data before 
charging the battery to prevent data loss. If you try to scan when your battery is low, 
you receive the message, “Your battery is too low for scanning”. When you receive 
this message, recharge your battery and attempt scanning again. 

• Similarly, if the battery becomes low in the course of normal use, an alert displays 
on the terminal screen describing the low battery condition. The message you 
receive is, “Your batteries are low. Place the handheld in a hotsync cradle to 
recharge”. If this alert displays, perform a HotSync synchronization to back up your 
data before you charge the battery. As the battery life becomes extremely low, you 
receive the message, “Your batteries are extremely low. Place the handheld in a 
hotsync cradle to recharge”. 

• If you remove the battery, the built-in backup power of your SPT 1700 terminal 
maintains memory data for a period of up to 2 minutes. Whenever you remove 
the battery, replace it with a fully charged spare battery immediately. If you 
encounter any difficulties in the course of battery replacement, reinstall the original 
battery and wait a few minutes for the backup power to recharge.

• If the battery drains to the point where your SPT 1700 terminal does not operate, it 
stores your data safely for an indefinite period of time. In this case, there is enough 
residual energy in the battery to store the data, but not enough to turn on your SPT 
1700 terminal. If your SPT 1700 terminal does not turn on when you press the red 
power button, charge the battery immediately.

• If you leave a drained battery in your SPT 1700 terminal for an extended period of 
time, you can lose all of the stored data. If this happens, replace the battery and 
use the reset button to reset your SPT 1700 terminal. (Refer to Resetting Your SPT 
1700 Terminal on page 21-5.) After you reset your SPT 1700 terminal, perform a 
HotSync operation to restore the data from your computer.

• If your battery becomes low while the terminal is still associated with a WAN, the 
terminal disconnects from the network. Recharge the battery using the cradle or 
the synchronization/charging cable, then reassociate with the network.
21-4

Download from Www.Somanuals.com. All Manuals Search And Download.



Maintaining Your SPT 1700 Terminal
Resetting Your SPT 1700 Terminal

Under normal circumstances, you will never have to use the reset button. However, on rare 
occasions your SPT 1700 terminal may “hang” (no longer respond to buttons or the 
screen). In this case, perform a reset to get your SPT 1700 terminal running again.

Performing a Soft Reset
A soft reset tells your SPT 1700 terminal to stop what it’s doing and start over again. All 
records and entries stored in your SPT 1700 terminal are retained with a soft reset. After a 
soft reset, the Palm Computing Platform Logo screen displays followed by the General 
Preferences screen. 

To perform a soft reset, remove the battery cover and use your stylus to gently press the 
reset button, which is located under the battery cover. 

Performing a Hard Reset
A hard reset tells your SPT 1700 terminal to start over again and erase all records and 
entries stored in your SPT 1700 terminal. Therefore, never perform a hard reset unless a 
soft reset does not solve your problem. 

Note: You can restore any data previously synchronized with your 
computer during the next HotSync operation.

Reset button
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To perform a hard reset:

1. Open and remove the battery cover.

2. Hold down the power button on the front of the SPT 1700 terminal.

3. While holding down the power button, use the tip of the stylus to gently press the 
reset button on the back of the terminal.

4. Release the reset button.

5. Release the power button.

6. When a message displays on the SPT 1700 terminal screen warning that you are 
about to erase all the data stored on your SPT 1700 terminal, do one of the 
following:

• Press the upper half of either of the scroll buttons on the front panel of the SPT 
1700 terminal to complete the hard reset and display the Digitizer screen.

• Press any other button to perform a soft reset.

Note: With a hard reset, the current date and time are retained. Formats 
Preferences and other settings are restored to their factory default 
settings.
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Appendix  A
Using Expense Templates 

and Custom Expense Reports

Introduction

This appendix provides illustrations of the four expense templates that come with the 
Symbol Palm Terminal Desktop software and describes how to use or modify any of these 
templates when creating expense reports with data from the Expense application. It also 
provides information about creating your own custom expense report templates for use with 
Expense. 
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Sample 1
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Sample 2
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Sample 4

Modifying and Creating Expense Templates

This section assumes that you are familiar with Microsoft Excel or a similar spreadsheet 
application. If you are not familiar with Microsoft Excel, consult your company’s Information 
Services department or an experienced user.

About Mapping Tables
Before creating or modifying an Expense template, it’s important to understand the function 
of Symbol Palm Terminal Desktop’s Expense application. In simple terms, the Expense 
application is designed to move Expense data from your SPT 1700 terminal into a Microsoft 
Excel spreadsheet.
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Each Expense item stored in your SPT 1700 terminal represents a group of related data. 
The following data can be associated with an expense item:

• Category

• Payment Currency

• Date

• Vendor

• Expense Type

• City

• Amount

• Attendees

• Payment Method

• Note.

When you perform a HotSync operation between your SPT 1700 terminal and the Symbol 
Palm Terminal Desktop on your computer, the Expense data is stored on your computer in 
the Expense.txt file. When you open the Expense application in Symbol Palm Terminal 
Desktop, an Excel macro populates an expense template with your data based on the rules 
specified in a spreadsheet file named Maptable.xls. 

The Maptable.xls file is an editable spreadsheet that functions as a “mapping table”, which 
guides the Excel macro in extracting the Expense data. The mapping table tells the Excel 
macro how large the spreadsheet is and provides the data-cell layout of the Excel template 
used for the Expense Report.

Customizing Existing Sample Templates

Four sample Expense Report templates have been provided and are stored in the 
Templates folder (which is in the same folder as the Symbol Palm Terminal Desktop 
application). 

If the layout of one (or more) of these templates is appropriate for your reporting needs, you 
can easily customize the templates with your company name and other information.

To customize a sample Expense Report template:

1. Make a backup copy of the contents of the Templates folder.

2. Open the sample template you want to modify to open it in Microsoft Excel.

3. Make the changes you require.
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Important: Do not insert rows or columns in the sample template. Doing so 
changes the way your Expense data maps to the template and causes errors. If 
you want to move the cells to a different location or add or delete rows or columns, 
make changes to the Maptable.xls file.

You can insert your own company logo without changing the Maptable.xls file. 
However, if you change the file name, you must make a corresponding change in 
the Maptable.xls file.

You can also rename cells without changing the Maptable.xls file — provided that 
the expense type corresponds to your SPT 1700 terminal data. For example, you 
can change “Snack” to “Munchies” — then all items entered on your SPT 1700 
terminal as “Snack” maps to the cell(s) labeled “Munchies.”

4. Choose Save As from the File menu and save it as a template (*.xlt) file.

5. Navigate to the Templates folder (in the Symbol Palm Terminal Desktop directory).

Note: If you do not need to change the Maptable.xls file, save the template 
file with its original file name (e.g., Sample2.xlt). If you do need to 
change the Maptable.xls file, give your modified template a unique 
name. Be sure to use the.xlt file suffix, which defines the file as a 
Microsoft Excel template.

6. Click the Save button to save your modified template.

Note: If you need to modify the Maptable.xls file, you must do this before 
you can use the modified template with your Expense data. To 
modify the Maptable.xls file for your new template, refer to 
Programming the Mapping Table on page A-9. Read all of the 
sections of this appendix before making changes to the Maptable.xls 
file.

Determining the Layout of the Expense Report
This section describes the layout considerations for the Expense Report and explains the 
terms used for creating the report. 

Labels
There are two kinds of labels you need to define for your report: day/date and expense type. 
Each type of label can be either Fixed or Variable. A Fixed label means that the label always 
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displays as a header at the beginning of a row or column. A variable label means the 
location of the header can vary.

For example, a list table of expenses could have variable labels in the rows for day/date, 
and variable labels in the columns for expense type. In this case, neither day/date or 
expense type information would be “fixed” (as a header). Instead, the date and expense 
type information would be filled into the cells of the spreadsheet as appropriate.

Examples of both Fixed and Variable labels display in the sample expense templates, 
which were discussed previously in this appendix. 

Sections
A Section is an area of the report that has common formatting. It is common for an Expense 
report to have more than one Section. For example, the following sample Expense Report 
(Sample3.xlt) contains several Sections.

Because your Expense data maps to row and column areas of your final report, different 
Sections require different definitions for the data mapping. To create additional Sections 
with different mapping, create corresponding additional lines to the mapping table file, 
Maptable.xls. Refer to Programming the Mapping Table on page A-9 for details.

Section 1 
(not prepaid)

Section 2 
(prepaid)

Section 3 
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If a Section contains cells for prepaid (company paid) expenses, create an additional line 
in the mapping table for “prepaid.” This will count as an additional Section in the mapping 
table. The only data that differs in the prepaid Section (from the non-prepaid Section) is the 
row/column numbers for the expense type.

Using Your Custom Expense Report

If you already have a custom Excel expense report, you can use it with a modified mapping 
table. However, before you can create a Maptable.xls file that corresponds to your custom 
Expense Report, you must first analyze the characteristics of your report. 

Perform the following before you begin a custom mapping table:

• Print a copy of your custom expense report. Activate the Row and Column 
Headings option in the Sheet settings of the Page Setup command. This enables 
you to quickly determine the size of the Section(s), as well as the numbers for the 
start rows and columns.

• On the printed copy, identify the data Sections. A Section is an area of data with 
common row and column formatting. A yellow high lighter marking pen can make 
it easy to see the Sections as you work with programming the mapping table. Your 
custom Expense Report can contain any number of Sections, and the same data 
can be repeated in any Section.

• On the printed copy, identify the type of Labels that apply to each Section. Each 
Section can have only one kind of Fixed or Variable Label for rows and each 
Section can have only one kind for columns.

• Place a copy of your custom Expense Report in the Templates folder (in the 
Symbol Palm Terminal Desktop directory). Change the file name so it has the file 
extension.xlt (which defines it as a Microsoft Excel Template). Make a note of the 
exact file name so it can be defined in the mapping table file.

Programming the Mapping Table
Once you have analyzed the components of your custom Expense Report, you can 
program the mapping table to fill the report with data from the SPT 1700 terminal.
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To program a new custom mapping table:

1. Open a copy of the Maptable.xls file in Microsoft Excel. 

Note: This file is located in the same folder as the Symbol Palm Terminal 
Desktop application. Make a backup copy of this file before you 
make your modifications.

2. To map a new template, scroll to the original template that you chose for your 
modifications (the name of the template displays in column B of the Maptable.xls 
file, next to the cell highlighted in green that reads “Template Name:”). If you did not 
modify an existing template, move to any table in the Maptable.xls file. 

3. Select all the rows associated with the template name and copy and paste them 
into a blank area of the Maptable.xls file (below the rows used for Sample4.xlt), and 
click on a row number to select a blank row.

A copy of the rows is pasted into the Maptable.xls file.

4. Name the table. 

All rows 
associated 
with 
template are 
selected 
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In the cell immediately to the right of the cell entitled Template Name, enter the 
exact file name of your custom Expense Report template. 

5. Define the number of Sections. Each row in a table defines how your SPT 1700 
terminal data is placed in a Section of your custom Expense Report. Note that the 
prepaid portion of a Section has its own row and counts as a separate Section for 
map table purposes, even though it is not a separate Section in your template.

You may add or delete rows as necessary so that the total number of rows 
corresponds to the number of Sections in your custom Expense Report. To clear 
all of the existing settings in a row, click to select the row and press Ctrl+Delete. 

6. Name each row to correspond to a Section of your custom Expense Report.

7. Determine the Label settings. The orientation of the data fields (Row, Column) 
displays in the yellow Section of the table.

Determine whether the Rows will contain expense or date information, and 
whether a row is Fixed or Variable. You can place only one “x” in the Row Section 
(columns 2–5).

Determine whether the Columns will contain expense or date information, and 
whether a label is Fixed or Variable. You can place only one “x” in the Column 
Section (columns 6–9).

8. Define the dimensions of the Section. The dimensions of the Section display in the 
green columns (10–13).

Table with 
four sections
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9. Define the Dates and Intervals. The dates and intervals between dates display in 
the light blue columns (14–17).

10. Define whether the Section is in list format. This setting displays in the light purple 
columns (18–19).

# of Rows Represents the total number of rows in the Section, 
excluding any header or total rows. This includes only the 
number of rows in the Section where your SPT 1700 
terminal data will be placed.

# of Columns Represents the total number of columns in the Section, 
excluding any header or total columns. This includes only 
the number of columns in the Section where your SPT 
1700 terminal data will be placed.

Start Row The number of the first row of the Section that will be filled 
with your SPT 1700 terminal data.

Start Column The number of the first column of the Section that will be 
filled with your SPT 1700 terminal data.

Date The row or column number where all the date information 
will be placed

Dates the number of blank columns (or rows) separating the date 
fields. If there are no blank columns (or rows) between 
date entries, leave this number set to zero

Start Day the day of the week that starts the expense reporting 
period. Enter a three-character abbreviation for the day 
(e.g., Sun, Mon, Tue).

Day the row or column number where all the day information 
will be placed. If the dates are in a row, enter the row 
number. If the dates are in a column, enter the column 
number
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The following diagram shows data presented in a list format:

If your Section is in list format, enter “Yes” under list format and enter the number 
of the row or column where the expense description will be placed in the Expense 
Type cell. Expense amounts can be entered in several different columns or rows if 
required by your template.

Note: Expense type labels must all display in the same column.

11. Enter the row or column numbers for the expense types that appear in the Section. 
These settings display in the aqua columns (20–48).

For these settings, simply enter the row or column number for the expense types 
that you want to display in the Section. Note that the same row or column number 
can be used more than once. An example of this would be meals that encompass 
breakfast, lunch, dinner and snacks. In the previous example, all expense items 
would be populated into row/column 4 of the custom Expense Report.

12. Complete the table. The remaining columns (49–57) in the table are used to define 
the column or row number that corresponds to the description. 

13. Mark a Section for prepaid expenses (yellow column). If a row in the map table is 
for prepaid (company paid) expenses, type a “yes” in the cell on that Section’s row. 
Type “no” in all the cells of this column that do not pertain to prepaid expenses.

14. Repeat steps 7 through 12 for each Section that you have defined for your custom 
Expense Report. 
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15. The Map Expense Report Options dialog (magenta section) has five fields where 
you can specify the row and column on your template where header information 
will be mapped. 

Because header data is not related to any particular Section, you have to fill in only 
one row. If the item does not display on your template, leave these cells blank.

Using Applications Other Than Microsoft Excel

You can use applications other than Microsoft Excel (such as Lotus 1-2-3 or Quattro Pro) 
to open and manipulate the Expense data on your computer. The data file is named 
“Expense.txt,” and is stored in the Expense folder, within the folder containing the SPT 1700 
terminal user data.

Expense data in the Expense.txt file is in tab-delimited format.

Expense File Details
The Expense.txt file contains four groups of data. It is easier to see these four groups if you 
open the file with a spreadsheet application.

Trips Shows the number of Expense application categories, and 
lists each one followed by an “end” statement.

Currency Shows how many currencies were used for the Expense 
data, and lists the countries that correspond to that 
currency.

Trip Shows the number of expenses by category, and lists the 
expenses for each category.

Expenses Shows the total number of expenses, and lists them 
chronologically.
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Appendix  B
Non-ASCII Characters for Login Scripts

Introduction

The following information enables you to create custom login scripts that require non-ASCII 
characters. It is provided for advanced users who understand the use and requirements of 
such characters in a custom login script.

Use of ^char

You may use the caret ( ^  ) to transmit ASCII command characters. If you send ^char, and 
the ASCII value of char is between @ and _, then the character is automatically translated 
to a single-byte value between 0 and 31. For example, ̂ M is converted to a carriage return. 
If char is a value between a and z, the character sequence is translated to a single-byte 
value between 1 and 26. If char is any other value, the character sequence is not subject 
to any special processing.

For example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage Return and Line Feed

You may include carriage return and line feed commands as part of the login script, when 
entered in the following format:

<cr>Sends or receives a carriage return

<lf>Sends or receives a line feed
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For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by a carriage 
return and line feed from the remote computer before executing the next command in the 
script.

Literal Characters

The backslash ( \ ) character defines that the next character is transmitted as a literal 
character, and is not subject to any special processing ordinarily associated with that 
character. 

Examples:
\^Includes a caret as part of the string

\<Includes a < as part of the string

\\Includes a backslash as part of the string
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Tell Us What You Think...

We’d like to know what you think about this Manual. Please take a moment 
to fill out this questionnaire and fax this form to: (631) 738-3318, or mail to:

Symbol Technologies, Inc. 
One Symbol Plaza   M/S B-4
Holtsville, NY 11742-1300 
Attention: Technical Publications Manager

IMPORTANT: If you need product support, please call the appropriate 
customer support number provided. Unfortunately, we cannot provide 
customer support at the fax number above.

User’s Manual Title:___________________________________________
(please include revision level)

How familiar were you with this product before using this manual?

Did this manual meet your needs? If not, please explain.
___________________________________________________________
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What topics need to be added to the index, if applicable? 
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What can we do to further improve our manuals?
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